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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
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Preface

SIMOTION SCOUT TIA documentation
This documentation is included as electronic documentation in the scope of delivery of 
SIMOTION SCOUT TIA and it comprises ten documentation packages. 

The following documentation packages are available for SIMOTION V4.4:

● SIMOTION Engineering System Handling

● SIMOTION System and Function Descriptions

● SIMOTION Service and Diagnostics

● SIMOTION IT

● SIMOTION Programming

● SIMOTION Programming - References

● SIMOTION C

● SIMOTION D

● SIMOTION Supplementary Documentation

Hotline and Internet addresses

Additional information
Click the following link to find information on the following topics:

● Ordering documentation / overview of documentation

● Additional links to download documents

● Using documentation online (find and search manuals/information)

http://www.siemens.com/motioncontrol/docu

My Documentation Manager
Click the following link for information on how to compile documentation individually on the 
basis of Siemens content and how to adapt it for the purpose of your own machine 
documentation:

http://www.siemens.com/mdm

Training
Click the following link for information on SITRAIN - Siemens training courses for automation 
products, systems and solutions:

http://www.siemens.com/sitrain
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FAQs
Frequently Asked Questions can be found in SIMOTION Utilities & Applications, which are 
included in the scope of delivery of SIMOTION SCOUT TIA, and in the Service&Support pages 
in Product Support:

http://support.automation.siemens.com

Technical support
Country-specific telephone numbers for technical support are provided on the Internet under 
Contact:

http://www.siemens.com/automation/service&support 

Preface
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Fundamental safety instructions 1
1.1 General safety instructions

DANGER

Danger to life due to live parts and other energy sources 

Death or serious injury can result when live parts are touched.
● Only work on electrical devices when you are qualified for this job. 
● Always observe the country-specific safety rules. 

Generally, six steps apply when establishing safety: 
1. Prepare for shutdown and notify all those who will be affected by the procedure.
2. Disconnect the machine from the supply.

– Switch off the machine. 
– Wait until the discharge time specified on the warning labels has elapsed. 
– Check that it really is in a no-voltage condition, from phase conductor to phase 

conductor and phase conductor to protective conductor.
– Check whether the existing auxiliary supply circuits are de-energized.
– Ensure that the motors cannot move.

3. Identify all other dangerous energy sources, e.g. compressed air, hydraulic systems, or 
water.

4. Isolate or neutralize all hazardous energy sources by closing switches, grounding or short-
circuiting or closing valves, for example.

5. Secure the energy sources against switching on again. 
6. Ensure that the correct machine is completely interlocked.

After you have completed the work, restore the operational readiness in the inverse sequence. 

WARNING

Danger to life from hazardous voltage when connecting an unsuitable power supply

Touching live components can result in death or severe injury. 
● Only use power supplies that provide SELV (Safety Extra Low Voltage) or PELV 

(Protective Extra Low Voltage) output voltages for all connections and terminals of the 
electronics modules.

SIMOTION SCOUT TIA
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WARNING

Danger to life from touching live parts on damaged devices

Improper handling of devices can result in damage. 

For damaged devices, hazardous voltages can be present at the enclosure or at exposed 
components; if touched, this can result in death or severe injury. 
● Observe the limit values specified in the technical specifications during transport, storage, 

and operation. 
● Do not use damaged devices.

WARNING

Danger to life through electric shock due to unconnected cable shields 

Hazardous touch voltages can occur through capacitive cross-coupling due to unconnected 
cable shields.
● As a minimum, connect cable shields and the cores of power cables that are not used 

(e.g. brake cores) at one end at the grounded housing potential.

WARNING

Danger to life due to electric shock when not grounded 

For missing or incorrectly implemented protective conductor connection for devices with 
protection class I, high voltages can be present at open, exposed parts, which when touched, 
can result in death or severe injury.
● Ground the device in compliance with the applicable regulations.  

WARNING

Danger to life due to fire spreading if housing is inadequate

Fire and smoke development can cause severe personal injury or material damage. 
● Install devices without a protective housing in a metal control cabinet (or protect the device 

by another equivalent measure) in such a way that contact with fire inside and outside the 
device is prevented.

● Ensure that smoke can only escape via controlled and monitored paths.

Fundamental safety instructions
1.1 General safety instructions
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WARNING

Danger to life from unexpected movement of machines when using mobile wireless devices 
or mobile phones

Using mobile radios or mobile phones with a transmit power > 1 W closer than approx. 2 m 
to the components may cause the devices to malfunction, influence the functional safety of 
machines therefore putting people at risk or causing material damage.
● Switch off wireless devices or mobile phones in the immediate vicinity of the components. 

WARNING

Danger to life due to fire if overheating occurs because of insufficient ventilation clearances

Inadequate ventilation clearances can cause overheating of components followed by fire and 
smoke development. This can cause death or serious injury. This can also result in increased 
downtime and reduced service life for devices/systems. 
● Ensure compliance with the specified minimum clearance as ventilation clearance for the 

respective component. 

WARNING

Danger of an accident occurring due to missing or illegible warning labels 

Missing or illegible warning labels can result in accidents involving death or serious injury. 
● Check that the warning labels are complete based on the documentation.
● Attach any missing warning labels to the components, in the national language if 

necessary.
● Replace illegible warning labels.

WARNING

Danger to life when safety functions are inactive

Safety functions that are inactive or that have not been adjusted accordingly can cause 
operational faults on machines that could lead to serious injury or death. 
● Observe the information in the appropriate product documentation before commissioning.
● Carry out a safety inspection for functions relevant to safety on the entire system, including 

all safety-related components.
● Ensure that the safety functions used in your drives and automation tasks are adjusted 

and activated through appropriate parameterizing. 
● Perform a function test.
● Only put your plant into live operation once you have guaranteed that the functions relevant 

to safety are running correctly.

Fundamental safety instructions
1.1 General safety instructions
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Note
Important safety notices for safety functions

If you want to use safety functions, you must observe the safety notices in the safety manuals.

1.2 Safety instructions for electromagnetic fields (EMF)

WARNING

Danger to life from electromagnetic fields

Electromagnetic fields (EMF) are generated by the operation of electrical power equipment 
such as transformers, converters or motors.

People with pacemakers or implants are at a special risk in the immediate vicinity of these 
devices/systems.
● Ensure that the persons involved are the necessary distance away (minimum 2 m). 

1.3 Handling electrostatic sensitive devices (ESD)
Electrostatic sensitive devices (ESD) are individual components, integrated circuits, modules 
or devices that may be damaged by either electric fields or electrostatic discharge.

NOTICE

Damage through electric fields or electrostatic discharge

Electric fields or electrostatic discharge can cause malfunctions through damaged individual 
components, integrated circuits, modules or devices.
● Only pack, store, transport and send electronic components, modules or devices in their 

original packaging or in other suitable materials, e.g conductive foam rubber of aluminum 
foil.

● Only touch components, modules and devices when you are grounded by one of the 
following methods:
– Wearing an ESD wrist strap
– Wearing ESD shoes or ESD grounding straps in ESD areas with conductive flooring

● Only place electronic components, modules or devices on conductive surfaces (table with 
ESD surface, conductive ESD foam, ESD packaging, ESD transport container).

Fundamental safety instructions
1.3 Handling electrostatic sensitive devices (ESD)
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1.4 Industrial security

Note
Industrial security

Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, solutions, machines, equipment and/or networks. They are 
important components in a holistic industrial security concept. With this in mind, Siemens’ 
products and solutions undergo continuous development. Siemens recommends strongly that 
you regularly check for product updates. 

For the secure operation of Siemens products and solutions, it is necessary to take suitable 
preventive action (e.g. cell protection concept) and integrate each component into a holistic, 
state-of-the-art industrial security concept. Third-party products that may be in use should also 
be considered. For more information about industrial security, visit http://www.siemens.com/
industrialsecurity. 

To stay informed about product updates as they occur, sign up for a product-specific 
newsletter. For more information, visit http://support.automation.siemens.com

WARNING

Danger as a result of unsafe operating states resulting from software manipulation

Software manipulation (e.g. by viruses, Trojan horses, malware, worms) can cause unsafe 
operating states to develop in your installation which can lead to death, severe injuries and/
or material damage.
● Keep the software up to date. 

Information and newsletters can be found at: 
http://support.automation.siemens.com

● Incorporate the automation and drive components into a state-of-the-art, integrated 
industrial security concept for the installation or machine.
For more detailed information, go to: 
http://www.siemens.com/industrialsecurity

● Make sure that you include all installed products into the integrated industrial security 
concept.

1.5 Residual risks of power drive systems
The control and drive components of a drive system are approved for industrial and commercial 
use in industrial line supplies. Their use in public line supplies requires a different configuration 
and/or additional measures.

These components may only be operated in closed housings or in higher-level control cabinets 
with protective covers that are closed, and when all of the protective devices are enabled.

These components may only be handled by qualified and trained technical personnel who are 
knowledgeable and observe all of the safety instructions on the components and in the 
associated technical user documentation.

Fundamental safety instructions
1.5 Residual risks of power drive systems
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When assessing the machine's risk in accordance with the respective local regulations (e.g. 
EC Machinery Directive), the machine manufacturer must take into account the following 
residual risks emanating from the controller and drive components of a drive system:

1. Unintentional movements of driven machine components during commissioning, operation, 
maintenance, and repairs caused by, for example:

– Hardware defects and/or software errors in the sensors, controllers, actuators, and 
connection technology

– Response times of the controller and drive

– Operating and/or ambient conditions outside of the specification

– Condensation / conductive contamination

– Parameterization, programming, cabling, and installation errors

– Use of radio devices / cellular phones in the immediate vicinity of the controller

– External influences / damage

2. In the event of a fault, exceptionally high temperatures, including an open fire, as well as 
emissions of light, noise, particles, gases, etc. can occur inside and outside the inverter, 
for example:

– Component malfunctions

– Software errors

– Operating and/or ambient conditions outside of the specification

– External influences / damage

Inverters of the Open Type / IP20 degree of protection must be installed in a metal control 
cabinet (or protected by another equivalent measure) such that the contact with fire inside 
and outside the inverter is not possible.

3. Hazardous touch voltages caused by, for example:

– Component malfunctions

– Influence of electrostatic charging

– Induction of voltages in moving motors

– Operating and/or ambient conditions outside of the specification

– Condensation / conductive contamination

– External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a risk 
to people with a pacemaker, implants or metal replacement joints, etc. if they are too close.

5. Release of environmental pollutants or emissions as a result of improper operation of the 
system and/or failure to dispose of components safely and correctly.

Fundamental safety instructions
1.5 Residual risks of power drive systems

SIMOTION SCOUT TIA
16 Configuration Manual, 01/2015



Note

The components must be protected against conductive contamination (e.g. by installing them 
in a control cabinet with degree of protection IP54 according to IEC 60529 or NEMA 12).

Assuming that conductive contamination at the installation site can definitely be excluded, a 
lower degree of cabinet protection may be permitted.

For more information about residual risks of the components in a drive system, see the relevant 
sections in the technical user documentation.

Fundamental safety instructions
1.5 Residual risks of power drive systems
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Introduction 2
2.1 Target group and content of the configuration manual

The SIMOTION SCOUT TIA Configuration Manual is a general description of the software for 
new users and experienced users switching from SIMOTION SCOUT. 

To differentiate the two versions from each other, the SIMOTION SCOUT designation refers 
to SCOUT in the SIMATIC Manager environment and the SIMOTION SCOUT TIA designation 
to SCOUT in the TIA Portal environment.

At the beginning of each section a note is included that indicates whether each configuration 
step is performed in the TIA Portal or in SIMOTION SCOUT TIA. 

For an overview of the configuration step and its place of execution, refer to Section 
Configuration overview (Page 63).

Not all available software functions are described in this document. For detailed, topic-specific 
information, refer to the information system of the TIA Portal, the context-sensitive online help 
of SIMOTION SCOUT TIA, and the corresponding documentation.

Important notes and information on the SIMOTION Motion Control system are described in 
the following catalog:

● SIMOTION, SINAMICS S120 & SIMOTICS and equipment for production machines, PM 21 
catalog

Note
Getting Started with SIMOTION SCOUT TIA

We recommend that you work through "Getting Started with SIMOTION SCOUT TIA" in the 
online help. There you find guidelines how you work with SIMOTION SCOUT TIA, for example, 
how you create a project, compile and save it, insert a SIMOTION device, insert and 
parameterize a technology object, and how to create a program. When you have worked 
through all these steps, you will be able to create more complex projects.

2.2 SIMOTION in the TIA Portal

SIMOTION in the TIA Portal
By integrating the SIMOTION motion control system into the Totally Integrated Automation 
Portal, Siemens has expanded the efficient engineering framework within the "Integrated Drive 
System" concept to include another powerful tool. The full range of SIMOTION motion control 
functions can now also be used in the TIA Portal. All the SIMOTION components can be 
configured and engineered simply and efficiently using the TIA Portal's intuitive user interface.

This enables the efficient and user-friendly mechanisms of this engineering framework to be 
used for commissioning, configuring and designing SIMOTION components. That includes, 
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for example, merging of the hardware and network configuration into one consistent editor, 
thus enabling intuitive and fully graphical configuration and powerful diagnostics of the 
configured and networked components. In the device view, the SIMOTION CPU is displayed 
fully graphically with all its interfaces and properties. All the parameters can be selected and 
modified intuitively. In the network view, further automation components such as the HMI 
(Human Machine Interface) or drives can be connected to the CPU, and configuration of the 
PROFINET network topology is just as intuitive.

With SIMOTION SCOUT TIA, configuration is as easy as ever. Not only can you configure 
telegrams and integrate technology and drive objects, you can also configure automatic 
communication for distributed synchronous operation between two CPUs. 

Figure 2-1 SIMOTION in the TIA Portal

SIMOTION devices in the TIA Portal
As of Version 13 of the TIA Portal, you can also configure SIMOTION devices.

A SIMOTION configuration comprises the following steps:

● Hardware configuration

● Technology configuration

Introduction
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The following list shows which configuration steps you perform in the TIA Portal and which 
configuration steps you perform in SIMOTION SCOUT TIA:

Configuration steps in the TIA Portal
● Project management

● Hardware configuration

● Save and compile the hardware configuration

● Communication configuration

● Create the F programs

● Connection to HMI

● Set up and test online connection

Configuration steps in SIMOTION SCOUT TIA
● Drive configuration

● Configure technology (e.g. axis, external encoder)

● Create user programs

● Save and compile

● Establish online/offline connection

● Diagnostics

● Trace

Integration of SIMOTION SCOUT TIA as an option package of the TIA Portal has resulted in 
the following special features of use: 

● You can only start SIMOTION SCOUT TIA from the TIA Portal.

● As soon as you close the TIA Portal, SIMOTION SCOUT TIA is also closed.

● When you switch to SIMOTION SCOUT TIA, you cannot undo the actions you last 
performed in the TIA Portal.

2.3 SIMOTION SCOUT TIA Engineering System

Introduction
The SIMOTION Motion Control system provides not only a range of ready-to-use functions, 
but can also be individually parameterized and programmed. High-performance tools, which 
provide optimum support and ease of use for the necessary engineering steps, are required 
for this.

The SIMOTION SCOUT TIA Engineering System is the environment for the uniform 
automation of production machines with SIMOTION and integrates into the 
SIMATIC environment in accordance with TIA (Totally Integrated Automation).

Introduction
2.3 SIMOTION SCOUT TIA Engineering System
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SIMOTION SCOUT TIA provides a uniform, function-oriented view for your automation task 
and it is also very user-friendly.

The possible SIMOTION applications range from simple, parameterizable, speed-controlled 
single axes through to complex, mechatronically-coupled and programmable multi-axis 
machines. Therefore, SIMOTION SCOUT TIA provides views that are adapted to the task, and 
it can be expanded by additional tools.

SIMOTION SCOUT TIA provides all the necessary tools for the following functions: 

● Configuration

● Parameterization

● Programming

● Testing

● Diagnostics

The following tasks are graphically supported with operator guidance:

● Creation of the hardware and network configuration

● Creation, configuration and parameterization of technology objects such as axes, output 
cams and cams

2.4 SIMOTION hardware platforms

SIMOTION hardware platforms
To meet the complex requirements of mechanical engineering, SIMOTION offers two hardware 
versions with different performance in various designs and expandability options. The basic 
system characteristics, like the engineering, are identical. 

SIMOTION D (Drive-based)
SIMOTION D is a compact, drive-based version of SIMOTION based on the SINAMICS S120 
drives family. In the case of SIMOTION D, both the SIMOTION runtime environment and the 
SINAMICS drive software run simultaneously on the controller hardware in SINAMICS S120 
design.

SIMOTION C (Controller-based)
SIMOTION C is the modular controller variant in the tried and trusted packaging system of the 
SIMATIC S7-300 with its very varied expandability options on the I/O bus. SIMOTION C240 
are high-performance motion controllers for control functions and motion control tasks. The 
integrated interface for four analog coupled drives makes the SIMOTION C particularly suitable 
for compact applications with the control of analog electrical drives and the operation of 
hydraulic axes. SIMOTION C also supports operation of four stepper motors at these 
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interfaces. SIMOTION C240 PN offers a PROFINET interface instead of the encoder and drive 
interfaces.

Note

In the current version, SIMOTION SCOUT TIA supports only specific SIMOTION devices.

To find out which SIMOTION devices are supported, see Supported devices (Page 23).

2.5 Supported devices
Not all devices that are available in SIMOTION SCOUT are currently supported by SIMOTION 
SCOUT TIA. 

The following table lists the devices that are supported in the current version of SIMOTION 
SCOUT TIA:

SIMOTION devices SINAMICS devices
As of SIMOTION firmware/kernel V4.3 and SINAMICS Inte‐
grated V4.5:
● SIMOTION C240/C240 PN
● SIMOTION D410-2/D4x5-2/SIMOTION CX32-2

SINAMICS V4.5 and 4.7 or higher:
● SINAMICS S120 CU310-2
● SINAMICS CU320-2
● CBE20

Note

The SINAMICS devices listed in the table can be found in the TIA Portal in the task card 
hardware catalog under "Controller > SIMOTION > SIMOTION drives". 

You can parametrize these devices only if you have networked them with a SIMOTION device 
via PROFIBUS/PROFINET.

The following devices are not supported:

● Single drive devices

See also
Inserting a SIMOTION drive (Page 91)

Migrating a SIMOTION SCOUT project (Page 69)
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SIMOTION hardware platforms (Page 22)

Overview (Page 217)

2.6 Supported functionalities

Supported functionality
SIMOTION SCOUT TIA generally supports the same functionality as SIMOTION SCOUT and 
the TIA Portal. 

The current SIMOTION SCOUT TIA version does not yet support the following functionality:

● DCC SIMOTION / DCC SINAMICS

● Scripting of HWCN data

● XML export/import of HWCN data

● Library concept of the TIA Portal

● SIMOTION Easy Project

● Device update tool

● PROFIBUS: F-Proxy

● PROFINET: Media redundancy MRPD

● PROFINET Performance Upgrade

● PROFINET: Shared I device

● PROFINET: Shared Device below a SIMOTION CPU

See also
Migrating a SIMOTION SCOUT project (Page 69)

2.7 Programming languages
SIMOTION provides different programming languages for the solution of Motion Control tasks, 
control logic, arithmetic calculations, etc. During runtime, the selected programming language 
has no effect – except in the different displays when debugging. You can create user 
applications in different programming languages and use them jointly in a project.
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The following programming languages are available in SIMOTION SCOUT TIA:

● Motion Control Chart (MCC) 
Graphical programming as a flow chart. 
In particular, for sequential tasks with a high level of motion control functionality. 

● Ladder Logic/Function Block Diagram (LAD/ FBD)
Graphical Programming as Ladder Logic/Function Block Diagram, supplemented by Motion 
Control Functions via PLC Open Function Blocks. 
In particular, for cyclic tasks with a high logic proportion. 

● Structured Text (ST)
Textual Programming in a High-level Language. 
As the base language of the SIMOTION, ST system supports all system features and 
functions of the technology packages and is thus suitable for all tasks. 

Sources (units)
Programs are created in program containers, the so-called sources (units). They are compiled 
in the engineering system. Any errors or warnings that occur during compilation are output in 
the diagnostics window. Sources compiled without error can then be loaded into the associated 
controller. 

A source contains any number of programs, functions, and function blocks. Each executable 
part of a source (program, function, function block) is called a POU (Program Organization 
Unit). 

A source is divided into an interface and an implementation section. 

Interface section
All parts exported by the source are defined in the interface section. Other sources and external 
components (e.g. HMI systems) can access these parts. These include user-defined data 
types, data (tags and constants) as well as names of programs, functions, and function blocks.

Implementation section
The data types and data defined in the implementation section are global throughout the source 
and can be used by all POEs. The implementation section also contains the program code of 
the POUs. Any POUs not specified in the interface section can only be used within the source. 

Note
Source concept

The source concept with encapsulation of code and data allows you to structure applications. 
For example, the functionality of an entire machine module with a defined external interface 
can be implemented in a single source. 
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Tasks
Programs are processed in tasks. A task is a job which is executed in a certain chronological 
sequence. The advantage of the task system (sequence system) is that processes appended 
to the appropriate task levels can run simultaneously. 

The SIMOTION Motion Control system uses high-performance CPUs on which a real-time 
operating system - suitable for fast control processes - is implemented. Each task is allocated 
a slice of the computing time. The organization of the task sequences is performed by the 
operating system. A differentiation is made between user and system tasks that are 
independent of one another.

Additional references
For detailed information on the programming languages and the execution system, refer to the 
online help of SIMOTION SCOUT TIA and the respective programming and operating manuals.

See also
MCC (Page 26)

LAD/FBD (Page 27)

ST (Page 28)

2.7.1 MCC

Motion Control Chart
MCC (Motion Control Chart) is a "flow diagram language" that can be used to graphically 
formulate the process sequences in production machines in a simple manner. The result is 
one or more flow diagrams, comprising MCC blocks that describe the time sequence of the 
individual machine actions. Due to its special means of expression, MCC (Motion Control 
Chart) is ideally suited to programming sequential processes.

Motion Control Chart supports the simple description of the motion sequences of machines 
with the help of powerful motion control commands, such as reference axis, position axis, 
synchronize or desynchronize cam, and many more.

To control the machine sequence, commands are available for awaiting conditions and for 
formulating computations, as well as for programming various control structures, such as 
polling (IF), case determination (CASE) and loops (FOR, WHILE, UNTIL). Several MCC 
programs may be created to describe different process situations. For example, you can create 
one MCC program to bring the machine to a defined initial state when it is switched on, a 
second MCC program for the normal production sequence, and a third MCC program to specify 
what the machine has to do in the event of a fault.

All MCC blocks – a selection of the most important SIMOTION functions – are available in tool 
bars. They are grouped according to function and are automatically inserted in the flow diagram 
at the marked point by means of a click. A click on the individual elements opens specific 
dialogs for parameterization. Obviously, you can also add your own comments for the further 
documentation of the process sequence. Functions from the SIMOTION command library that 
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are not individually offered as MCC blocks can be used in an MCC program by means of a 
special command.

Performance features:

● Easy-to-use due to graphical illustration in the form of flow diagrams.

● Hierarchical command library for motion control, PLC, and technology functions

● Control structures (IF, WHILE, CASE, etc.)

● Zooming for LAD, FBD and ST

● Subroutine calls (FB/FC)

● Structuring based on command modules, i.e. combination of command sequences to create 
a command module

● Easy-to-use debug functions for online testing and diagnostics: for example, single-step, 
program status or breakpoints for easier troubleshooting (debugging)

● Monitor, trace

Note
Implicit conversion to ST

When being compiled, programs written in MCC are implicitly converted to ST programs and 
then compiled.

You can export the intermediate result as an ST and use it as a basis for your own ST programs. 

Additional references
Detailed information can be found in the online help of SIMOTION SCOUT TIA and in the 
SIMOTION MCC Motion Control Chart Programming and Operating Manual.

2.7.2 LAD/FBD

Ladder Logic/ Function Block Diagram
LAD/FBD is a graphical programming language and is available for Ladder Logic/ Function 
Block Diagram. The statement syntax corresponds to a circuit diagram (LAD) or a function 
block diagram (FBD). LAD/FBD enable simple tracking of the signal flow between power rails 
via inputs, outputs, and operations. LAD and FBD programs are usually suitable for application 
in cyclic tasks (in particular, BackgroundTask).

LAD/FBD programs consist of elements and boxes that are graphically connected to networks. 
Their operations work mostly according to the rules of Boolean logic or simple arithmetic 
expressions and equations. Therefore, they are suitable only for control-relevant programs or 
also for motion control tasks by using the PLCopen blocks.

Introduction
2.7 Programming languages

SIMOTION SCOUT TIA
Configuration Manual, 01/2015 27



Functions, function blocks and programs can be programmed in LAD/FBD. A source can 
contain several LAD and FBD blocks. Only one POU can be implemented in an LAD or FBD 
block. 

LAD/FBD also include commands for SIMOTION control using standard logic functions. These 
commands are added from the command library. Motion Control tasks are preferably 
programmed with PLCopen blocks. Blocks which have been programmed in other SIMOTION 
languages can be called. User-friendly functions such as "on the fly" tag declarations or 
automatic syntax checks are available when programming in LAD or FBD. It is possible to 
switch over between LAD and FBD in the editor at any time. A program can therefore be viewed 
and processed in either LAD or FBD.

User-friendly debug functions for online testing and diagnostics are available such as 
monitoring the values of tags for MCC, program status and breakpoints.

Note

Direct editing of motion commands is not recommended. It is better to use the PLCopen blocks 
here. These blocks are designed for integration in logic-oriented programs.

Additional references
Detailed information can be found in the online help of SIMOTION SCOUT TIA and in the 
SIMOTION LAD/FBD Programming and Operating Manual.

2.7.3 ST

Structured Text
ST is a high-level, PASCAL-based programming language. ST is based on the IEC 61131-3 
standard. This standard standardizes programming languages for programmable logic controls 
(PLCs).

The basic command scope is sufficient for the implementation of everything related to data 
management, arithmetic functions, control structures and I/O access. The addition of 
technology packages for Motion Control expands the scope of commands by other 
comprehensive, extremely flexible Motion Control commands.

In addition, applications can be subdivided into any number of sections. Such a section might 
be a program allocated to a runtime level, an instantiatable function block with its own memory, 
or a function without its own memory. In this case, the function blocks and functions are not 
allocated to a runtime level, but are instead called in programs.

Performance features:

● Motion Control, PLC and technology functions in a single language

● Well-structured programs with comment capability
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● High-performance editor functions, such as:

– Syntax coloring

– Automatic indenting

– Automatic completion

– Bookmarks

– Fold (show and hide blocks)

– Displaying sets of parentheses

– Select text, e.g. by column

– Using the command library

● Convenient debug functions for online testing and diagnostics, e.g. display of up-to-date 
variable content of the code sequence selected in the editor (program status) and 
breakpoints.

Additional references
Detailed information can be found in the online help of SIMOTION SCOUT TIA and in the 
SIMOTION ST Structured Text Programming and Operating Manual.

2.8 CamEdit cam editor
CamEdit can be used to describe curves by means of either interpolation points or segments. 
A combination is not possible. If the curve is to be created from segments using polynomials, 
SIMOTION SCOUT TIA provides the VDI wizard to assist in creation of the curve. Cam 
geometries are created in offline mode.

Information on the graphical creation of cams can be found in the section Optional CamTool 
package (graphical cam editor) (Page 29).

Additional references
Detailed information on the topic can be found in the SIMOTION SCOUT TIA online help and 
in the Function Manual SIMOTION Motion Control, Synchronous Operation TO, TO Cam.

2.9 Optional CamTool package (graphical cam editor)

SIMOTION CamTool
SIMOTION CamTool is a powerful, graphical editor for creating and optimizing cams.
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SIMOTION CamTool can be used as an expansion package for SIMOTION SCOUT TIA and 
is completely integrated in the SIMOTION SCOUT TIA user interface.

Basic functions
SIMOTION CamTool provides the following basic functions:

● Inserting and editing cams.
Cams can be inserted in a SIMOTION SCOUT TIA project using a SIMOTION CamTool. 
You can also edit a cam created with CamEdit using CamTool: Cams can also be imported 
from a text file or read from a SIMOTION device.

● Customize display of the cam in CamTool.
In SIMOTION CamTool, you can show and hide diagrams, change display parameters of 
the axes and diagrams and adjust the lines and fonts. You can also display auxiliary lines 
in the diagram.

● Convert cams from SIMOTION CamTool to SIMOTION CamEdit.
To edit a cam that is edited in SIMOTION CamTool using SIMOTION CamEdit, the cam 
needs to be converted.

● Export cams to a text file.

● Load cams into a SIMOTION device.

Additional references
Detailed information can be found in the online help of SIMOTION SCOUT TIA and in the 
SIMOTION CamTool Configuration Manual.

See also
CamEdit cam editor (Page 29)

2.10 Technology packages and technology objects

Technology packages in SIMOTION SCOUT TIA
Technology packages combine software functions which are required for automation in 
mechanical engineering in various sectors. They are loaded into the controller during 
configuration and expand the basic functionality through additional system functions. The 
functions of the technology packages can be accessed easily in the SIMOTION SCOUT TIA 
command library during engineering. Access to the technology package functions is carried 
out via additional language commands and system tags. Programming of motional sequences 
is therefore simple and integrated. 

The following standard technology packages are available for SIMOTION SCOUT TIA:
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CAM technology package
The SIMOTION technology package CAM contains the basic Motion Control technologies, 
such as drive axis, position axis, following axis, synchronous object, cam, output cam, cam 
track, and measuring input.

PATH technology package
The SIMOTION technology package PATH contains additionally the path interpolation 
technology. 
Path interpolation generates the traversing profile for the path, calculates the path interpolation 
points in the interpolation cycle, and uses the kinematic transformation to derive the axis 
setpoints for the interpolation cycle points.

CAM_EXT technology package
TP CAM_EXT SIMOTION technology package contains additional objects for preparing 
technological data on the system level, e.g. addition object, formula object

Technology Package TControl
The SIMOTION technology package for temperature control (TControl) provides temperature 
channels with extensive functions. These functions are also accessed via additional language 
commands and system tags.

More sector-specific technology packages are also available as separate products.

The loadable technology packages support the creation of technology objects (e.g. positioning 
and synchronous axis, cam tracks, external encoders, etc.) which can be accessed over 
system functions and system tags for use in every SIMOTION programming language.

Technology objects in SIMOTION SCOUT TIA
SIMOTION SCOUT TIA uses technology objects to represent the functionality of axes, cams, 
output cams, etc. After setting up a technology object (e.g. an axis) and configuring it (e.g. as 
a positioning axis), you can access it when programming with system functions. 

Note
Missing licenses

All TOs outside the basic functionality (Motion Control Basic) must be licensed. Missing 
licenses are indicated by a flashing group error LED. The number and type of missing licenses 
is stated by the online diagnostics. They are also displayed during downloading.
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Additional references
Detailed information is provided in the online help of SIMOTION SCOUT TIA and in the 
following documents:

● SIMOTION Basic Functions Function Manual

● Function Manual: SIMOTION Motion Control, TO Axis, Electric/Hydraulic, TO External 
Encoder

● Function Manual: SIMOTION Motion Control, Synchronous Operation TO, TO Cam

● Function Manual: SIMOTION Motion Control, Supplementary Technology Objects

● Function Manual: SIMOTION Motion Control Output Cams and Measuring Inputs

● Function Manual: SIMOTION Motion Control, Path Interpolation TO

● Function Manual: SIMOTION Motion Control, Basic Functions for Modular Machines

See also
Licensing of the runtime components (Page 279)

2.11 CLib Studio option package

SIMOTION CLib Studio
If required, further functions and function blocks can be created in user libraries (SIMOTION 
CLib Studio) by means of C/C++ programming in the Windows environment. 

They can be used in all SIMOTION languages (MCC, LAD, FBD, ST). 

That allows the creation of application-specific and high-performance function extensions as 
well as adaptations including know-how protection.

Additional references
Detailed information on programming of functions and function blocks with CLib Studio can be 
found in the CLib_Studio_3_3 Manual.

Note

Note that the documentation for the CLib Studio in only available in English.
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Installation 3
3.1 System preconditions

System preconditions for SIMOTION SCOUT TIA and TIA Portal
Details for the system preconditions are contained in the Readme file in the start menu under 
"Start > Programs > Siemens Automation > Documentation > Readmes".

Compatibility details can be found in the Internet compatibility list under: Compatibility list (http://
support.automation.siemens.com/WW/view/en/18857317)

3.2 Install SIMOTION SCOUT TIA

Preconditions
The following preconditions apply to the installation of SIMOTION SCOUT TIA:

● Hardware and software of the PG/PC meet the system preconditions.

● You require administrator rights on your PG/PC.

● All running programs are closed.

● The TIA Portal (framework) is pre-installed, for example with the STEP 7 or WinCC software 
package. 

● The SIMOTION SCOUT TIA version to be installed (not part of the TIA Portal) is compatible 
with the installed TIA Portal version.

Side-by-side installations
The following combinations are possible:

● Different versions of the TIA Portal

● Different SIMOTION SCOUT TIA versions

● SIMOTION SCOUT (as of V4.4) and different SIMOTION SCOUT TIA versions

● STARTER (as of V4.4) and different SIMOTION SCOUT TIA versions

Note

You cannot install STARTER and SIMOTION SCOUT at the same time.
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Procedure
To install SIMOTION SCOUT TIA, proceed as follows:

1. Insert the installation data medium into the appropriate drive.
The Setup program will start automatically if the Autostart is not disabled on the PG/PC. 
If the Setup program does not start automatically, start it manually by double clicking the 
"Start.exe" file.

2. Acknowledge any Windows Security prompt with the "Yes" button.

3. Select the installation language of the Setup program.

4. Read the product information and installation instructions. To do this, click the "Read 
installation notes" or "Read product information" button.

5. Close the online help and click the "Next >" button.

6. Select the Product languages to be installed and click the "Next >" button. 

7. In the following dialog box, select the product configuration. Activate the migration tools in 
the "Migration" folder if you intend to migrate projects.
The required memory and the target directory are also listed. Click the "Next >" button.

8. Read and accept all of the licensing agreements and safety guidelines for safe operation 
that are listed in the following dialog, and confirm this by activating the two checkboxes. 
Click the "Next >" button.

9. In the final dialog, an overview of all installation settings appears. 
If you want to change the settings, navigate with the "< Back" button to the corresponding 
installation dialog, and perform the change there.
Otherwise, click the "Install" button to start the installation.

Note
License transfer

If no license key is found during installation, you will be given the opportunity to transfer it 
to your PC. If you skip the license transfer, you can transfer it later using the Automation 
License Manager.

You will find additional information on licensing in section Licensing for SIMOTION SCOUT 
TIA (Page 35).

10.Click the "Finish" button to complete installing.

Result
You have installed SIMOTION SCOUT TIA in the specified directory on the PG/PC.
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3.3 Uninstall SIMOTION SCOUT TIA

Preconditions
The following requirements are valid for uninstalling SIMOTION SCOUT TIA:

● You require administrator rights on your PG/ PC.

● All running programs are closed.

Procedure
To uninstall SIMOTION SCOUT TIA, proceed as follows:

1. Open the Control Panel via "Start > Control Panel."

2. Double-click the "Programs and Functions" item in the Control Panel.
The "Uninstall or Change a Program" dialog box opens.

3. Double click the "Siemens Totally Integrated Automation Portal Vxx" entry.

4. Acknowledge any Windows Security prompt with the "Yes" button.

5. Select the Installation language and click the "Next >" button.

6. Select the SIMOTION SCOUT TIA version you want to uninstall, and click the "Next >" 
button. 

7. Confirm uninstalling in the subsequent "Overview" dialog box and initiate uninstalling by 
clicking the "Uninstall" button.
The expected time until completion of uninstalling is displayed in the dialog box.

8. Click the "Finish" button to complete uninstalling.

Result
You have uninstalled the selected SIMOTION SCOUT TIA version.

3.4 Licenses

3.4.1 Licensing for SIMOTION SCOUT TIA

License for SIMOTION SCOUT TIA
To be able to use SIMOTION SCOUT TIA, in addition to the product DVDs, you will also receive 
a data medium containing the authorization data medium on which you will find the license 
key for SIMOTION SCOUT TIA. 

Because the license key is identical for SIMOTION SCOUT TIA and SIMOTION SCOUT, it is 
valid for both.

The Automation License Manager program is used to manage the license.

Installation
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How to install the license for SIMOTION SCOUT TIA
1. Insert the data medium containing the authorization and the license key.

2. Start the Automation License Manager program as follows:

– In the start menu, select 
"Start > SIMATIC > License Management > Automation License Manager".
Or

– Double-click the "Automation License Manager" icon.

3. In the navigation area (left-hand window), select the drive with the data medium containing 
the authorization. The license key is displayed in the right-hand window.

4. Select the license key and drag it via drag-and-drop onto the target drive.

5. Exit the Automation License Manager.

6. Remove the data medium containing the authorization.

Result
You have licensed your SIMOTION SCOUT TIA.

To upgrade the license for SIMOTION SCOUT TIA
1. Insert the data medium containing the authorization and the upgrade license key.

2. Start the Automation License Manager program as follows:

– In the start menu, select 
"Start > SIMATIC > License Management > Automation License Manager".
Or

– Double-click the "Automation License Manager" icon.

In the navigation area (left-hand window), select the drive where the authorization for the 
old version of SIMOTION SCOUT TIA is located. Generally, the authorization will be 
installed on a hard disk drive on the PG/PC.

3. Transfer the authorization to the data medium containing the upgrade license key.
To do this, select the license in the right-hand window and select "License key > Transfer..." 
via the menu.

4. In the "Transfer License Key" dialog box, select the connected data medium and start 
transfer with "OK".
When transfer is complete, the authorization and the upgrade license key will be located 
on the data medium.

5. Select "License Key > Upgrade..." in the menu.
The older authorization will be deleted. After the upgrade, you will have a new floating 
license.

Note

Do not interrupt the upgrade while it is in progress. Interrupting this process can result in 
the license key being lost.
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6. Now transfer the new floating license onto the hard disk drive. Proceed as described under 
item 3. 

7. Exit the Automation License Manager. 

8. Remove the automation data medium.

Result
You have upgraded SIMOTION SCOUT TIA.

Additional references
Detailed information about license keys is provided in the online help of the Automation License 
Manager.
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User interfaces 4
4.1 User interfaces

The TIA Portal serves as framework for the hardware and network configuration (HWCN). 

Call SIMOTION SCOUT TIA from this framework with the "SIMOTION configuration" item. 
SIMOTION SCOUT TIA is the workbench for configuring and programming the motion control.

As you are working both in the TIA Portal and in SIMOTION SCOUT TIA, both user interfaces 
are briefly described in the following sections.

Additional references
Detailed information about the user interfaces is provided in the information system of the TIA 
Portal and in the help system of SIMOTION SCOUT TIA.

See also
TIA Portal (Page 39)

SIMOTION SCOUT TIA (Page 44)

4.2 TIA Portal

Views in the TIA Portal
The following views are available in the TIA Portal:

● Portal view

● Project view

Portal view
The portal view provides an overview of all configuration steps and enables a task-based start 
to your automation solution.

The individual portals ("Start", "Devices & Networks", "PLC Programming", "Visualization", 
"Online & Diagnostics", etc.) provide the basic functions for the individual tasks. 
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① Portals for the various tasks
The portals provide the basic functions for the individual task areas. The portals provided in the portal view depend 
on the products that have been installed.

② Actions for the selected portal
Here, you will find the actions available to you in the portal you have selected. You can open context-sensitive help 
in every portal.

③ Selection window for the selected action
The selection window is available in all portals. The content of the window adapts to your current selection.

④ Change to the project view
Use the "Project view" link to change to the project view.

⑤ Select user interface language
Use the "User interface language" link to set the user interface language.
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Project view
The project view is a hierarchically structured view of all components in a project. The project 
view enables quick access to all objects in the project, the relevant working areas and editors. 
The various work windows show you all the corresponding data for the selected objects.

① Title bar
The name of the project is displayed in the title bar.

② Menu bar
The menu bar contains all the commands that you require for your work.

③ Tool bar
The tool bar provides you with buttons for commands you will use frequently. This allows you to access these 
commands faster.
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④ Project tree
The project tree provides access to all components and project data. Some of the actions that you can perform in 
the project tree:
● Add new components
● Edit existing components
● Query and change the properties of existing components

⑤ Reference projects
In the "Reference projects" view, you can open further projects in addition to the current project. Although these 
reference projects are write-protected, you can copy individual devices from a reference project and add them to 
your current project where they can be further processed.

⑥ Details
The details view shows certain contents of a selected object. This might include text lists or tags.

⑦ Changing to the portal view
Use the "Portal view" link to change to the portal view.

⑧ Working area
The objects that you can open for editing purposes are displayed in the working area.

⑨ Inspector window
The Inspector window displays additional information on a selected object or on executed actions.

⑩ Editor bar
The opened editors are displayed in the editor bar. If you have many open editors, they are shown grouped. The 
editor bar can be used to change quickly between the opened elements.

⑪ Status bar with progress display
The status bar contains the progress display for those background processes that are running currently.

⑫/⑬ Task cards 
Depending on the edited or selected objects, task cards are provided to perform further actions, such as
● Select objects from a library or from the hardware catalog
● Search for objects in the project and replace 
● Drag objects to the working area
The available task cards are found in a bar at the right-hand edge of the screen. You can collapse and reopen them 
at any time.

Additional references
For detailed information about the user interface and operation of the TIA Portal, refer to the 
"Introduction to the TIA Portal" section in the information system of the TIA Portal.

4.2.1 TIA Portal - language settings

User interface language 
The TIA Portal allows you to switch the user interface language during operation. SIMOTION 
SCOUT TIA takes over the language setting of the TIA Portal. However, change in the 
language setting takes effect only after a restart of the SIMOTION SCOUT TIA.
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The TIA Portal supports the following languages:

● German

● English

● French

● Italian

● Spanish

● Chinese (simplified)

Note
Not all languages of the TIA Portal are supported by SIMOTION SCOUT TIA.

If the user interface language selected in the TIA Portal is not supported by SIMOTION SCOUT 
TIA, e.g. Chinese simplified, the user interface of SIMOTION SCOUT TIA will be displayed in 
English.

Changing the user interface language
Proceed as follows to change the user interface language:

1. Changeover to the TIA Portal.

2. Switch to the "General" group in the "Tools > Settings" menu. 

3. Set your preferred language in the "User interface language" drop-down menu of the 
"General Settings".

4.2.2 TIA Portal - Using Help

TIA Portal information system
The TIA Portal has an extensive information system. Start this in the Portal view via the "Help" 
button or in the Project view via the "Help -> View Help" menu and read in the "Help on the 
information system" chapter there to know how you deal with the Help section. 

Additional references
You will find detailed information on all steps that you perform for SIMOTION configuration in 
the TIA Portal (configuring hardware, setting up communications, etc.) in the information 
system of the TIA Portal in Section "Configuring SIMOTION devices."
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4.3 SIMOTION SCOUT TIA

4.3.1 SIMOTION SCOUT TIA - using workbench
The SIMOTION SCOUT TIA workbench is the common framework for all other tools of the 
engineering system. The workbench is the navigation center of the individual engineering steps 
and offers a uniform and integrated view of all data and programs. 

The following figures shows an example of the Workbench components:

1

2

4
5

7

6

3

① Menu bar
② Tool bars
③ Working area
④ Project navigator
⑤ Snap-in
⑥ Tab
⑦ Detail view
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Workbench components
The Workbench components are:   

● Menu bar:
You call the functions of SIMOTION SCOUT TIA via the menus in the menu bar.    

● Tool bars:
Frequently used menu commands are also available in tool bars, which can be activated 
or deactivated as required. These provide quick access to the functions. The tool bars can 
be undocked from the top and relocated to a different position (right, left, lower border) or 
as a window.    

● Working area:
The task-specific windows are displayed in the working area. In these windows, you can 
perform the configuration with wizards for the axis configuration and drive configuration. 
You also create programs in the working area. Further information about the active window 
in the working area is provided in the detail view.    

● Project navigator:
The project navigator provides an overview of the entire project. All defined elements, such 
as devices, drives, axes, etc., are displayed here in a tree structure.    

● Snap-in / tab:
A Snap-in is a program integrated automatically in the working area of the SIMOTION 
SCOUT TIA Workbench. Snap-ins provide functions for processing SIMOTION SCOUT 
TIA projects and are displayed as a work window in the working area of the workbench. 
Several Snap-ins can be opened in order to be able to work in these. Open Snap-ins are 
displayed in the working area as tabs. The active Snap-in is visible in the foreground. 
Examples are: 

– Program editors 

– Wizards for the configuration of technology objects 

– Device diagnostics 

– Drive navigator 

● Detail display:
In the detail display, you can show more detailed information about the element selected 
in the project navigator (marked) and the active window in the work range, for example, 
tags of a program, system tags of a technology object, protocols of compiled program 
sources.   

Additional references
Detailed information can be found in the SIMOTION SCOUT TIA online help.

4.3.2 SIMOTION SCOUT TIA - using the working area
The workbench displays all of the Snap-in work windows in the working area. Each Snap-in 
provides its own working window. You can open multiple instances of these windows. You 
can, for example, open several programs at the same time for editing.   
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Active functions in the working area of the workbench depending on the project mode (offline/ 
online)

Function in project navigator Function in working area
offline mode
(Example)

Function in working area
online mode
(Example)

Programs 
(MCC, ST, LAD/FBD)
For further information, please go to:
● SIMOTION MCC Motion Control Chart
● SIMOTION ST
● SIMOTION LAD/FBD

Create program Monitor program

Execution system Assign program -
Technology objects
(TO configuration)

Create and configure TO element Change configuration data during 
RUN

Cam editor 
CamEdit/CamTool

Create a cam Change cam

Trace Load and evaluate old recordings Create current recordings
Axis control panel - Traverse axes during commis‐

sioning
Drive control panel - Traverse drives during commis‐

sioning 
Path control panel - Commission kinematics

Using windows in the working area
You can change the size of the windows in the working area: 
Click the edge of the window, hold down the left mouse button, and drag the window to the 
required size. 

You can maximize or restore each window using the shortcut <Ctrl+F11>.

Each window opened in the working area can be accessed via a tab at the bottom edge of the 
working area.

You place a window in the foreground in one of the following ways: 

● Click the relevant tab.

● Select the appropriate item in the "Window" menu.

To close the window:

● Configuration dialog boxes: 
Click the "Close" button.

● Editors for MCC, ST and LAD/FBD:
Click the "X" button in the top right-hand corner.

Configuration dialog boxes and editors can also be closed with the shortcut <Ctrl+F4>.
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4.3.3 SIMOTION SCOUT TIA - using the project navigator
By default, the project navigator has two tabs, the "Project" and "Command library" tabs.

The "Project" tab displays the entire project structure and is used for managing elements within 
the projects.

The commands and functions required for the programming are displayed in a tree on the 
"Command library" tab. You can search in the command library or set filters. You can use 
commands and functions in the ST, LAD/ FBD and MCC programming languages, e.g. for the 
creation of conditions. In the MCC programming language, the functions are used, e.g. via the 
ST zoom or the system function call command. 

4.3.4 SIMOTION SCOUT TIA - menus
SIMOTION SCOUT TIA menus are subdivided into static and dynamic menus. 

Static menu
Static menus are primarily used to control the workbench or a project and are permanently 
displayed.

Figure 4-1 Static menu

Dynamic menu
Dynamic menus are provided by snap-ins and are added to the static menu. Always the menu 
that is active in the workspace is being displayed.
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Figure 4-2 Example of a dynamic menu

Table 4-1 Structure of the menu bar

Menu Comment
Project Static menu, always visible
(Dynamic menu) See Dynamic menus table
Edit Static menu, always visible
Paste Static menu, always visible
Target system Static menu, always visible
View Static menu, always visible
Options Static menu, always visible
Window Static menu, always visible
Help Static menu, always visible
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Table 4-2 Dynamic menus

Dynamic menu Comment
Axis Visible only when a project has been loaded and the associated 

snap-in is active in the working area.
Dynamic menus appear in the second position on the menu bar 
after "Project."

Output cam
Measuring input
Synchronous operation
Cam
External encoder
Sensor
Controller object
Drive
Fixed gear
Formula object
Addition object
Drive control panel
Trace
ST source file
MCC unit Visible only when a project has been loaded and the associated 

snap-in is active in the working area.
Dynamic menus appear in the second position on the menu bar 
after "Project." 

MCC chart
LAD/FBD unit
LAD/FBD program

4.3.5 SIMOTION SCOUT TIA - menu items
You can use the shortcuts listed in the table to call the menu items available in 
SIMOTION SCOUT TIA.   

Table 4-3 Menu items in SIMOTION SCOUT TIA

Shortcuts Menu item Reaction
Project...
Ctrl+Alt+K Check consistency Checks project consistency
Ctrl+Alt+B Save and compile 

changes
Saves the project and compiles the changes 
made in the project since the last compilation

Ctrl+P Print Prints the selected window
Alt+F4 Exit Exits the SIMOTION SCOUT TIA program

Shortcuts Menu item Reaction
Edit...
Ctrl+Z Undo Undoes the last action
Ctrl+Y Redo Redoes the last action
Ctrl+X Cut Cuts the selection
Ctrl+C Copy Copies the selection
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Shortcuts Menu item Reaction
Edit...
Ctrl+V Paste Inserts the clipboard contents
Del Delete contents Deletes the selection
F2 Rename Renames the selected tree object
Alt+ENTER Object properties Displays the properties of an object in the project 

tree
Ctrl+Alt+O Open object Opens a new object of the selected tree object
Ctrl+A Select all Selects the entire contents in the ST and MCC 

Snap-ins

Ctrl+F Find Opens the Find window
F3 Find next Continues the search from the current position
Ctrl+Shift+F Search in the project Opens the Find window
Ctrl+Shift+G Replace in the project Opens the "Find and Replace" window

CTRL+H Replace Opens the "Replace" window
CTRL+J Display next position  

Shortcuts Menu item Reaction
Target system...
Ctrl+L
Is only possible online

Download / target device Loads individual target device

Ctrl+D
Is only possible online

Device diagnostics Opens device diagnostics

Ctrl+I
Is only possible online

Control operating mode Opens the dialog box for control of the operating 
mode

Shortcuts Menu item Reaction
View...
Ctrl+F11 Maximize working area Maximizes and restores the view of the working 

area
Ctrl+F12 Maximize detail view Maximizes and restores the view of the detail 

view
Ctrl+Num+
(Plus key on the numer‐
ic keypad)

Zoom in Enlarges the graphic in the program editors

Ctrl+Num+
(Minus key on the nu‐
meric keypad)

Zoom out Scales down the graphic in the program editors

F5 Refresh Updates the view
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Shortcuts Menu item Reaction
Options...
Ctrl+Alt+E Settings Opens the "Options > Settings" dialog box

Shortcuts Menu item Reaction
Window...
Ctrl+Shift+F5 Arrange cascading Arranges the opened windows in the working 

areaCtrl+Shift+F3 Arrange vertically

Shortcuts Menu item Reaction
Snap-in menu...
Ctrl+F4 Close Closes the selected window
Ctrl+B Accept and compile Compiles the active object
Ctrl+E Expert list Opens the expert list for the current technology 

object

Shortcuts Menu item Reaction
Help...
F1 Help topics Opens the entire help available for SIMOTION 

SCOUT TIA
SHIFT+F1 Context-sensitive help Opens the context-sensitive help function for the 

selected object, parameter, etc.

Note
List of all shortcuts

The online help of SIMOTION SCOUT TIA includes a complete list of all the shortcuts available 
in SIMOTION SCOUT TIA and the programming and operating instruction manuals.

4.3.6 SIMOTION SCOUT TIA - keyboard operation and shortcuts

Note

There are various keyboard assignments and shortcuts for the menu items to facilitate your 
work in SIMOTION SCOUT TIA.
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The following table provides an overview of the keyboard assignments or shortcuts that you 
can use for SIMOTION SCOUT TIA. 

Table 4-4 Keyboard action

Keyboard action / shortcuts Meaning
Workbench: Change window...
Alt+0 Project navigator
Alt+1 Working area
Alt+2 Detail view
Ctrl+F6 Next window in the working area
Ctrl+F11 Minimize/maximize working area in relation to the whole desktop
Ctrl+F12 Minimize/maximize detail view in relation to the whole desktop

Project navigator
Left mouse button Selects the tree object at the cursor position;

detail view displays the associated details
Double-click with left mouse button Selects the tree object at the cursor position;

detail view displays the associated details;
corresponding snap-in is opened

Right mouse button Selects the tree object at the cursor position;
detail view displays the associated details;
corresponding snap-in is opened

UP/DOWN arrow keys Selects the tree object at the cursor position
"ENTER" Snap-in for the selected tree object opens
"Context menu key" Context menu for the selected tree object opens

4.3.7 SIMOTION SCOUT TIA - using the context menus
The tree elements of the project navigator have context menus. These provide quick access 
to all major functions enabled for this tree element.   

To call up a function for the tree element via context menus, proceed as follows:

1. Select the respective element in the project navigator and right-click to open the context 
menu.

2. Left-click the appropriate menu item to select it.
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Figure 4-3 Context menu for SIMOTION device

4.3.8 SIMOTION SCOUT TIA - detail view

4.3.8.1 Using the detail view
When you select an element in the project navigator, the associated detail view will appear in 
the lower area of the workbench.     

Depending on the selected element, different tabs are offered and information about the 
element is displayed therein. 

The tabs available are determined by the project mode (offline/online) and the active snap-ins.

Figure 4-4 Example of detail view
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Each tab is opened only once, i.e.:

● The active tab shows the details of the selected element.

● The contents of the tab change when you select a different element.

You can maximize or minimize each tab using the shortcut <Ctrl+F12>.

4.3.8.2 Using the symbol browser

The symbol browser in the detail view
The symbol browser is a tab in the detail view. It displays status values of the variables for the 
element selected in the project navigator. 

To activate the symbol browser:

1. Select an element in the project navigator.

2. In the detail view, select the "Symbol browser" tab.

Continuous display of the symbol browser
To activate/deactivate the continuous display of the symbol browser: 

Click the symbol at the top right of the symbol browser.
The active element is displayed continuously until this function is deactivated. To deactivate 
this function, click the pin again.

4.3.8.3 Address list
The address list is where you create I/O variables, which you then assign to a particular item 
of hardware. You can monitor, control, and, if necessary, adapt these in the address list. You 
can enter the I/O variable assignment manually, or use an assignment wizard to make the 
relevant selections.

Opening the address list
1. Browse to the folder for the device in the project navigator. Double-click the "Address list" 

element below the device.
The address list opens in the detail area.

Note

You will find further information and guidelines on the address list in the online help of 
SIMOTION SCOUT TIA.
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4.3.8.4 Watch table

Watch table options
With the symbol browser you can view the variables belonging to one object in your project; 
with the program status you can view the variables belonging to a selected monitoring area in 
the program. With watch tables, in contrast, you can monitor selected variables from different 
sources as a group (e.g. program sources, technology objects, SINAMICS drives - even on 
different devices). You can sort the variables in the watch table in any way you wish, add 
comments regarding them, and combine them into groups. You can hide individual variables 
to make the watch table more manageable and also control variables via the watch table 
directly.

Creating a watch table 
Procedure for creating a watch table and assigning variables: 

1. In the project navigator, open the "Monitor" folder.

2. Double-click the "Insert watch table" item to create a watch table and enter a name for it. 
A watch table with this name appears in the "Monitor" folder.

3. In the project navigator, click the object from which you want to move variables to the watch 
table.

4. In the symbol browser, in the address list, or in the expert list, select the corresponding 
variable line by clicking its number in the left column.

5. From the shortcut menu, select "Add to watch table" and the appropriate watch table, e.g. 
"Watch table_1."

6. If you click the watch table, you will see in the detail view of the"Watch table" tab that the 
selected variable is now in the watch table.

7. Alternately, you can also copy and paste variables to the watch table.

8. Repeat steps 3 to 6 to monitor the variables of various objects.

You can also create a watch table direct by selecting a variable followed by "Add to watch table 
> New watch table" in the shortcut menu. The new watch table, containing the selected 
variable, is created automatically.

If you are connected to the target system, you can monitor the variable contents.

Additional references
You will find detailed information on this topic in the SIMOTION SCOUT TIA online help.

4.3.9 SIMOTION SCOUT TIA - using the help
SIMOTION SCOUT TIA has a comprehensive context-sensitive help. The following is a 
description of how to work with the help system using different examples. 
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Structure of the online help window

3

1

2

4

 1 Menu bar You can use buttons in the menu bar to configure the help or display general information.
● Click "PDF documents" to display the available function diagrams.
● Click "Use online help" to display the help page for the full text search on the "Search" 

tab.
2 Navigation area
 

In the navigation area you can navigate through the help, open the index or search through 
the entire help.
● Click the "Contents," "Index," or "Search" tab to navigate through the help.
● Click the "+" in front of a book to open the table of contents.
● Click a book or help page to display its contents in the contents area.
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3 Contents area The contents for the help pages selected in the navigation area are displayed in the contents 
area.
Within the contents area, you can use symbols to display hidden information:
●  Click the arrow to display or hide additional information.
●  Click the minimized view to display a hidden figure.
●  Click the copy symbol. The following program code will be saved automatically in the 

clipboard. You can then insert this in a program editor.
4 Link bar The header area of many help pages has a link bar. This link bar can be used to display 

further information for the selected help page. The link bar contains the following entries:
● In Section

Links to headers of the displayed topic. 
● Programming Manuals

Links to handling instructions. 
● Examples

Links to examples. 
● Fundamentals

Links to background information, such as definitions or details. 
● History

List of the most recently opened help pages. 
● Options

Link to the start page. 
Forwards and backwards in the previously opened help pages.

Features of online help

Features of online help To open the help:
Open entire help Key <F1> Press <F1>. 

or
Select "Help > Help topics" from the 
menu.

The entire help is opened.
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Features of online help To open the help:
Open Getting Started Select "Help > Getting Started" from the 

menu.

Getting Started is opened.
Help button

or

Click the Help button of the respective 
dialog box or window.
 

The context-sensitive help for the dialog box is opened.
Context-sensitive help SHIFT+F1 ● Press <SHIFT+F1>.

● or
● Click the button in the menu bar.

● or
● In the menu, select "Help > Context 

help."

The mouse pointer changes to a question mark.
● Then click with the changed mouse 

cursor on the dialog, the parameter, 
the input field (see figure) or the 
menu item.

The context-sensitive help for the selected entry opens.
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Examples of the context-sensitive help

Help in the project navigator
General help Press <SHIFT+F1> and then click with 

the question mark on the project navi‐
gator.
The general help for the project naviga‐
tor is opened.

Help for the technology ob‐
ject 
(only SIMOTION)

Press the <SHIFT+F1> and then click 
with the question mark on a technology 
object in the project navigator.
The help for this technology object is 
displayed.
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Help for the detail view
General help for the symbol 
browser

Press the <SHIFT+F1> and then click 
with the question mark in the margin of 
the symbol browser. You can also open 
the help for the symbol browser by click‐
ing on .
The general help for the symbol brows‐
er is opened.

System tags in the symbol 
browser

In the project navigator, select the SI‐
MOTION device or the technology ob‐
ject. 
The system tags of the element are dis‐
played in the symbol browser. 
Press the <SHIFT+F1> keys and then 
click with the question mark on the sys‐
tem tag in the symbol browser. 
The help for this is opened.

Help for alarms Press the <SHIFT+F1> and then click 
with the question mark on the alarm 
shown on the "Alarms" tab. 
The help for the drive alarm or techno‐
logical alarm is opened.
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Help for the expert list
Configuration data Press <SHIFT+F1> and then click with 

the question mark on the configuration 
data item in the expert list. 
The help is opened.

System tags Press <SHIFT+F1> keys and then click 
with the question mark on the system 
variable in the expert list. 
The help is opened.

Parameters of the drives Press <SHIFT+F1> and then click with 
the question mark on the parameter in 
the expert list. 
The help is opened.

Help for the LAD/FBD editor (only SIMOTION)
Declaration area
 

Press <SHIFT+F1> and then click with 
the question mark on a tab in the dec‐
laration area of the LAD/FBD editor. 
The help is opened.

Editor area Press <SHIFT+F1> and then click with 
the question mark on an element in the 
editor area of the LAD/FBD editor. 
The help is opened.
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Basics of SIMOTION configuration in the TIA Portal 5
5.1 Configuration overview

Configuring prerequisites
The following preconditions apply to configuring:

● You have installed the TIA Portal (framework), for example with the STEP 7 or WinCC 
software package.

● SIMOTION SCOUT TIA has been installed and licensed for the PG/PC.

● The hardware has been installed and wired.

● The PG/PC has been connected to the SIMOTION device via the PROFIBUS, Ethernet or 
PROFINET IO interface.

● For configuring the drives with the drive wizard, you need the article number of the drive 
unit and the components (power supply, power unit, motors and encoders).

The following table provides an overview of the individual configuring steps and where to 
implement them.

Configuring step Where
① Creating a new project TIA Portal
② Inserting SIMOTION devices TIA Portal
③ Inserting a SIMOTION drive TIA Portal
④ Compile hardware configuration TIA Portal
⑤ Configure online access TIA Portal
⑥ Configure communication TIA Portal
⑦ Configure HMI connection TIA Portal
⑧ Go online SIMOTION SCOUT TIA
⑨ Configure the drives SIMOTION SCOUT TIA
⑩ Configure the technology objects SIMOTION SCOUT TIA
⑪ Create user programs SIMOTION SCOUT TIA
⑫ Testing and diagnostics SIMOTION SCOUT TIA
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5.2 Managing projects

Basic principles
Projects are used for the orderly storage of data and programs that result in the creation of an 
automation solution. You create projects in the TIA Portal and manage them there. The data 
summarized in a project shall include, in particular:

● Configuration data on the hardware structure and parameter data for modules

● Configuration data for communication via networks

● Configuration data for the devices

● Reports

● Configuration data

● User programs

● Motion profiles 

● Drive data 

The following table provides an overview of the individual configuration steps and where to 
implement them.

Project management Where
Creating a new project TIA Portal
Open project TIA Portal
Delete a project TIA Portal
Close a project TIA Portal
Save project as TIA Portal
Migrating a project TIA Portal
Save project SIMOTION SCOUT TIA
Save project and compile changes SIMOTION SCOUT TIA
Save project and recompile everything SIMOTION SCOUT TIA
Load project to the target system SIMOTION SCOUT TIA
Saving and exporting a project SIMOTION SCOUT TIA

See also
Creating a new project (Page 65)

Transferring SIMOTION SCOUT projects (Page 68)
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5.2.1 Creating a new project

Note

You can only create a project in the TIA Portal.

Procedure
To create a project, proceed as follows:

1. Start the TIA Portal.

2. Select the "Creating new project" entry in the secondary navigation in the Portal view.

3. Assign a name for the new project below "Project name".

4. Set the storage location using the "..." button.

5. If required, enter comments in the Comment field.

6. Create the project using the "Create" button.

Figure 5-1 Creating a project

Result
You have created a project that was saved in the specified directory.
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Note
Maximum number of characters

If necessary, adjust the storage location or project name, because a maximum of 94 characters 
are available for the project name and 143 characters for the path.

5.2.2 Open project

Note

You can only open a project in the TIA Portal.

Procedure
To open a project, proceed as follows:

1. Start the TIA Portal.

2. Select the "Open existing project" entry in the secondary navigation in the Portal view.

3. Select the project you want to open in the right window under "Recently used".

4. Click the "Open" button to open the project.

If the project to be opened is not listed, proceed as follows:

1. Click the "Browse" button and navigate to the project you want to open in the following 
"Open existing project" dialog.

2. Double click the project file.

Result
You have opened the project and are in the portal view. Go to the Project view to continue with 
the configuration.

5.2.3 Close a project

Note

You can only close a project in the TIA Portal.

Basics of SIMOTION configuration in the TIA Portal
5.2 Managing projects

SIMOTION SCOUT TIA
66 Configuration Manual, 01/2015



Procedure
To close a project, proceed as follows:

1. Changeover to the TIA Portal.

2. Open the "Close" entry in the "Project" menu in the Portal view. Or select the "Close project" 
entry in the secondary navigation in the Portal view.

3. If you made changes in the project and have not saved them yet, you are asked in the "The 
project has been changed" dialog, whether you want to save the changes or not. 

Result
You have closed the selected project. SIMOTION SCOUT TIA has been closed.

5.2.4 Save project as

Note

You can only perform "Save project as" in the TIA portal.

Procedure
Proceed as follows to save project as...:

1. Changeover to the TIA Portal.

2. Select the "Save project as ..." entry in the "Project" menu in the Portal view. 

3. In the "Save current project as ..." dialog, navigate to the storage location where you want 
to save the project.

4. Assign a file name to the project.

5. Save the project at the set storage location by clicking the "Save" button.

Result
You have saved the project in the specified location.

Note
Maximum number of characters

If necessary, adjust the storage location or project name, because a maximum of 94 characters 
are available for the project name and 143 characters for the path.
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5.2.5 Delete a project

Note

You can only delete a project in the TIA Portal.

Precondition
● The project is not opened. 

Procedure
To delete a project, proceed as follows:

1. In the "Project" menu, select the "Delete project" command. 
The "Delete project" dialog opens and a list of recently used projects is displayed. The 
project that is currently open does not appear on the list.

2. Select the project you want to delete. 
If the required project is not in the list, click the "Browse" button. Navigate to the project 
folder and open the project file.

3. Click the "Delete" button.

4. Confirm the security prompt with "Yes" to delete the project permanently.

Result
The complete project folder has been deleted from the file system.

5.2.6 Transferring SIMOTION SCOUT projects

You have the following options to transfer a SIMOTION SCOUT project to SIMOTION SCOUT 
TIA:

● Migration with the migration tool in the TIA Portal (complete, including the hardware and 
network configuration, and the SCOUT data).

● Migration with the migration tool outside the TIA Portal as dual-computer solution and import 
of the SIMOTION SCOUT project via an intermediate file into the TIA Portal.

● Export of the SIMOTION SCOUT project and import into SIMOTION SCOUT TIA (only 
SCOUT data).
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Note
Readiness Check Tool TIA Portal

With the TIA Portal Readiness Check Tool, you can easily check whether the hardware 
included in your projects is supported by the TIA Portal.

You can find detailed information about the tool and a download link online under: Readiness 
Check Tool TIA Portal (http://support.automation.siemens.com/WW/llisapi.dll?
aktprim=0&lang=en&referer=%2fWW
%2f&func=cslib.csinfo&siteid=csius&groupid=4000002&extranet=standard&viewreg=WW&n
odeid0=29156492&objaction=csopen)

See also
Migrating a SIMOTION SCOUT project (Page 69)

Exporting/ importing projects (Page 75)

Examples of export/ import (Page 79)

5.2.6.1 Migrating a SIMOTION SCOUT project

Migration of a SIMOTION SCOUT project

Note

You can migrate a SIMOTION SCOUT project only together with the hardware configuration.

A SIMOTION SCOUT TIA project cannot be converted to a SIMOTION SCOUT project. 
However, you can export the SIMOTION SCOUT TIA data without the hardware configuration 
and import it into the SIMOTION SCOUT by XML export/import. See Section Exporting/ 
importing projects (Page 75). In this case, you must manually create the hardware 
configuration in the SIMOTION SCOUT so that it is identical to the TIA Portal project.
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Note
AlarmS_messages

AlarmS_messages are incremented in the number range starting at 60,000,000 for the 
migration from SIMOTION SCOUT to SIMOTION SCOUT TIA.

Note that the AlarmS information text is limited to the same characters as the AlarmS text.

Note that the associated values in the AlarmS text can be displayed only formatted 
appropriately for the data type.

Note the TIA Portal specifications for data type formattings for previously-configured 
AlarmS_messages.

If you reconfigure AlarmS_messages in SIMOTION SCOUT, check the message text for 
compatibility with TIA Portal. 

To do this, activate the "Check compatibility with TIA Portal" checkbox.

Further information is contained in the help system of the TIA Portal under "Configure 
messages > Creating and editing messages".

You must migrate a SIMOTION SCOUT project to be able to use it in SIMOTION SCOUT TIA. 

The following procedures are available for this purpose:

● Migration with the migration tool in the TIA Portal (complete, including the hardware and 
network configuration, and the SCOUT data).

● Migration with the migration tool outside the TIA Portal as dual-computer solution and import 
of the SIMOTION SCOUT project via an intermediate file into the TIA Portal.

Migration in the TIA Portal
During the migration, the project data from a SIMOTION SCOUT project can be converted for 
processing in SIMOTION SCOUT TIA. The migration is performed in the TIA Portal using the 
migration tool.

Preconditions
The following preconditions must be satisfied for a migration:

● The TIA Portal migration tool (integral part of SIMATIC STEP7 Professional V13) and the 
migration tool plug-in for SIMOTION SCOUT TIA (included on the installation DVD for 
SIMOTION SCOUT/SIMOTION SCOUT TIA) are installed.

● STEP 7 V5.5 SP4 is installed.

● SIMATIC STEP 7 Safety Advanced is installed so that Safety projects can be migrated.

● WinCC flexible V1.3 SP3 is installed.

● SIMOTION SCOUT V4.4 is installed.

● SIMOTION SCOUT TIA is installed.
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● The SIMOTION SCOUT project is consistent and can be compiled without error.

● You have saved the SIMOTION SCOUT project in SIMOTION SCOUT as of Version 4.4.

● The SIMOTION SCOUT project does not use any devices/objects/functionality not 
supported by SIMOTION SCOUT TIA.
(See Section Supported devices (Page 23) and Section Supported functionalities 
(Page 24).)

Note

Perform "Save and recompile everything" in SIMOTION SCOUT before you start the migration.

Procedure
To migrate a SIMOTION SCOUT project, proceed as follows:

1. Start the TIA Portal.

2. Select the "Migrate project" entry in the secondary navigation in the Portal view.

3. Use the "..." button to set the source path to the SIMOTION SCOUT project that you want 
to migrate.

4. Activate the "Include hardware configuration" checkbox.

5. Assign a name to the migrated project.

6. Use the "..."  button to set the target path.
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7. If required, enter comments in the Comment field.

8. Start the migration with the "Migrate" button.

Figure 5-2 Migration

Result
The migrated project is opened in the TIA Portal. 

You can find the migrated project in the selected target directory.

Note

Perform "Save and recompile all" in SIMOTION SCOUT TIA before you work with the project.
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Note
Abort of the migration

The migration is aborted with an error message if the SIMOTION SCOUT project to be migrated 
uses SIMOTION/SINAMICS devices that are not supported by SIMOTION SCOUT TIA, or the 
SIMOTION SCOUT project contains objects that are not supported. 

In the event of an error, open the project in SIMOTION SCOUT and remove the devices/objects 
that are not supported, or upgrade the firmware of the devices used. 

For information on which devices/objects/functionalities are supported, see Section Supported 
devices (Page 23) and Section Supported functionalities (Page 24).

Detailed information on the firmware upgrade can be found in Section "Upgrade" of the 
SIMOTION SCOUT TIA online help.

If the project includes further components in addition to SIMOTION components, such as 
SIMATIC components and HMI, then the migration conditions specified therein are also 
applicable.

Migration outside TIA Portal as dual-computer solution
In many cases, the project that you want to migrate is not located on the same PG/PC on which 
the TIA Portal is installed. The migration tool converts the initial project into a compatible format. 
This file can be imported and further process in the TIA Portal.

Preconditions
The following preconditions must be satisfied for a migration:

Computer 1
● The TIA Portal migration tool is installed.

The TIA Portal migration tool is available as download in the service and support area of 
the Siemens Website.

● STEP 7 V5.5 SP4 is installed.

● WinCC flexible V1.3 SP3 is installed.

● SIMOTION SCOUT V4.4 is installed.

● The SIMOTION SCOUT project is consistent and can be compiled without error.

● You have saved the SIMOTION SCOUT project in SIMOTION SCOUT as of Version 4.4.

● The SIMOTION SCOUT project does not use any devices/objects/functionality not 
supported by SIMOTION SCOUT TIA.
(See Section Supported devices (Page 23) and Section Supported functionalities 
(Page 24).)
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Computer 2
● The TIA Portal migration tool (integral part of the TIA Portal framework) and the migration 

tool plug-in for SIMOTION SCOUT TIA (included on the installation DVD for SIMOTION 
SCOUT/SIMOTION SCOUT TIA) are installed.

● STEP 7 Professional V13 is installed.

● SIMATIC STEP 7 Safety V13 is installed so that Safety projects can be migrated.

● WinCC V13 is installed if an HMI is available.

● SIMOTION SCOUT TIA V4.4 is installed.

Note

Perform "Save and recompile everything" in SIMOTION SCOUT before you start the migration.

Procedure
To perform a migration, proceed as follows: 

1. Start the migration tool on computer 1.

Figure 5-3 Migration tool

2. Navigate to your source project.

Figure 5-4 Setting the paths

3. Migrate the source project in the migration file format with the appropriate file extension 
".apxx".
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4. Copy the migration file to the target system, computer 2.

5. Perform the migration within the TIA Portal using the procedure described under "Migration 
in the TIA Portal".

Result
The migrated project is opened in the TIA Portal. 

You can find the migrated project in the selected target directory.

Note

Perform "Save and recompile all" in SIMOTION SCOUT TIA before you work with the project.

5.2.6.2 Exporting/ importing projects

Fundamentals
You can export a whole project or individual projects and subsequently import them into 
another project.

This functionality is available to you both in SIMOTION SCOUT and in SIMOTION SCOUT 
TIA. You can therefore replace project data using the export/import function. 

Restrictions
You can only export the SCOUT data with SIMOTION SCOUT TIA because hardware and 
network configuration is performed in the TIA Portal. By the same token, you only import 
projects in SIMOTION SCOUT TIA without the hardware configuration.   

Note

Export/import is only possible in offline mode.

Export/import functions
The following functions are available to you in each of the applications:

SIMOTION SCOUT SIMOTION SCOUT TIA
Export/import of com‐
plete packages 

Export/import of a project (without hardware configuration)

Export/import of indi‐
vidual devices

Export/import of an existing project (without hardware configuration)

Export/import of indi‐
vidual data or objects

Export/import of technology objects, watch tables, programs, drive objects, scripts (see restrictions 
in Section Appendix A (Page 309)), and global device and I/O variables.
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Preconditions
Project data can only be exchanged between SIMOTION SCOUT and SIMOTION SCOUT TIA 
via the export/import function if the hardware is identical. 

That means the SCOUT data exported from SIMOTION SCOUT must have identical device 
properties (name, type, version) in order to be able to import them into SIMOTION SCOUT 
TIA:  From the point of view of configuration, a SIMOTION D435-2 DP V4.4 and a D435-2 DP/
PN V4.4 are the same type.

Procedure for exporting from SIMOTION SCOUT
To export a project from SIMOTION SCOUT, proceed as follows:

1. Start SIMOTION SCOUT.

2. Open the project that you want to export.

3. Compile the project.

4. Change to offline mode.

5. Mark the project in the project navigator, right-click to open the shortcut menu and select 
"Project > Expert > Save and export...".

6. In the next dialog box, enter a target directory for the export.

Note
Access violation to target directory

Before the export, all files in the specified target directory are deleted. Therefore make sure 
that no application accesses a subdirectory or file of the specified target directory (e.g. 
Windows Explorer). In case of an error, export will be interrupted with an error message. 
In this case, close the application in question and restart export. 

7. If necessary, activate the "Use optimized export format" option.
In this format, the memory size is reduced because only the data required for a running 
system is exported. For example, all comments, minimum and maximum parameter values, 
are cut from the files.

8. If necessary, deactivate the option "Export including hardware configuration (STEP 7 data)".

9. Confirm with "OK". 

Result
The project has been exported into the specified target directory. 

Procedure for exporting from SIMOTION SCOUT TIA
To export a project from SIMOTION SCOUT TIA, proceed as follows:

1. Start the TIA Portal and open the project that you want to export.

2. Switch to SIMOTION SCOUT TIA.

3. Compile the project.
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4. Change to offline mode.

5. Mark the project in the project navigator, right-click to open the shortcut menu and select 
"Project > Expert > Save and export...".

6. In the next dialog box, enter a target directory for the export.

Note
Access violation to target directory

Before the export, all files in the specified target directory are deleted. Therefore make sure 
that no application accesses a subdirectory or file of the specified target directory (e.g. 
Windows Explorer). In case of an error, export will be interrupted with an error message. 
In this case, close the application in question and restart export.

7. If necessary, activate the "Use optimized export format" option.
In this format, the memory size is reduced because only the data required for a running 
system is exported. For example, all comments, minimum and maximum parameter values, 
are cut from the files.

Procedure for importing into SIMOTION SCOUT
This is how you import XML files for projects/objects that you previously exported from 
SIMOTION SCOUT or SIMOTION SCOUT TIA. For example: Projects, technology objects, 
drive objects, devices:

1. Open the project into which you want to import the data.

2. Change to offline mode.

3. Mark the project in the project navigator, right-click to open the shortcut menu and select 
"Project > Expert > Import SCOUT data...".

4. In the dialog box that then opens, select the source path and the source name for the import.

Note
Selecting a source path and source file

As import file, always select the XML file which bears the name of the technology object / 
device to be imported. The text field is preassigned with the file name of the exported file.  
You only have to perform the subsequent steps if you want to import a different file.

5. Select the target path and target name of the project file.
This displays the target path and target name of the currently opened project into which 
the technology object / device is being imported. You can only import technology objects / 
devices into the opened project.

6. Confirm with "OK".

7. Compile the project.

Result
You have imported the project/objects.
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Procedure for importing into SIMOTION SCOUT TIA
You only import the SIMOTION SCOUT data without the hardware configuration into 
SIMOTION SCOUT TIA. If there is any hardware configuration data in the import file it will be 
ignored. You can optionally delete any libraries, watch tables, messages contained in the target 
project when you import. Please note that you can only import SCOUT data if a corresponding 
hardware configuration exists in the target project. You overwrite the existing SCOUT data 
when you import. 

Note
Backup copy before importing

It is advisable to make a backup copy of the project before you import because deleted and 
overwritten data cannot be restored once you have imported.

This is how you import SCOUT data:

1. Open the project into which you want to import.

2. Change to offline mode.

3. Select "Project > Expert > Import SCOUT data..." or select the project in the project 
navigator and select "Expert > Import SCOUT data..." in the shortcut menu.

4. In the dialog box that then opens, select the source path and the source name for the import.

5. Confirm with "OK".

6. Compile the project.

To import the station:

1. Change to offline mode.

2. Select "Project > Expert > Import station..." 

3. In the dialog box that then opens, select the source path and the source name for the import.

4. Confirm with "OK".

5. Compile the project.
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Note
AlarmS_messages

AlarmS_messages are incremented in the number range starting at 60,000,000 for the 
migration from SIMOTION SCOUT to SIMOTION SCOUT TIA.

Note that the AlarmS information text is limited to the same characters as the AlarmS text.

Note that the associated values in the AlarmS text can be displayed only formatted 
appropriately for the data type.

Configure AlarmS_messages in SIMOTION SCOUT TIA in accordance with the TIA Portal 
specifications for data type formatting.

If you reconfigure AlarmS_messages in SIMOTION SCOUT, check the message text for 
compatibility with TIA Portal. 

To do this, activate the "Check compatibility with TIA Portal" checkbox.

Note also for previously-configured AlarmS_messages the TIA Portal specifications for data 
type formatting.

Further information is contained in the help system of the TIA Portal under "Configure 
messages > Creating and editing messages".

Result
You have imported the project/objects.

Additional references
You will find detailed information in Section "Exporting and importing" of the SIMOTION 
SCOUT TIA online help.

See also
Examples of export/ import (Page 79)

Migrating a SIMOTION SCOUT project (Page 69)

5.2.6.3 Examples of export/ import
The following describes the migration of a project via export/import by two examples.

Export/import of SIMOTION SCOUT data to SIMOTION SCOUT TIA (Example 1)
A project of SIMOTION SCOUT is migrated to SIMOTION SCOUT TIA via export/import of the 
SIMOTION SCOUT data.
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Preconditions
● A project with two C240 CPUs with distributed synchronization via PROFIBUS or 

PROFINET.

● A SIMOTION D CPU with an axis interconnected with a drive to the SINAMICS Integrated.

● An ST program with a P1 program that runs in the BackgroundTask.

● The project can be compiled without errors.

Procedure
1. Execute an export in SIMOTION SCOUT.

– Deactivate the option "Export including hardware configuration (STEP 7 data)" during 
export.

2. Create a new project in the TIA Portal.

3. Configure the hardware in the TIA Portal same as in SIMOTION SCOUT.

4. Open SIMOTION SCOUT TIA and import the previously exported SCOUT data.

5. Compile the project.

Result
● The distributed synchronization is established.

● The connection of the axis to the drive is established.

● Program P1 is entered in the execution system (BackgroundTask).

● The project can be compiled without errors.

Export/import of SIMOTION SCOUT TIA data to SIMOTION SCOUT (Example 2)
A project of SIMOTION SCOUT TIA is migrated to SIMOTION SCOUT via export/import of the 
SCOUT data.

Preconditions
Modify the sample project previously imported into SIMOTION SCOUT TIA as follows:

● Move the program P1 from the BackgroundTask into the MotionTask_1.

● Add a further drive to the SINAMICS Integrated.

● The axis is connected with the new drive.

● The project can be compiled without errors.
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Procedure
1. Execute an export in SIMOTION SCOUT TIA.

– SCOUT data without a hardware configuration

2. Start SIMOTION SCOUT.

3. Open the previously exported project from example 1.

4. Import the previously exported project from example 2.

5. Compile the project.

Result
● The axis is connected with the new drive.

● The program P1 is entered in the MotionTask_1.

● The program can be compiled without errors.

See also
Commissioning the drives (Page 217)

5.3 Configure the device.

5.3.1 Adding a SIMOTION device

Note

You can add a SIMOTION device only in the TIA Portal.

Several options are available for adding a SIMOTION device. SIMOTION SCOUT TIA does 
not support all devices that can be configured with SIMOTION SCOUT.

To find out which SIMOTION devices are supported, see Supported devices (Page 23).

To find out which functionality is supported, see Supported functionalities (Page 24).

Procedure
To add a SIMOTION device via the project tree, proceed as follows:

1. Switch to the project view.

2. Double-click "Add new device" in the project navigation.
The "Add New Device" dialog box opens.

3. Under "Controller", open the desired device variant (e.g. SIMOTION D - Drive-based).

4. Select the desired SIMOTION device.
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5. Click the article number to display device-specific information.

6. Under "Version", select the firmware version of the installed SIMOTION device.

Figure 5-5 Project tree - Add device 

7. Click "OK" to apply the settings and add the SIMOTION device.

Result
You have now created a SIMOTION device. 

In the device view, the SIMOTION device is displayed in full graphics, showing all interfaces 
and properties.

In the Inspector window under "Properties", you can configure and parameterize the interfaces 
easily and intuitively.
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Figure 5-6 SIMOTION device in the device view

All inserted devices are also visible in the project tree.

As soon as you have inserted the SIMOTION device in the TIA Portal, it is also visible in 
SIMOTION SCOUT TIA.

Note

The selected firmware version must match the firmware version on the memory card of the 
device. Otherwise an error message will appear as soon as you switch to online mode.

5.3.2 Replacing a SIMOTION device

Note

You can replace a SIMOTION device only in the TIA Portal.
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Procedure
To replace a SIMOTION device, proceed as follows:

1. In the TIA Portal, select the SIMOTION device that you want to replace in one of the views 
(topology view, network view or device view).

2. In the shortcut menu, select the "Change devices..." menu item. 

3. The "Change devices" dialog box opens.

Figure 5-7 Replace device

– The "Current device:" area displays the device to be replaced. 

– In the right-hand area, only those devices are listed that are compatible with the device 
that you want to replace.

Basics of SIMOTION configuration in the TIA Portal
5.3 Configure the device.

SIMOTION SCOUT TIA
84 Configuration Manual, 01/2015



4. In the right-hand area, select the new device.  
The selected device is displayed in the "New device:" area. 

5. Under "Version," set the correct firmware version.  
Observe the compatibility information. 

6. Click the "OK" button to close the dialog box.

7. Save the project.

Result
You have replaced a SIMOTION device. 

As soon as you replace the device in the TIA Portal and save the project, it will also be replaced 
in SIMOTION SCOUT TIA. 

Note

You can only replace devices with devices that are compatible. If you select an incompatible 
device or an incompatible firmware version, the "OK" button remains inactive.

One SIMOTION D can be replaced with another SIMOTION D only if the associated SINAMICS 
version is the same or higher. It is not possible to downgrade to an earlier SINAMICS version

Replacing hardware components may result in inconsistencies in the project. The consistency 
check points out any inconsistencies. 

Eliminate these inconsistencies as appropriate.

5.3.3 Deleting a SIMOTION device

Note

You can delete a SIMOTION device only in the TIA Portal.
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Procedure
To delete a device, proceed as follows:

1. Select the device you wish to delete.

– Device view

– Network view
In the graphical view or in the "Network overview" tab.

– Topology view
In the graphical view or in the "Topology overview" tab.

– Project navigation
In the tree structure of the project.

2. Press "Del".

3. Save the project.

Result
The SIMOTION device has been deleted. 

Once you have deleted the device in the TIA Portal, it is also deleted in SIMOTION SCOUT 
TIA. 

Note
Inconsistencies caused by deleting hardware components

Deletion of hardware components may lead to inconsistencies in the project. 

The inconsistencies are indicated in the consistency check. 

Eliminate these inconsistencies as appropriate.

5.3.4 Configuring an Ethernet interface

Creating an Ethernet subnet
You set up online communication of the PG/PC with the SIMOTION device via PROFIBUS, 
PROFINET, or Industrial Ethernet.

The most common application is the communication via Industrial Ethernet (communication 
via PROFINET protocol).

Creating a subnet is required when you configure IO devices. The following step shows how 
a subnet is created.
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Precondition
You have connected the PG/PC and the SIMOTION device with an Ethernet cable.

Procedure
To add a subnet to the SIMOTION device in the network view, follow these steps:

1. Click the Ethernet "X127" interface of the SIMOTION device where you would like to create 
a subnet.

2. Open the context menu with the right mouse button and select "Add Subnet".

Figure 5-8 Adding a subnet

Result
You have added a subnet.

Figure 5-9 Subnet added
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5.3.5 Add the expansion module SIMOTION - CX32-2

Note

You can insert a CX32-2 only via the hardware catalog in the TIA Portal.

If the computing performance of SINAMICS Integrated is not sufficient and you wish to use 
additional drives, you can insert an CX32-2 to increase performance. This module is connected 
via DRIVE-CLiQ and is thus networked via PROFIBUS Integrated.

Precondition
You have now created a SIMOTION device.

Procedure
To insert a CX32-2 in the network view, proceed as follows:

1. Go to the "Hardware Catalog" task card and open the "Controller" component.

2. Open the "SIMOTION" folder and then "SIMOTION D - Drive-based".

3. Under "Controller extensions," select the CX32-2 that you wish to use.
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4. Drag the CX32-2 onto the PROFIBUS Integrated.
The "Connection between controller and CX" dialog box opens.

Figure 5-10 CX32-2 wiring

5. Select the address (DRIVE-CLiQ interface) to which your CX32-2 is connected. Make sure 
that the configured wiring is the same as the real wiring.

DP address of the CX32-2 in the master system DRIVE-CLiQ socket on the SIMOTION device
10 X100
11 X101
12 X102
13 X103
14 X104
15 X105

6. Click "OK" to apply the settings.

Note
The configured address cannot be changed.

Once you have created the CX32-2 in the network view, you can no longer change the 
configured address. 

If you nevertheless want to change the address, you must first delete it and then create a new 
CX32-2 in the network view.
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Result
The CX32-2 is inserted in PROFIBUS Integrated and assigned to the SIMOTION module. You 
can execute the configuration of PROFIBUS Integrated and the interfaces in the Inspector 
window on the "Properties" tab.

The following figure shows a CX32-2 on a SIMOTION D435-2.

1

3

2

① DRIVE-CLiQ interface CX32-2
② DRIVE-CLiQ interface SIMOTION D435-2
③ PROFIBUS Integrated

Note
Configuring the CX32-2

You can configure the CX32-2 in SIMOTION SCOUT TIA.

5.3.6 Using communication modules

CBE20
The device is connected to PROFINET IO using the CBE20 communication board for 
SINAMICS S120. The module supports PROFINET IO with isochronous Realtime Ethernet 
(IRT), PROFINET IO with RT, and standard TCP/IP communication.

The following SINAMICS drive units support the Onboard version.

● SINAMICS S120 CU320-2 DP CBE20 V4.5

● SINAMICS S120 CU320-2 DP CBE20 V4.7
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● SINAMICS S120 CU320-2 PN CBE20 V4.5

● SINAMICS S120 CU320-2 PN CBE20 V4.7

When selecting a drive unit from the hardware catalog, you can decide whether to use the 
CBE20 communication board.

Choose the appropriate variant of the SINAMICS S120 CU320-2.

CBE30-2
A second PROFINET interface can be implemented for the SIMOTION D4x5-2 DP/PN with 
the CBE30-2 communication board.

It is not possible to use a CBE30-2 in SIMOTION D4x5-2 DP controllers.

To add the communication module, proceed as follows:

1. Select the SIMOTION device.

2. Switch to the device view.

3. Switch to the "Hardware Catalog" task card and open the "Controller" component

4. Open the "SIMOTION" folder.

5. In the "SIMOTION D – Drive Based" folder under “Communication boards,” select the 
CBE30-2 communication board.

6. Move the communication board into the device view onto the interface of the device with a 
drag-and-drop operation.

5.3.7 Inserting a SIMOTION drive

Note

You can insert a SIMOTION drive only via the hardware catalog in the TIA Portal.

A SIMOTION drive in the current version of SIMOTION SCOUT TIA is a drive of the SINAMICS 
S120 type (interconnection via PROFINET or PROFIBUS) interconnected with a SIMOTION 
CPU. The explicit SIMOTION drives you can insert can be found in Supported devices 
(Page 23).

These SIMOTION drives can be configured and parameterized only under these conditions 
(interconnection with SIMOTION CPU). The latter is configured in SIMOTION SCOUT TIA.

Procedure
To insert a SIMOTION drive (SINAMICS S120), proceed as follows:

1. Insert a SIMOTION device, if not available yet.

2. Create the bus system (DP master system or PN/IO system).

3. Navigate in the hardware catalog to the "Controller" component and open the "SIMOTION" 
folder. 
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4. Open the "SINAMICS S120" sub-folder in the "SIMOTION drives" folder and select the 
desired drive, in the example "CU310-2 PN".

5. Move the drive onto the bus system with a drag-and-drop operation.

6. Assign the master system. 
To do this, click "Unassigned" and select the device with which the drive is to be networked.

Figure 5-11 Networking the drive

Result
You have networked the drive with the SIMOTION device via the bus system. 

You perform the settings on the bus system in the Inspector window in the "Properties" tab. 
Here, you can specify, among other things, the transmission speed, configure the line, and set 
the bus parameters and equidistance. 

Figure 5-12 Networked drive
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Note

You perform the configuration of the drive in SIMOTION SCOUT TIA.

5.3.8 Inserting a Startdrive drive

Precondition
● You have installed "Startdrive" option package.

● You have now added a SIMOTION device.

Procedure

Inserting a drive and assigning it to a controller
To insert a Startdrive drive (SINAMICS G120 / SINAMICS G110M), proceed as follows:

1. Insert a higher-level controller, e.g. a SIMOTION D435-2.

2. Switch to the network view.

3. Double-click "Add new device" in the project tree.
The "Add new device" dialog box opens.

4. Open the variant of the drive you require under "Drives."

5. Then select the desired drive.

6. Click on drive to display its device-specific information.
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7. Under "Version," select the firmware version of the drive.

Figure 5-13 Selecting a Startdrive drive

8. Click "OK" to apply the settings and add the Startdrive drive.

Adding a Power Module
1. Switch to the device view

2. Navigate to the "Hardware Catalog" task card and open the "Power Modules" component.

3. Select the Power Module that you want to use. In the example it is a PM240.

4. Move the Power Module onto the drive with a drag-and-drop operation.

5. Assign the master system. To do this, click "Unassigned" and select the device with which 
the drive is to be networked.
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Result
You have created a Startdrive drive and added the Power Module.

You have networked the drive with the SIMOTION device.

The device view displays a full graphical view of the Startdrive drive, showing all interfaces 
and properties.

Figure 5-14 Startdrive drive in the device view

The inserted Startdrive drive is visible in the project tree.

As soon as you have inserted the Startdrive drive in the TIA Portal, it will also be visible in 
SIMOTION SCOUT TIA.

5.3.9 Inserting a GSD drive
If you are using a drive that cannot be configured via SIMOTION SCOUT TIA or Startdrive, 
insert this drive as a GSD drive. Various Siemens drives, such as the SINAMICS S150 
CU320-2, are available as a GSD drive in the TIA Portal.
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Procedure

Inserting a GSD drive and assigning it to a controller
To insert a GSD drive and assign it to a controller, proceed as follows:

1. Insert a higher-level controller, e.g. a SIMOTION D435-2.

2. Switch to the "Network view."

3. Navigate to the "Hardware Catalog" task card and open the "Other field devices" 
component.

Figure 5-15 Selecting field devices

4. Select the GSD drive in the hardware catalog. In the example it is SINAMICS GM150.

5. Move the GSD drive onto the "Network view" with a drag-and-drop operation.

6. Assign the master system. 
To do this, click "Unassigned" and select the device with which the GSD drive is to be 
networked.
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Configuring telegrams for the communication
Communication between the control and the drive is performed via PROFIdrive telegrams. 
Different telegrams are available, depending on the task.

1. Select the GSD drive and switch to the device view.

2. Display the device overview.

3. Navigate to the "Hardware catalog" task card. 
The telegrams available for this drive are displayed.

Figure 5-16 Hardware catalog telegrams
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4. Select a telegram. 
In the device view, the possible positions for insertion are indicated by blue lines.

Figure 5-17 Selecting a telegram

5. Move the telegram into the device overview and the desired position in a drag-and-drop 
operation. 
The I/O addresses are assigned automatically. 

6. If required, adapt the I/O addresses for the motion control applications.

Result
You have created a GSD drive and networked it with the SIMOTION device.

You have inserted a telegram for the communication between controller and drive.

Figure 5-18 Telegram inserted into device overview
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As soon as you have inserted the GSD drive in the TIA Portal, it will also be visible in SIMOTION 
SCOUT TIA.

5.4 Configuring online access

5.4.1 Online access of the project

Displaying available nodes in the TIA Portal 
In the "Online access" folder in the project navigation, you will find all active interfaces on your 
PG/PC. At each interface icon, you get information about the current status. You can view the 
available nodes and use the context menu to show and change the properties of an interface.

Procedure
To display the available nodes on a single interface of the PG/PC, proceed as follows:

1. Open the "Online access" folder in the project navigation.

2. Click the arrow to the left of "Online access" to make all objects that are located below the 
interface visible.

3. Double-click "Update available nodes" below the interface.

4. All nodes that are available via this interface are displayed in the project navigation.

Figure 5-19 Available nodes
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5.4.2 Setting up the PG/PC communication

Note

You assign the PG/PC interface in the TIA Portal.

Communication between a SIMOTION device and a PG/PC requires a conditioner card (for 
PROFIBUS) or an Ethernet interface. You configure, parameterize, program and test using 
the PG/PC.

You have the following functions to assign the PG/PC interface:

● "Connect online" function (function is available until the PG/PC interface is set up 
successfully)

● "Online & diagnostics" function

● "Online access" function

Assign PG/PC interface 

The following procedure describes the process for the Ethernet interface type by using the 
"Online access" function.
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To assign the interfaces, proceed as follows:

1. Navigate to the appropriate interface in the project tree under "Online access".

2. In the shortcut menu, click "Properties".

Figure 5-20 Online access properties

3. In the next step, select the subnet and apply the setting with "OK".
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Figure 5-21 Assigning a subnet
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Adding an IP address in the subnet
1. Click  on the toolbar.

The "Select Devices for Setting Up the Online Connection" dialog box opens.

Figure 5-22 Selecting a device for online connection

2. Select the device and confirm with "Connect".
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3. Assign an IP address to the PG/PC that is located in the subnet of the SIMOTION device.
If you have not already done, it is now possible to temporarily assign a suitable IP address 
from the subnet of the device.

Figure 5-23 Assigning an IP address

4. Confirm with "Yes".

Figure 5-24 IP address assigned

Result
● You have assigned the PG/PC interface.

● The TIA Portal has assigned an IP address within a project. 

● The online connection has been established.
The title bar of the project navigation is orange colored.
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Displaying and deleting temporary IP addresses
You can display and also delete all temporarily assigned addresses.

1. Navigate in the project navigation under "Online access" to the appropriate interface.

2. In the shortcut menu, click "Properties".

3. Under Configuration, select the "IE-PG Access" item.

Figure 5-25 Displaying and deleting temporary IP addresses

Compiling a project and loading the hardware configuration in a SIMOTION device

Note

Before you continue configuration in the SIMOTION SCOUT TIA, you should download the 
hardware configuration in the TIA Portal to the SIMOTION device.

Downloading to the SIMOTION device from the TIA Portal is required if you want to change, 
for example, the device name or IP address. In addition, the loading in the TIA Portal results 
in the routing information being loaded.
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Precondition
The online connection to the SIMOTION device is disconnected.
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Procedure
Proceed as follows:

1. Select the SIMOTION device and select "Compile > Hardware (only changes)" from the 
context menu.

Figure 5-26 Compile hardware

2. Select the SIMOTION device and choose "Load in device > Hardware configuration" from 
the context menu.

Figure 5-27 Load hardware
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Result
You have compiled the current hardware configuration and loaded it to the target device.

Additional references
You will find a detailed description of how to set up the Ethernet interfaces in SIMOTION 
SCOUT TIA in the online help "SIMOTION SCOUT TIA Getting Started".

For detailed information about the configuration of the online access, refer to the information 
system of the TIA Portal "Configuring online access".

See also
Not possible to connect to target system (Page 214)

5.5 Diagnostics and functions

5.5.1 Overview
The following device diagnostics functions are available, for example, via the online and 
diagnostics view:

● Display diagnostics status of a module

● Read out diagnostics buffer of a CPU

● Assign an IP address to a PROFINET IO device

● Determine and set the time of a CPU

● Assign PROFINET device name

● Reset the parameters of the PROFINET interface

Calling up the online and diagnostics view
To call up the online and diagnostics view, proceed as follows:

1. Open the device view.

2. Select the module to be diagnosed.

3. Choose "Online> Online & diagnostics" from the main menu, or select "Online & 
diagnostics" in the context menu.

Result
The online and diagnostics view of the module to be diagnosed is started.
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Note

If no online connection is available when starting the online and diagnostics view, no online 
information can be displayed and the corresponding display fields remain empty.

Structure of the online and diagnostics view
Via the group "Online access" it is displayed if there is currently an online connection to the 
associated target or not. Furthermore, you can also establish or cancel an online connection.

The "Diagnostics" folder contains several diagnostic groups for the selected module.

The "Functions" folder contains several groups in which you make can make settings on the 
selected module or output commands at the module.

Figure 5-28 Online and diagnostics view
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5.5.2 Diagnostics

General
The "General" group shows the general characteristics and system-relevant information for a 
module.

The following areas are displayed:

Module The "Module" area contains information such as short designation, Article No., firmware, hard‐
ware, rack, and slot.

Module information The "Module information" area contains information such as device name, module name, plant 
ID, and location designation.

Manufacturer information The "Manufacturer information" area contains information, such as manufacturer description, 
device name, serial number, copyright, and profile details.

Diagnostics status
The "Diagnostics status" group displays the status of the module from the perspective of the 
CPU.

Diagnostics buffer
The diagnostics buffer is used as a log file for the diagnostic events that have occurred on the 
CPU and its associated modules. These are entered in the order they occurred, with the most 
recent event shown at the top.
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The following areas are displayed:

Events Activate the option "CPU time stamp considers local PG/PC time" if you want the diagnostics 
buffer entries to be displayed with the time that is calculated using the following formula: Dis‐
played time = module time + time zone offset of your PG/PC
It is assumed that the module time is identical with UTC.
Use this setting if you want to see the local time of your PG/PC as the time of day in the diag‐
nostics buffer entries of the module.
If you activate or deactivate the checkbox, the time information of the diagnostics buffer entries 
is immediately adjusted.
The events with consecutive number, date and time, and short description of the event are listed 
in the events table.
If you click the "Freeze display" button, the current display of the diagnostics buffer entries will 
be frozen. If there is a quick succession of diagnostic events, this lets you examine the entries 
without a hurry. The CPU continues to enter events in the diagnostics buffer. Click "Cancel 
freezing" to update the diagnostics buffer entries again.

Event details Detailed information such as the consecutive number of the event in the diagnostics buffer, 
event ID, description of the event with event-related additional details, time stamp, and infor‐
mation as to whether it is an incoming or outgoing event is displayed in the "Events" area.
If you click the "Help for event" button, the selected event will be explained in greater detail and, 
if applicable, remedies are suggested.
If you click the "Open in Editor" button, the referenced block is opened in the offline view at the 
programming instruction causing the error if reference is made in the diagnostic event to a 
relative address of a block. This allows you to check the source code of the block at the specified 
location and, if necessary, change and subsequently load it back into the CPU.
If the diagnostic event was triggered by a module, the "Open in Editor" function opens the device 
view of the module concerned.
Click "Save as..." if you want to save the contents of the diagnostics buffer in a text file.

Settings In the "Settings" area, you can configure how the events should be displayed.

Communication
The following areas are displayed:

Connection resources, 
maximum number

Specifies the maximum number of available connection resources of the module. In each case, 
a certain number of available connection resources is reserved for PG, OP communication, S7 
communication, and S7 basic communication. 
However, you can create additional PG or OP connections; the number of unassigned connec‐
tion resources is then reduced accordingly.

Cycle load through com‐
munication

The CPU's cycle time can be extended due to communication processes. These communication 
processes include, for example: 
● Data transfer to another CPU
● Loading of blocks is triggered via a programming device (PG)
The duration of these communication processes can be controlled to a certain extent by means 
of the CPU parameter "Cycle load through communication." 
Via the parameter "Cycle load through communication", you indicate the percentage of total 
CPU processing power that is to be available to the communication processes. 
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Displaying interfaces and interface properties of a module
The interfaces and interface properties of a module can be found in the following groups: 

● MPI/DP interface

● DP interface

● PROFINET interface

Additional references
Detailed information about diagnostic functions can be found in the information system of the 
TIA Portal under "Diagnose hardware".

5.5.3 Functions

Assigning an IP address 
If the IP address of a device is located in a different subnet than the IP address of the network 
card, you must first assign the network card an additional IP address with the same subnet 
address as that of the device. Only then is communication between the device and the PG/PC 
possible.

Assigning an additional temporary IP address may be automatically suggested when you want 
to perform an online action and the current IP address of the PG/PC is not already located in 
the correct subnet.

A temporarily assigned IP address is valid until the next restart of the PG/PC or until it is 
manually deleted.

Setting the time of day
In the "Set time" folder, you can determine and change the time of a CPU. This is only possible 
if there is an existing online connection.
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The following areas are displayed:

PG/PC time: Here the set time zone, the current date, and the current time-of-day of your PG/PC is displayed.
Module time The "Module information" area contains information such as device name, module name, plant ID, 

and location designation.
Here the current date and time values that were read from the module (e.g. CPU) and converted 
to local time are displayed.
If the checkbox "Import from PG/PC" is selected, clicking on the button "Apply" triggers transfer of 
the date and PG/PC time (converted to UTC time) to the module.
If the checkbox "Import from PG/PC" is cleared, you can specify the date and time for the internal 
clock of the module. After clicking the "Apply" button, the date and time of day (converted to UTC 
time) will be transferred to the module.

Time system In the "Time system" area, the following factors are considered for the time-of-day and synchroni‐
zation:
● Resolution:

Specifies the accuracy of the calculation and output of the time-of-day
● Real-time clock:

Displays if the CPU has a real-time clock: "Present" if yes; "Not present" if no
● Correction factor:

Parameterized correction factor for the real-time clock of the module. The daily deviation of the 
clock is corrected using the correction factor.

Synchronization can be achieved through synchronization mechanisms between the clocks of var‐
ious sub-systems. The time synchronization settings are made during module parameterization.
The integrated real-time clock - if present - can synchronize the clocks of other modules (master) 
or can be synchronized by the clocks of other nodes (slave), or it does not participate in the syn‐
chronization. Synchronization can be performed in the AS or MPI.

Assign name
Before an IO device can be addressed by an IO controller, it must have a device name. In the 
case of PROFINET, this method was chosen because names are easier to handle than 
complex IP addresses.

The assignment of a device name for a PROFINET IO device can be compared with setting 
the PROFIBUS address of a DP slave.

In its delivery state, an IO device does not have a device name. An IO device can only be 
addressed by an IO controller, for example, for the transfer of project engineering data 
(including the IP address) during startup or for user data exchange in cyclic operation, after it 
has been assigned a device name with the PG/PC.

Resetting to factory settings
Select "Reset to factory settings" to reset the parameters of the PROFINET interface to their 
original factory settings.

Additional references
Detailed information about diagnostic functions can be found in the information system of the 
TIA Portal under "Diagnose hardware".
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Configuring communication 6
6.1 Devices and networks in the TIA Portal

6.1.1 Configure and parametrize communication

Editing devices and networks
In the TIA Portal, you edit devices and networks in the hardware and network editor. For a 
detailed description, please refer to the corresponding chapter in the information system of the 
TIA Portal below "Editing devices and networks". Note that modules can be fully parameterized 
only if they are assigned to a CPU. Therefore, PROFIBUS or PROFINET modules need to be 
networked first, so that they form a master system or IO system.

Only then, for example, can the addresses of the component be edited.

In this section, only the settings relevant to SIMOTION are listed below:

● PROFIBUS Integrated on SIMOTION D

● SIMOTION on PROFIBUS DP

● SIMOTION and PROFINET IO

● SIMOTION drives on PROFIBUS DP

● SIMOTION drives on PROFINET IO

Representation in the user interface
Devices and networks are shown in the device view and the network view.

Device view
In the device view, the device is illustrated with all interfaces. Additional modules can also be 
added, e.g. communication boards.

In the device overview, the parameters of the individual interfaces are shown in tabular form.

If you select an interface or the whole device, you will see the corresponding parameters 
displayed in tabs in the Inspector window.

Network view
In the network view, you perform the following tasks:

● Configure and parametrize devices

● Network devices with each other
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For SIMOTION devices, this means that you can network the SIMOTION modules with each 
other or with drives or SIMATIC modules or PN IO devices (e.g. ET200SP, third-party devices) 
in the network view.

In the network overview, the parameters of the modules are shown in tabular form.

If you select a device or the bus, you will see the corresponding parameters displayed in tabs 
in the Inspector window.

Configuring telegrams
The telegram configuration is performed exclusively in SIMOTION SCOUT TIA. There, you 
specify the telegrams or allow specification of the telegrams by the symbolic assignment.

The telegrams configured for the respective drive objects are displayed in the device overview 
of the device.

Figure 6-1 View telegrams

Note
Deleting telegrams in the TIA Portal

Deleting telegrams in the TIA Portal can result in synchronization errors between SCOUT TIA 
and the TIA Portal.
● Avoid deleting telegrams in the TIA Portal.
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6.1.2 Telegram configuration and symbolic assignment

Introduction
The communication and also the communication roles of PROFINET IO controllers/IO devices 
or master-slave relationships for PROFIBUS DP are based on the use of telegrams. The 
telegrams and necessary interconnections can be automatically created during configuration 
in SIMOTION SCOUT TIA via the symbolic assignment. This in turn is a prerequisite for the 
automatic setting of the communication relationships in the TIA Portal.

Symbolic assignment in SIMOTION SCOUT TIA
SIMOTION SCOUT TIA supports the symbolic assignment on SINAMICS drive objects (DOs) 
during the configuration of technology objects (TOs) and I/Os. This simplifies the configuration 
of the technological relationships, including communication between IO controllers and IO 
devices (e.g. drives) for PROFINET IO or master and slave for PROFIBUS DP.

After the configuration of the hardware in the TIA Portal (devices created, ports networked), 
you should configure the drives and technology objects (axes) in SIMOTION SCOUT TIA. 
Because of the selected functions for the configuration of the drives and technology objects, 
the required telegrams are determined. They are used as basis for the communications 
configuring in the TIA Portal. If a telegram configuration exists, the TIA Portal makes the 
required settings automatically, e.g. the Sync-Master and Sync-Slave synchronization roles 
are preassigned automatically and a clock synchronization set. Note this for further actions.

Note

Before communications are configured in the TIA Portal, the drive and axis should be 
configured with active symbolic assignment in SIMOTION SCOUT TIA.

You will find further information on symbolic assignment in the "SIMOTION Runtime Basic 
Functions" Function Manual.

6.2 PROFINET IO

6.2.1 Device settings on the PROFINET IO

Introduction
This chapter briefly explains the basic concepts and properties of PROFINET IO.

PROFINET IO
PROFINET, as an Ethernet-based automation standard specified by PROFIBUS International 
(PI - PROFIBUS & PROFINET International), defines a manufacturer-independent 
communication, automation and engineering model.

Configuring communication
6.2 PROFINET IO

SIMOTION SCOUT TIA
Configuration Manual, 01/2015 117



You will find SIMOTION-specific settings and parameters described in detail in the "SIMOTION 
SCOUT Communication" Function Manual.

PROFINET IO systems
A PROFINET IO system consists of a PROFINET IO controller and its assigned PROFINET 
IO devices. A PROFINET IO controller is (e.g. SIMOTION D4x5-2 DP/PN) controls the 
automation task. A PROFINET IO device (e.g. SINAMICS S120) is controlled and monitored 
by an IO controller.

RT classes and isochronous mode
PROFINET offers two transmission protocols that are adapted to the requirements of 
automation. These are PROFINET IO with RT and PROFINET IO with IRT. For typical motion 
control applications, an isochronous application with IRT is required. As well as synchronizing 
the transmission network, IRT enables the application (e.g. SIMOTION position controller and 
interpolator) to be synchronized in the devices (isochronous application). 

Addressing of PROFINET IO devices 
In addition to the MAC and the IP address, PROFINET also uses a device name 
(NameOfStation) to identify PROFINET devices. 

Creating PROFINET subsystem
If you want to create a new PROFINET subsystem, proceed as follows:

1. Right-click the PN interface at which you want to create a subsystem.

2. Select "Create subnet" if you want to create a new subnet.

3. Select "Assign subnet" if you want to assign an existing subnet to the PN interface.

Editing an IP address
You set IP addresses in the Inspector window in the "General" tab. Normally, an IP address 
is assigned to your SIMOTION device ex factory. Thus, you need not change it when it fits 
your PROFINET subnet. 

1. In the network view/ device view, select the interface whose IP address you want to edit.

2. In the Inspector window, select the "Properties" tab and click the "General" tab.

3. Select "Ethernet addresses."
You will now see the IP address and subnet mask below the "IP protocol." 

Note

Make sure that all IP addresses and subnet masks are in the same area.

4. On the tab, you can select the subnet to which the interface is assigned with "Interface 
networked with."
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Assigning device names
Before an IO device can be addressed by an IO controller, it must have a device name. In the 
case of PROFINET, this method was chosen because names are easier to handle than 
complex IP addresses.

If you want to change the PROFINET device name, then you have to pay attention to the DNS 
naming conventions. For more information, refer to the online help of the TIA Portal below 
"Address and naming convention for PROFINET devices."

1. In the network view/ device view, select the interface whose device name you want to edit.

2. In the Inspector window, select the "Properties" tab and click the "General" tab.

3. Select "Ethernet addresses."
You now see under "PROFINET" the setting options of the device name.

4. If necessary, change the device name or select "Automatically generate PROFINET device 
name" for automatic generation.

Note
Converted device names

The TIA Portal supports PROFINET device names that do not conform with the DNS name 
conventions. A "converted name" is generated from the non-conform PROFINET device name. 
This is the device name that is actually loaded into the device. The PROFINET device name 
is converted only when it does not conform to the IEC 61158-6-10 rules. The PROFINET device 
name and the converted name are displayed for the properties of the PN interface. You cannot 
change the converted name; it is generated automatically.

6.2.2 Brief introduction communication configuration SIMOTION controller with 
SIMOTION drive via PROFINET IO

6.2.2.1 SIMOTION controller with PROFINET IO drive

Introduction
This chapter explains how to get started quickly with communication configuration of a 
PROFINET IO system using the examples of a SIMOTION D455-2 DP/PN with a SINAMICS 
S120 CU320-2 PN drive.

Configuration example Description
SIMOTION D455-2 DP/PN IO controller Sync master in the sync domain (IRT)

Servo isochronous mode of the subnet
IO device SINAMICS S120 CU320-2 PN Sync slave in the sync domain (IRT)

IO device isochronous mode with the servo clock
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Note

For the following steps, symbolic assignment must have been activated in SIMOTION SCOUT 
TIA and the drive and axis must have been configured before communication configuration.

The basic theoretical principles are described in the SIMOTION SCOUT Communication 
Function Manual or in the information system for the TIA Portal.

How quick start configuration works

How to configure an isochronous PROFINET IO system:
1. Insert a SIMOTION D4x5-2 DP/PN (PROFINET IO controller) and a SINAMICS S120 

CU320-2 PN (PROFINET IO device) (Inserting devices (Page 120)).

2. Configure a PROFINET IO system (Inserting a subnet (Page 121)).

3. Interconnect the topology. This is necessary if you are using PROFINET IO with IRT 
(Interconnecting topology (Page 124)).

4. Switch to SIMOTION SCOUT TIA and configure the drive and the telegrams (Telegram 
configuration (Page 124)).

5. Switch to the TIA Portal. All necessary settings for communication configuration are 
performed automatically (Communication configuration (Page 126)).
The PROFINET IO system is fully configured. Further operating steps are only required if 
you want to make changes to the default settings.

A detailed description of the individual steps is given in the next chapters.

6.2.2.2 Inserting SIMOTION D455-2 DP/PN and SINAMICS S120 CU320-2 PN

Precondition
You have created a project in the TIA Portal and inserted a SIMOTION D455-2 DP/PN (S120) 
and a SINAMICS S120 CU320-2 PN drive in the network view via the hardware catalog.

Inserting a device and drive
1. Insert a SIMOTION D455-2 DP/PN (S120) from the hardware catalog in the network view 

via drag & drop. The IP address and the PROFINET device name are assigned 
automatically. You can leave the default settings unchanged or adjust them accordingly. 

2. Insert a SINAMICS S120 CU320-2 PN from the hardware catalog in the network view via 
drag & drop. The IP address and the PROFINET device name are assigned automatically. 
You can leave the default settings unchanged or adjust them accordingly. 

After inserting the hardware, the network view is represented as follows. The drive unit is shown 
as "Not assigned."
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Figure 6-2 SIMOTION D455-2 DP/PN and SINAMICS S120 CU320-2 PN in the network view

 In the next step, you will create a PROFINET IO system.

6.2.2.3 Creating a PROFINET IO system

Introduction
After inserting the hardware, it must first be added to a subnet. Unassigned devices are 
displayed as "Not assigned." Nodes of a subnet form a PROFINET IO system. A sync domain 
is also needed for synchronizing PROFINET IO devices. The sync domain ensures that all 
nodes are synchronized. When a subnet is created, a new sync domain is also created. 
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Creating a sync domain

How to add devices to a sync domain:
1. In the network view, click on the link "Not assigned" on the SINAMICS S120 CU320-2 PN. 

All IO controllers in the project are displayed.

Figure 6-3 Assigning an IO device to an IO controller

2. Click on the displayed PROFINET device name of the SIMOTION D455-2 DP/PN to connect 
it to the IO device SINAMICS S120 CU320-2 PN. A PROFINET IO system and a sync 
domain with the two nodes is automatically created.
If you assign another IO device to the IO system of the IO controller, the IO device will 
automatically be assigned to the sync domain of the IO controller.

After you have assigned the drive unit, a sync domain ① and a PROFINET IO system ② will 
be created automatically. The IO controller is created as a sync master and the drive unit is 
created as an IO device without synchronization ③. The RT class and the synchronization 
role of the drive unit is created automatically after configuration of the drive and the axis in 
SIMOTION SCOUT TIA.
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Figure 6-4 Sync domain and PROFINET IO system

The topology is connected in the next step. 
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6.2.2.4 Interconnecting the topology

Introduction
A prerequisite for isochronous IRT is the topology configuration. In the example, a connection 
from the port of the IO controller (SIMOTION D455-2 DP/PN) to the port of the IO device 
(SINAMICS S120 CU320-2 PN) must be configured. The configuration is performed in the 
topology view.

Configuring the topology
1. Switch to the "Topology view" tab. 

2. Click on the port of SIMOTION D455-2 DP/PN. The topmost port (X150 P1) is used.

3. Hold down the left mouse button and draw a connection to the port of the SINAMICS S120 
CU320-2 PN. The topmost port (X150 P1) is used.

The connection between the ports is created.

Figure 6-5 Configuration of the topology in the topology view

After this step, configuration in the TIA Portal is complete. The next steps are performed in 
SIMOTION SCOUT TIA.

6.2.2.5 Configuration of technology and telegrams in SIMOTION SCOUT TIA

Introduction
After you have inserted the hardware in the TIA Portal and configured the topology, switch to 
the SIMOTION SCOUT TIA to configure the drive and the axis (technology). This step is 
necessary for automatic communication configuration. With configuration of an axis on the 
drive, the TIA Portal automatically configures communication, e.g. the drive as a sync slave 
that is isochronous with the servo clock. 
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Procedure

Note

You will find the precise procedure for configuration of the drive and the axis in the "SIMOTION 
SCOUT TIA" configuration manual in chapter Motion control parameterization/programming.

1. Open SIMOTION SCOUT TIA.

2. Configure the drive. In the example, a SINAMICS S120 CU320-2 PN.

3. Create an axis and assign it to the drive in the axis wizard.
If only one axis and one drive are present in the project, the correct assignment is 
automatically displayed.

Figure 6-6 Axis is assigned to the drive during configuration

4. "Save and compile" in SIMOTION SCOUT TIA. During active symbolic assignment, the 
technological relationships and the telegrams are configured in the SIMOTION SCOUT TIA 
automatically if symbolic assignment is active.

5. Open the telegram configuration below the drive unit to view the configured telegrams.
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Result
The telegrams and address have been synchronized with the TIA Portal. With the item 
"Telegram configuration" below the drive unit, you can go to the telegram overview in which 
blue checkmarks are now shown. 

Configuration in SIMOTION SCOUT TIA has now been completed. The communication 
configuration has therefore been created automatically in the TIA Portal.

Figure 6-7 Drive and axis configuration in the SIMOTION SCOUT TIA

6.2.2.6 Automatic communication configuration in the TIA Portal

Introduction
After synchronization of the telegrams of SIMOTION SCOUT TIA to the TIA Portal, the 
communication configuration will automatically be adapted in the TIA Portal. All necessary 
communication settings required because of the technology configuration in SIMOTION 
SCOUT TIA have been adapted automatically. You can check the automated settings below. 
Communication configuration has now been completed.
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Checking automatic communication configuration
In the table, you can see the necessary communication configuration settings. You can check 
them.

Configuration example Description
SIMOTION D455-2 DP/PN IO controller Sync master in the sync domain (IRT) ①

Servo isochronous mode of the subnet ③
IO device SINAMICS S120 CU320-2 PN Sync slave in the sync domain (IRT) ②

IO device isochronous mode with the servo clock 
④

Checking sync domain, sync master, sync slave ① ②
1. Select the PROFINET IO system in the network view and click on the "Sync domain" item 

on the "General" tab of the inspector window. You can check the settings there.

Figure 6-8 Checking sync domain, sync master, sync slave
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Servo isochronous mode of the subnet ③
1. Select the PROFINET IO system in the network view and click on the "Overview 

isochronous mode" item on the "General" tab of the inspector window. You can check the 
settings there. 

Figure 6-9 Isochronous mode of the subnet

IO device (sync slave) isochronous with the servo clock ④
1. In the network view, select the PN interface of the IO device and click on the item 

"isochronous mode" on the "General" tab of the inspector window. You can check the 
settings there. The isochronous telegram of the drive is shown in the detailed view.

Figure 6-10 Isochronous mode of the IO device in the servo clock

If you would like to change the preset values, e.g. the send clock, you will find more detailed 
explanations in the following chapters.
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6.2.3 Sync domain, topology, and isochronous mode

6.2.3.1 Drives and IO devices on the PROFINET IO

Introduction
A SIMOTION device should be connected with an IO device via PROFINET, in our example, 
a drive device. You have already inserted a SIMOTION device with integrated PROFINET 
interface into your project.

Chapter "Adding a SIMOTION device (Page 81)" describes inserting a SIMOTION device in 
detail.

Note

Drive devices that are not networked or assigned to an IO controller are not displayed in 
SIMOTION SCOUT TIA.
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Inserting and editing drives
To operate a drive as an IO device, proceed as follows:

1. Select a SIMOTION drive in the hardware catalog under "Controller> SIMOTION> 
SIMOTION drives" and drag it into the network view.

2. Click the link on the unassigned device in the network view (in the example, a SINAMICS 
S120).
All possible IO controllers in the project are displayed.  

Figure 6-11 Assigning an IO device to an IO controller

3. Assign the drive to a SIMOTION controller. You now have a PROFINET IO system. A 
PROFINET IO system and a sync domain with the two nodes are created automatically. If 
you assign another IO device to the IO system of the IO controller, the IO device is assigned 
automatically to the sync domain of the IO controller.

Figure 6-12 SINAMICS drive device on SIMOTION D4x5-2 via PROFINET
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Note

You need a telegram for the communication between a SIMOTION controller and a drive. 
Telegrams are configured in SIMOTION SCOUT TIA. This requires that you configure the drive 
and the axis in SIMOTION SCOUT TIA. If "Symbolic assignment" is activated, the required 
telegrams are configured automatically for saving and compiling.

After inserting the IO device, you can configure the sync domain and isochronous mode of the 
IO device. For motion control applications, isochronous mode is required.

See also
Real-time settings on IO devices and I devices (Page 150)

Configure sync domains and send clock (Page 131)

6.2.3.2 Configure sync domains and send clock

Configuring sync domains
A sync domain is needed for synchronizing PROFINET IO devices. The sync domain ensures 
that all nodes that belong to it are synchronized. After being added, the nodes of the sync 
domain are not synchronized.

After inserting a SIMOTION CPU and a SIMOTION S120 drive device, they must first be added 
to a subnet. Unassigned devices are displayed as "Not assigned." 

How to configure the sync domain:
1. Select the PROFINET IO system in the network view.

2. In the Inspector window, select the "General" tab and click the item "Sync domain." You 
can set the parameters in the tab.

3. You can set a new name under sync domain. It is converted automatically into a conformant 
name that is displayed under "Converted name."

4. Select the sync master (in the example, SIMOTION D445-2 DP/PN) and select the RT class 
for the IO device (in the example, SINAMICS S120). When you select IRT, the 
synchronization role of the IO device is set automatically to sync slave.

5. Select the "send cycle clock" for the sync domain.

Note

You can set the send cycle clock only when you have configured the synchronization role 
and the RT class under "IO devices."

Configuring communication
6.2 PROFINET IO

SIMOTION SCOUT TIA
Configuration Manual, 01/2015 131



Figure 6-13 Configuring the sync domain
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Explanation of the parameters

Parameters Description
③ Sync domain Name of the sync domain. This name is converted automatically if it does not 

conform with the DNS conventions.
④ IO devices Here, you can see a list of the IO devices of the sync domain. You can select the 

following parameters for the nodes:
● RT class: Select either RT (Real Time) or IRT (Isochronous Real Time).
● Synchronization role: Select either sync master or sync slave. Devices for 

which no role has been defined are "unsynchronized."
Information about the RT classes and synchronization roles is provided in the 
SIMOTION SCOUT Communication Function Manual.

⑤ Send cycle clock Select the send cycle clock for the sync domain here.
⑥ Node The nodes of the PROFINET IO system are listed here.

See also
Configuring media redundancy (Page 157)

Drives and IO devices on the PROFINET IO (Page 129)

6.2.3.3 Set up the sync master and sync slave.

Precondition
You have performed the following configured steps:

● IO controller and IO device configured with RT

● Port interconnections are configured

Note

The sync master and sync salve are automatically configured in the TIA Portal if you have 
configured the drive and axis as well as saved and compiled the project in 
SIMOTION SCOUT TIA. You will find further information and a short description of the 
configuring in SIMOTION SCOUT TIA in Section Isochronous mode (Page 138).
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Configuring the sync master
To configure a sync master, proceed as follows:

1. Select the PROFINET interface of the sync master in the network view.
The interface settings are displayed in the Inspector window.

2. Click "Synchronization" on the "General" tab.

3. Select the "Sync master" entry from "Synchronization role".

Figure 6-14 Configuring the sync master

Configuring the IO device as a sync slave
To configure a device within a PROFINET IO system as a sync slave, proceed as follows:

1. Select the PROFINET interface for the sync slave in the network view.
The interface settings are displayed in the Inspector window.

2. Click "Synchronization" on the "General" tab.

3. Select "IRT" as RT class. For the IRT example, the "sync slave" entry is selected 
automatically as "synchronization role".
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Figure 6-15 IO device as a sync slave

See also
Configure isochronous IO device (Page 137)

6.2.3.4 Configuring the topology, interconnecting ports

Interconnecting ports
With IRT, the topology must be configured and settings made to determine which device is to 
be connected via which port to which other devices.

There are two options for defining the properties of the cables between the ports of the switches:

● Using the topology view

● Using the object properties

Use topology view
With the topology view you have an overview of all ports in the project and can interconnect 
them centrally.
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How to configure in the topology view
1. Click the "Topology view" tab. 

You can perform the following in the topology view:

– Interconnecting ports

– Modify the properties of the interconnection

– Add passive components

– Arrange for an offline/online comparison to be displayed in online mode

2. If you hover the mouse over the ports, port names are displayed in the tooltip. In the 
Inspector window, the properties for each selected port/ device are displayed.

3. Click on the source port and drag the connection onto the target port with a drag-and-drop 
operation. 
The topology view then shows the connection between the two ports.

Figure 6-16 Topology view

Port interconnection via the properties
After selecting a device or interface, you see the entries for the ports in the inspector window 
in the "General" tab.

1. Select the interface, whose ports you want to edit, from the inspector window.

2. Select the interface you wish to interconnect.

3. Select the "Port interconnection" entry.
The dialogs "Local port" and "Partner port" will be displayed.

4. Open the drop-down menu "Partner port".
All devices with their PROFINET interfaces are shown.

5. Below the respective interface, select the port you want to connect to the selected port.
Interfaces that you cannot interconnect are marked in red.
The connection between the ports is displayed in the topology view.

6. If necessary, edit the other parameters of the port. For more information on this topic, refer 
to the Online Help of the TIA Portal.
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6.2.3.5 Configure isochronous IO device

Configuring isochronous mode for IO devices
The drive and controller together form a sync domain. For motion control applications of the 
PROFINET IO system, you must still parameterize the IRT operating mode (for isochronous 
drives) and the PROFINET settings. Isochronous mode for the application on the bus is only 
possible for PROFINET IO with IRT. In the case of PROFINET IO with IRT, a sync master 
generates a synchronization telegram to which all sync slaves synchronize themselves. To 
use isochronous mode, you must configure it for the IO device.  

The PROFINET IO system is isochronous with the servo clock. If you want to use the 
Servo_fast clock, you must select it under "Isochronous mode" on the IO controller.

Note

Isochronous mode only applies if isochronous submodules are configured in the IO device so 
that the IO controller has isochronous IO submodules. Otherwise, the Save and compile in the 
TIA Portal will be terminated with an error message.

To configure isochronous mode in the TIA Portal, you should therefore have already configured 
the drive and an axis in the SIMOTION SCOUT TIA. In this case, the necessary telegrams and 
isochronous submodules will be generated on Save and compile (symbolic assignment in 
SIMOTION SCOUT TIA). This is precondition for configuring the isochronous mode in the TIA 
Portal. After the configuration in the SIMOTION SCOUT TIA, isochronous mode is usually 
preset.

To configure isochronous mode, proceed as follows:
1. Select the IO device in the network view and click the PN interface.

The interface properties are displayed in the Inspector window.

2. Click the "Isochronous mode" on the "General" tab.

3. Activate the "isochronous mode" option.

4. In the "detailed overview", the drive objects with the appropriate telegrams are displayed. 
The objects and telegrams must have been configured previously in SIMOTION SCOUT 
TIA. The telegrams are parameterized automatically during the symbolic assignment.

5. If necessary, activate the "isochronous mode" option besides the drive object with the 
appropriate telegram. Telegram 105 requires isochronous mode that cannot be changed. 
Telegram 105 is created automatically during symbolic assignment in SIMOTION SCOUT 
TIA.
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Figure 6-17 Configure isochronous IO device
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Parameterizing isochronous mode
You will find a more detailed description of the possible settings for isochronous mode in the 
following table.

Parameter Description
Isochronous mode Activate this option if you want to operate the drive (IO device) in isochronous 

mode with the PROFINET IO.
Send clock Shows the send cycle clock of the PROFINET IO system. Click the link to edit 

the setting.
Application cycle Shows the application cycle (multiple of the data cycle). Click the link to edit the 

setting.
Ti/To values Isochronous mode can be individually activated or deactivated for each IO device 

or module in the IO device.
Three settings are possible for the Ti/To values:
● Automatic: Ti/To is automatically calculated.
● Manual: Ti/To can be edited.
● Task: Ti/To values are transferred to the OB.
Ti, To: can only be edited if "manual" is set.
TiMin/TiMax: minimum or maximum time for Ti.
ToMin/ToMax: minimum or maximum time for To.
Interval: defined interval for Ti/To values.

Time Ti (actual value) Specifies at what time Ti, the actual value will be read in before the cycle starts.
Intervals Indicates in which interval the value will be read in. The value should not be 

changed.
Time To (setpoint) Specifies at what time To, the setpoint will be read out after the end of the cycle.
Interval Indicates in which interval the value will be read in. The value should not be 

changed.

See also
Isochronous mode with servo cycle clock (Page 139)

Isochronous mode with Servo_fast cycle clock (Page 141)

6.2.3.6 Isochronous mode with servo cycle clock

Isochronous mode with the servo clock
For isochronous mode, the drive unit (IO device) must be synchronized with the PROFINET 
IO clock. You make these settings on the PN interface of the drive unit. In the previous chapter, 
you have already configured this. You can check isochronous mode in the IO controller.
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Displaying isochronous mode in the TIA Portal
To display isochronous mode for a PROFINET IO system or DP master system, proceed as 
follows: A PROFINET IO system is shown in the example.

1. Select the device (interfaces) in the network view.
The interface settings are displayed in the Inspector window.

2. Select "General > Isochronous mode" in the Inspector window.
The TIA Portal initializes the settings automatically in accordance with their configuration; 
the settings cannot be changed.
The application cycle is calculated and is derived from the settings in the TIA Portal and 
SIMOTION SCOUT TIA.

Figure 6-18 Setting the servo
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The following parameters are displayed:

Parameter Description
Reference system Displays the reference system for the servo cycle in the following form:

"Type of interface [interface name]: Master/IO system (number of master/ IO systems)".
In the example, the reference system (clock generator) is the PN interface X150.

Application cycle Shows the application cycle. The application cycle corresponds to the servo clock and can 
be set in SIMOTION SCOUT TIA.
1. Right-click the controller in the project navigator and perform "Set system cycle clocks."
2. Select an appropriate value in the "Factor" column.

Other isochronous systems Displays the other (DP) master systems that are operated in isochronous mode.
Coupled IO Displays the IO system on the [X1400] with the isochronously operated drive unit as the 

coupled I/O.

See also
Isochronous mode with Servo_fast cycle clock (Page 141)

6.2.3.7 Isochronous mode with Servo_fast cycle clock

Configuring Servo_fast
Servo_fast is configured like the Servo. That means the IO devices must be operated 
isochronously and the application of Servo_fast must be activated explicitly at the IO controller.

Note

Servo_fast is only supported by SIMOTION D435-2 DP/PN, D445-2 DP/PN and D455-2 DP/
PN. The requirements and constraints that apply to the Servo_fast clock can be found in the 
"SIMOTION SCOUT Communication" Function Manual.

For detailed information, read the descriptions of the servo settings:

Configure isochronous IO device (Page 137).

In the following example, a SIMOTION D455-2 DP/PN with two SINAMICS S120 CU310-2 PN 
drive devices is configured. The drives operate isochnronously. The drive device at the 
integrated PN interface (X150) should be operated isochronous with the Servo_fast; the drive 
device on the CBE30-2 (X1400) should be operated isochronous with the servo. 

To configure Servo_fast, proceed as follows:
1. Select the device (interfaces) in the network view.

The interface settings are displayed in the Inspector window.

2. In the Inspector window, select the "Properties > General" tab and click "Isochronous mode".

Configuring communication
6.2 PROFINET IO

SIMOTION SCOUT TIA
Configuration Manual, 01/2015 141



3. Activate the "Use Servo_fast" option.
The settings are "read-only" and are filled according to the configuration. The application 
cycle is calculated and is derived from the settings in the TIA Portal and SIMOTION SCOUT 
TIA. The reference systems in this example for servo and Servo_fast are X1400 of the 
CBE30-2 interface and X150 PN Integrated, respectively.

Figure 6-19 Assign Servo_fast
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4. The application cycle corresponds to the servo clock and can be set in SIMOTION SCOUT 
TIA. Change to SIMOTION SCOUT TIA, right-click the controller and select "Set system 
clocks" in the context menu. In the opened window, select an appropriate value in "Factor" 
column. In the example, 1 ms for Servo_fast and 2 ms for the Servo.

Figure 6-20 Setting system clocks for SIMOTION SCOUT TIA
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5. Switch to the TIA Portal. There you can check the isochronous mode, the send cycle clock 
and the application cycle for the IO devices. In the example, it is the IO device that is 
operated in Servo_fast (send cycle clock 1 ms, X150 P1).

Figure 6-21 IO device configured isochronous to the Servo_fast

6. At the IO device at the PN interface of the CBE30-2, the send cycle clock has been entered 
with 2 ms, which means synchronously to the servo cycle clock.

Figure 6-22 IO device clock-synchronized with servo
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6.2.4 IO controller as IO device (I-Device)

6.2.4.1 Configuring I devices

I-device description
The "I‑device" (intelligent IO device) functionality of a controller enables exchange of data with 
an IO controller. Here the I-device is connected as an IO device to a higher-level IO controller. 
Communication can be established in both directions (bidirectional) via I/O areas using the I-
device functionality. Further, this function allows both controls to operate in separate projects. 
When operating as an I-device, a SIMOTION device can be used for data exchange with a 
SIMATIC station, for example. 

You will find detailed information in the information system of the TIA Portal under the keyword 
"I-device" and in the "SIMOTION SCOUT Communication" Function Manual.

I-device properties
With SIMOTION, the I-device is available for PROFINET IO with RT and IRT. The restrictions 
that exist for operation as IRT or RT are contained in the following table.

Table 6-1 RT and IRT I-device combination options with SIMOTION

SIMOTION function Possible additional functions
 RT I-device RT controller IRT I-device IRT controller
RT I-device - X - X
RT controller X - X* X*
IRT I-device - X - -
IRT controller X X - -

*Either an IRT I-device or an IRT controller

Configuring I-device
In the following example, a SIMOTION D455-2 DP/PN with isochronous SINAMICS S120 
operates as I-device on a SIMATIC S7 CPU 1516-F. If you want to operate a device as an I-
device, you must first activate the "IO device" operating mode.

To create an I-device, proceed as follows:
1. In the network view, select the SIMOTION controller and the interface over which the I-

device is to be operated. In the example, X150.

2. In the Inspector window, select the "Properties > General" tab and click "Operating mode".

3. Activate the "IO device" option.
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4. Assign the controller to which the I-device is to be assigned underneath "Assigned IO 
controller."

Note

If the I-device is to be used in another project, select "not assigned" here. To be able to use 
the I-device, you must expert the GSD and reinstall it. In the hardware catalog, this is 
displayed under "Other field devices" in a subfolder.
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5. Activate the "Parameterization of the PN interface by higher-level IO controller" option if 
the interfaces of the I-device and its ports are to be configured by the controller. This is the 
case if the I-device is to be operated with IRT.
If the I-device is to be operated isochronously with IRT, you must also activate the "Operate 
in isochronous mode" option. This option is only available when the "Parameterization of 
the PN interface by the higher-level IO controller" option has been activated. If isochronous 
operation of the I-device is not possible (e.g. already configured as IRT controller), you 
cannot activate the "Operate in isochronous mode" option.
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Figure 6-23 Setting the I-device

6. Once the "IO device" option has been activated for the controller, you can define the transfer 
area. It is necessary to define a transfer area for the data exchange.
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Parameter Description
⑥ Transfer areas Transfer areas are the peripheral areas over which the I-device 

communicates data with the higher-level IO controller. 
 Add new Add a transfer area. A name is created automatically for the transfer 

area, the addresses are assigned in the IO controller and I-device, 
and the length of the transfer area is set. You can still edit the fol‐
lowing data:

 Type Select the "Type" CD (Controller Device communication relation‐
ship).

 TransferArea_x After you have created a transfer area, "Details of the transfer area" 
are displayed, where you can view the settings and change them, 
if necessary.

Diagnostic address of the 
communication

Here, you see the diagnostic addresses for each module and its 
ports/interfaces.

Export the device description 
file (GSD)

If you use the I-device in another project or if the I-device is used in 
another engineering system, then configure the higher-level IO con‐
troller and the I-device as described here, in principle.
Click the "Export" button after configuration of the transfer areas to 
create a GSD file from the I-device. This GSD file is the represen‐
tative of the I-device configured in the other project.

Exporting and installing an I-device
You can also export an I-device as a GSD file and then install it in the TIA Portal. With this 
functionality, you can insert the I-device in other projects via the hardware catalog.

1. In the "Operating mode" window, select the item "not assigned" under "Assigned IO 
controller."

2. Configure the transfer area.

3. The next step is to export the GSD (generic station description). Click the "Export" button 
in the same window in the field "Export generic station description (GSD)."

4. In the dialog box that opens, enter a name and description and specify the export path.

5. Confirm with "Export." The GSD file will be stored in the specified folder.

6. Select "Options" > "Install GSD File" in the menu.

7. Navigate to the storage location of the exported GSD file and select it in the window that 
opens.

8. Click on "Install." The GSD file will be installed. In the hardware catalog, the I-device is 
displayed under "Other field devices" in a subfolder.

9. With a drag-and-drop operation, you can, for example, insert the I-device into another 
project. 
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6.2.4.2 Real-time settings on IO devices and I devices

Real-time settings for IO devices
The real-time settings are displayed when you set the "IO Device" operating mode. 
Accordingly, these settings are also available for I devices:

1. Mark the SIMOTION CPU and select the "Real-time settings" for the PN interface in the 
"Properties" tab in the Inspector window. Possible options are listed in the table.

Figure 6-24 Real-time settings on the I device / IO device
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You can set the following parameters:

Parameter Description
② Shared device From the drop-down menu, select the number of IO controllers to have access to this 

I device (only possible if you have configured an I device).
Note:
A SIMOTION I device can be operated only on one IO controller. As shared I device 
is not possible. A number > 1 causes an error message during the compilation.

③ Update time Within this time interval an IO device / IO controller in the PROFINET IO system is 
supplied with new data by the IO controller / IO device. The update time can be con‐
figured separately for each IO device and determines the interval at which data is sent 
from the IO controller to the IO device (outputs) as well as from the IO device to the 
IO controller (inputs).

 Automatic Automatically calculates the update time for each IO device of the PROFINET IO 
system, taking into account the volume of data and the transmission cycle set.

 Adjustable Activate the option to enter the update time manually. However, this can lead to errors 
if the bandwidth is not sufficient, or for example, too many nodes are configured.

 Adjust the update time when 
changing the send clock

Automatically adjusts the update time.

④ Response monitoring time If the IO device is not supplied with input or output data (IO data) by the IO controller 
within the response monitoring time, it switches to the safe state.

 Accepted update cycles 
without IO data

Enter here the number of cycles in which the IO device may be without data from the 
IO controller.

 Response monitoring time Displays the current response monitoring time.
⑤ Synchronization Can only be edited if the "Parameterization of the PN interface by the higher-level IO 

controller" option has been activated. 
 Sync domain Displays the name of the assigned sync domain.

Click the domain setting to edit the sync domain.
 RT class Select the current RT class here. The following are available:

● RT; for the cyclic data transmission
● IRT; for isochronous real-time data transmission
Note:
The I-device can operate only in IRT mode when IO devices connected to the I-device 
operate only in RT mode.

 Synchronization role Indicates the synchronization role the IO device has. The following are possible:
● Unsynchronized
● Sync master
● Sync slave

See also
Drives and IO devices on the PROFINET IO (Page 129)
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6.2.5 Direct data exchange via PROFINET IO

6.2.5.1 Direct data exchange

Direct data exchange between two SIMOTION controllers
IO data areas can be exchanged cyclically via IRT between two or more SIMOTION controllers. 
This is also referred to as controller-controller data exchange broadcast. Controller-controller 
data exchange broadcast is possible only between SIMOTION controllers via PROFINET IO 
with IRT. The following preconditions must be met:

● The controllers are connected to the subnet.

● The topology is configured (ports interconnected).

● The PN-IO system is configured.

● The synchronization roles are assigned.

● The devices are in a single sync domain.

Procedure
To configure controller-controller data exchange broadcast, proceed as follows:

Figure 6-25 Drag-and-drop direct data exchange

1. Call the network view and click the "I/O communication" tab in the foreground below 
"Network data".

2. At the transmitter module, select the interface that you want to use for direct data exchange.
Below "I/O communication", the modules that are configured in this subnet are displayed.

3. Drag the receiver module onto the transmitter interface with a drag-and-drop operation.
The module is displayed with the corresponding direction of communication.

4. Repeat the operation to configure the reverse direction of communication.

5. Select the "receiver module" to configure it as a transmitter and drag the "transmitter 
module" onto the interface in the "I/O communication."
The two configured communication paths are now displayed.
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Figure 6-26 I/O communication

Configure transfer areas
It is necessary to define transfer areas for direct data exchange. Once you have selected the 
interface in the "I/O communication", the "Direct data exchange" area is displayed below the 
"General" tab in the Inspector window.
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To configure a transfer area, proceed as follows:

1. On the "General" tab, click on the item "Add new..." in the "Transfer areas" table.
The transfer area is created and displayed with the given data.

2. Repeat the process to create the transfer area for the reverse direction.

Note

The transfer areas must be configured both in the transmit and the receive direction 
(bidirectional data communication).

Figure 6-27 Configure transfer areas

3. In order to parameterize the transfer areas further, click the entries "transfer area 1", ... , 
"transfer area x".
The corresponding parameters are displayed for each transfer area.

The diagnostic addresses for transmitter and receiver are illustrated below "Diagnostic address 
of communication".

If you want to configure direct data exchange for additional controllers, add them to the subnet, 
and perform the configuration similarly.
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Type of transfer areas
In the TIA Portal, different types of communication (PROFIBUS, PROFINET) can be 
configured. Depending on this configuration, different short codes are displayed as the transfer 
area type.

● PROFINET IO
For Direct Data Exchange, "DX" is displayed as the type in the TIA Portal. For synchronous 
and distributed synchronism configurations that are generated automatically by SIMOTION 
SCOUT TIA, "M-DX" is displayed as the type. M-DX means motion control with Direct Data 
Exchange.

See also
Set up the sync master and sync slave. (Page 133)

6.2.6 Configuring the redundancy second sync master

Configuring the redundancy second sync master
For certain plants, e.g. printing machines in "tandem configuration", it is necessary for the two 
plant sections to be operated in stand-alone mode or together synchronously. If the entire plant 
had one sync master, the other plant section would not be capable of functioning 
independently. The "redundant sync master" function was developed for this very reason. 
Under this arrangement, a sync master is defined for every component. One of these is defined 
as the sync master, and the other as the "Redundant sync master." Provided the system 
components are combined during operation, the redundant sync master will synchronize itself 
with the sync master. The machine sections can also be operated separately from each other.

Example of a redundant sync master
In the following example, simple topology is configured with a redundant sync master. The 
project contains two SIMOTION D455-2 DP/PNs and one SINAMICS S120 CU320-2 PN. One 
SIMOTION D455-2 DP/PN is configured as the sync master (PLC_2) and the other as the 
redundant sync master (PLC_1). On the redundant sync master, the SINAMICS S120 is 
connected in isochronous mode via PROFINET.

For configuration of the sync master and sync slave, refer to Section Communication 
configuration SIMOTION controller with SIMOTION drive (Page 119).

To configure a redundant sync master, proceed as follows:
1. Select the PROFINET interface in the network view.

The interface settings are displayed in the inspector window.

2. Click "Synchronization" under "Realtime settings."
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3. Select the "Redundant sync master" entry.

Figure 6-28 Redundant sync master
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4. Switch to the topology view.

5. Interconnect the ports of the two SIMOTION controllers.

Note

In the topology view, the redundant sync master should be between the sync master and 
the sync slaves.

Figure 6-29 Topology view with redundant sync master

6.2.7 Media redundancy

6.2.7.1 Configuring media redundancy

Configuring MRP (PROFINET RT)
It is possible to establish redundant networks via the so-called Media Redundancy Protocol 
(MRP). Redundant transmission links (ring topology) ensure that an alternative communication 
path is made available when a transmission link fails. The PROFINET devices that are part of 
this redundant network form an MRP domain. The Redundancy Manager coordinates the 
communication. All other members in the MRP ring are so-called redundancy clients, e.g. 
SINAMICS S120 drives.

Only devices with MRP-capable ports may be inserted in an MRP ring. In SIMOTION 
controllers, the ring ports are marked R. In MRP, no IRT communication can be configured, 
i.e. no PROFINET interface is set to "sync master" or "sync slave."

Note

In the current version TIA Portal V13, SIMOTION controllers only support MRP and can only 
be configured as redundancy clients. The redundancy manager can, for example, be a 
SCALANCE switch.
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You will find detailed information in the information system of the TIA Portal under the keyword 
"Media redundancy" and in the "SIMOTION SCOUT Communication" Function Manual.

Preconditions
1. Generate a ring via the port interconnections in the topology view. If no rules are violated, 

a MRP domain is automatically created.

2. Check the media redundancy roles, e.g. who assumes the role of the "Redundancy 
Manager."

3. Select the device and click "Properties" in the Inspector window and then the "General" 
tab. You edit the parameters below the "Media redundancy" entry.

Port interconnection ring topology for MRP
In the topology view, you must configure the port interconnection of the manager with the 
clients to create a ring. In the example, a SCALANCE X-200 IRT as the redundancy manager, 
a SIMOTION D435-2 DP/PN, and a SINAMICS S120 CU310-2 PN as clients are configured. 

1. Open the topology view.

2. Interconnect the individual ports of the devices.

3. Connect the two end points of the line topology with each other to close the ring, e.g. the 
redundancy manager with a redundancy client.

Figure 6-30 Port interconnection of a ring topology

MRP parameters
You can set the following parameters for media redundancy:
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Parameter Description
MRP domain Shows the MRP domain that is assigned to the device. The assignment is made under 

Domain Management, see below.
Media redundancy role Please select here the role the device is to perform in the ring:

● Manager (Auto) if the device is to assume the manager role. The device must be able to 
fulfill this role.

● Client if the device is part of the MRP ring.
● Not node in the ring if the unit is not to participate in the MRP.

Ring port 1 Displays the interconnection of ring port 1.
Ring port 2 Displays the interconnection of ring port 2.
Diagnostic alarms (in the man‐
ager only)

Activate the option if you want to display diagnostic alarms.

Alternative redundancy (in the 
manager only)

Select this option if the properties of the media redundancy are parameterized by alternative 
mechanisms or tools.

Domain settings Click this button if you want to edit the domain settings. Then, switch to the "Properties > 
General" tab of the PROFINET system. There, you can edit the settings for sync domains 
and MRP domains, see also Configure sync domains and send clock (Page 131).

In the following example, you see the media redundancy settings of a SIMOTION D435-2 DP/
PN, which is configured as a client in the ring. The SCALANCE X-200 IRT is configured as a 
manager and the SINAMICS S120 CU310-2 PN as a further client. 
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Figure 6-31 Media redundancy settings of a SIMOTION D435-2 DP/PN as the redundancy client

6.2.7.2 Configuring the MRP domain

MRP domain
All devices that want to participate in the MRP must be part of an MRP domain. The ring 
topology can be accessed via the corresponding port interconnection.

Configuring the MRP domains
To configure the nodes of an MRP domain, proceed as follows:

1. To do this, select the PROFINET IO system in the network view.

2. In the Inspector window, select the "General" tab and click the item "MRP domain."
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The following parameters can be edited:

Figure 6-32 Configure MRP domain

Parameter Description
MRP domains  
 Media redundancy domain Displays the MRP domain that is assigned to the device.
 Converted name Displays the converted name of the MRP domain.
 Interfaces within the ring Displays the number of PROFINET interfaces that are located within the ring.
 Interfaces outside of the ring Displays the number of PROFINET interfaces that are located outside of the ring.
 Number of managers Displays the number of Redundancy Managers.
 Number of clients Displays the number of Redundancy Clients.
 Default domain Indicates whether the displayed MRP domain is the default domain.
PROFINET IO System  
 IO system Displays the IO systems that are part of the MRP domain.
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Parameter Description
Devices  
 IO device name Lists the device names of the PROFINET IO system nodes.
 MRP domain Drop-down menu to select the MRP domain
 MRP role Drop-down menu to select the role of the device in the MRP domain:

● Not node in the ring
● Client; is a redundancy client within the ring
● Master; is a redundancy master within the ring

 Ring port 1 Drop-down menu to select the port through which the device is connected to the 
ring.

 Ring port 2 Drop-down menu to select the second port through which the device is connected 
to the ring.

6.3 Using PROFIsafe - Configuring F-Proxy

6.3.1 F proxy with SIMOTION

F proxy description
SIMOTION features integrated F-Proxy functionality for the purpose of PROFIsafe connection 
of drives that are controlled by SIMOTION but are in a different communication domain than 
the F-CPU, for example. The F-Proxy functionality enables transparent routing of safety 
telegrams from the SIMOTION I-device interface to the respective SIMOTION controller 
interface on which the drive is configured. Despite the SIMOTION routing function, PROFIsafe 
communication between the F-CPU and drive is secure, as the PROFIsafe drivers at the end 
points (F-CPU, drive) securely monitor communication. 

In order to use F proxy functionality, the two paths of communication - from the F-CPU to 
SIMOTION and from SIMOTION to the drive - need to be configured separately. 

The following drive connections can be used on the SIMOTION control for the F-Proxy:
● Drive on SINAMICS_Integrated (SIMOTION D)

● Drive on PROFIBUS DP

● Drive on PROFINET IO Onboard PN interface

● Drive on PROFINET IO CBE30-2 PN interface

Properties of the I-device F proxy
● The F-Proxy submodules on the SIMOTION controller are RT and can be operated non-

isochronously. 

● The PROFIsafe telegrams 30, 31, 901, and 902 are supported
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Detailed information on the F proxy can also be found in the "SIMOTION SCOUT 
Communication" Function Manual.

Note
Connection between SIMOTION and F-CPU only via PROFINET IO

With TIA Portal V13, you can interconnect F-Proxy slots between the SIMOTION controls and 
the F-CPU only via PROFINET IO. A so-called PROFIBUS I slave F-Proxy is not supported.

Basic procedure for an F-Proxy configuration
The F proxy configuration is performed in the TIA Portal and the SIMOTION SCOUT TIA:

● Creating the device (F-CPU, SIMOTION controller, drives) in the TIA Portal

● Networking the devices and creating the topology in the TIA Portal

● Creating and configuring the drives, axes, and configuration of PROFIsafe in the drive in 
SIMOTION SCOUT TIA

● Changing the operating mode of the PN interface of the SIMOTION controller to IO device 
(I-device) in the TIA Portal

● Interconnecting the F-CPU with the drive units via the PN interface that functions as I-device 
in the TIA Portal

A configuration example (Page 164) is described in detail in the next chapter.

F-Proxy settings on the SIMOTION controller
If you want to run a SIMOTION controller as F proxy, you must perform the following steps:

1. Change the operating mode for the SIMOTION device to IO device and select whether the 
F-CPU is in the same or in another project.

2. In the Inspector window below "General", select the "F-Proxy" entry.

3. Configure the interconnections of the F-Proxy.

See also
Direct data exchange via PROFIBUS DP (Page 182)

Direct data exchange (Page 152)
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6.3.2 Configuration example for I device F-Proxy

Introduction
This chapter describes a configuration example for an I-device F proxy. The configuration is 
largely identical for all drives at the SIMOTION control. The difference is essentially whether 
the F-CPU is in the same or in another project. As an example, the configuration is shown in 
the same project.

Controllers and drives used
● SIMOTION D455-2 DP/PN (Motion Control) [PLC_1]

● SINAMICS S120 CU320-2 PN

● SIMATIC S7-300 CPU317F-2 PN/DP (F-CPU) [PLC_2]

Precondition
● Project created in the TIA Portal

● Controller and drives inserted

● PROFINET IO system configured with SIMOTION D455-2 DP/PN and SINAMICS S120 
CU320-2 PN

● Ports are interconnected

● Drive and the axis are configured in SIMOTION SCOUT TIA

Also note the chapter Brief introduction to SIMOTION control and SINAMICS drive via 
PROFINET IO (Page 119).

Configuring PROFIsafe in SIMOTION SCOUT TIA
1. In the project tree in SIMOTION SCOUT TIA below the drive, click "Functions > Safety 

Integrated."
The window for safety configuration is opened in the working area.

2. Select a PROFIsafe function such as "Extended functions via PROFIsafe".
You can view the "PROFIsafe address" in the window "Configuration PROFIsafe". 0001H 
is used in this example. 

Note

The PROFIsafe address for the safety configuration is the F-destination address for the 
later configuration of the F-Proxy. These must be identical. You enter the F destination 
address in the interconnection table when interconnecting the F proxy.

The F destination address must be configured at three places and must be identical:
● in the drive (PROFIsafe-address)
● at the F-Proxy interconnection
● at the exported I-device if the F-CPU is in another project
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3. After configuration, you have to select the PROFIsafe telegram. In the SIMOTION SCOUT 
TIA project navigator, under the drive unit double-click on "<Drive unit_xx"> - 
Communication > Telegram configuration".
The telegram configuration is opened in the working area.

4. Mark the appropriate drive in the tab "IF1: PROFIdrive PZD telegram" of the telegram 
overview, and in the bottom part of the window under "Adapt telegram configuration", select 
the entry "Add PROFIsafe".
The PROFIsafe telegram is inserted. Dependent on the drive, you can select from several 
telegrams. The PROFIsafe standard telegram 30 is inserted by standard. You can change 
this.

Figure 6-33 Adding the PROFIsafe telegram on the drive

5. Save and compile the project.

6. Click on "Set up address" to run an address alignment between SIMOTION SCOUT TIA 
and TIA Portal. A successful alignment is indicated with a blue checkmarks. For the drive, 
telegrams are indicated with red checkmarks, since during the alignment the process data 
were extended due to the automatic telegram extension. This is for information purposes 
only. Configuration in SIMOTION SCOUT TIA is completed by saving.

Figure 6-34 Telegram configuration for drive with PROFIsafe

7. Switch to the TIA Portal and create the I-device.
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Creating an I-device in the TIA Portal
1. In the network view, select the SIMOTION controller and the interface over which the I-

device is to be operated. X150 in the example. 

2. In the Inspector window, select "Properties > General" and click "Operating mode". 

3. Activate the "IO device" option.
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4. Assign the controller to which the I-device is to be assigned underneath "Assigned IO 
controller." In this case, the F-CPU. A subnet is automatically inserted between the F-CPU 
and the SIMOTION control.

Note

From that point on the configuration is different if F-CPU is in another project. "Not assigned" 
is selected as IO controller, then the F proxy is configured, and a GSD file of the I-device 
is created.

5. Define the transfer area.
You will configure the F proxy in the next step.

Note
Transfer areas

In the transfer area, the automatically created fail-safe I/O transfer areas are not displayed.
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Figure 6-35 Creating an I-device for I-device F proxy

Configuring F proxy in the TIA Portal
1. Click "F-Proxy" on the "General" tab. F-Proxy interconnection is opened.

2. In the column "F-CPU", select the IO controller for PROFIsafe monitoring. All controllers in 
the project are displayed. Choose "PLC_2.PROFINET_Interface_1" in the example.

Configuring communication
6.3 Using PROFIsafe - Configuring F-Proxy

SIMOTION SCOUT TIA
168 Configuration Manual, 01/2015



3. If the F-CPU is already interconnected with the SIMOTION control, the PN interface used 
is automatically entered into the column "F-Proxy interface". If there is no interconnection 
yet, you can select the PN interface of the SIMOTION control here.

4. An address is specified in the "F-destination address" column. This address must be 
identical with the PROFIsafe address of the drive in SIMOTION SCOUT TIA. Check if these 
addresses are identical and change them. Address 0001H is used in this example. Click 
the field to change the address. This will finish the configuration.
More information about the interconnection table can be found in Chapter Edit F-Proxy 
settings (Page 170).

Note

The F-destination address must be assigned for every drive. If you have configured further 
drives at the SIMOTION control, they are shown in the table and are configured identically. 
You must also enter the specific F-destination addresses of the safety configuration here 
for every drive.

Figure 6-36 Configuring interconnections for F-Proxy

F-CPU in another project
If the F-CPU exists in another project, you must pay attention to some points.

1. When configuring the I-device, select the entry "Not assigned" under "Assigned IO 
controller" and then configure the I-device as described above.

2. Configure the interconnection of the F-Proxy. For the F-CPU, select "F-CPU in another 
project" and then configure the further parameters of the F-Proxy as described above.
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3. Change back to the "Operating mode" window. Now export the I-device as device 
description file (GSD). The procedure is described in Chapter Configuring an I-device 
(Page 145).

Note
Configuring an F proxy prior to the I-device export

Before you create the I-device, you must have finished the F proxy interconnections. If 
changes are made to the F proxy interconnection (e.g. other F destination addresses), you 
must export the I-device again.

4. You may insert the installed I-device with a drag-and-drop operation into the other project 
with the F-CPU and connect it with the subnet of the F-CPU.

Figure 6-37 Connecting an F-CPU in another project with I-device F proxy at the subnet

6.3.3 Editing F-Proxy settings

Working with the F-proxy interconnection table
With an interconnection table, you interconnect all drives (also termed drive objects or DOs) 
with a F-CPU. The drives must be connected to the SIMOTION controller and a PROFIsafe 
telegram must be set up.  

The table is hierarchically organized. If you change a setting (F-CPU, F-Proxy interface) on a 
higher-level entry, the new setting will be propagated to all lower-level objects.

● To edit the settings underneath a SIMOTION controller, edit the settings at the controller 
level to interconnect all the interfaces and drive objects beneath it.

● If you only want to interconnect the drive objects of one particular bus system, edit the 
relevant entry of the interface to interconnect all the drive objects beneath it.

● If you only want to configure a particular drive object, change the settings on this drive 
object only.

In the first example figure, for example, the F-CPU with the name PLC_2 is used for all drive 
objects.

In the following figures, you can see an example of an F-proxy interconnection with an F-CPU 
in the same project and an F-CPU in another project. You will find the explanations of the 
numerals in the table. In the interconnection table, you can edit only the field with a light-blue 
background.
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Figure 6-38 F-proxy interconnection table with two drive objects and F-CPU in the same project

Figure 6-39 F-proxy interconnection table with two drive objects and F-CPU in another project

Explanations of the interconnection table

Parameter Description
Displayed drive objects ① Under "Displayed drive objects," you can filter the display of the drive objects. You can have 

only the interconnected or only the non-interconnected objects displayed.
Starting address in the F-
CPU ②

Enter a starting address as the basis for address assignment in the F-CPU here. If no drive 
object has yet been interconnected with the F-CPU, this button is not active.

Drive object ③
(not editable)

The drive objects are displayed sorted hierarchically underneath the controller and interface.

F-CPU ④ Select the F-CPU with which interconnection of the SIMOTION controller is to be performed 
via the F-proxy.
● All F-CPUs connected to the SIMOTION control are listed (F-CPU in the same project)

In the example, the SIMOTION control (PLC_1) is interconnected with the F-CPU (PLC_2).
● F-CPU in another project
● None

With this selection, existing interconnections will be deleted.
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Parameter Description
F-proxy interface ⑤ Here, you can select the PN interface of the SIMOTION controller via which interconnection 

with the F-CPU is performed. All PN interfaces that are in I-device mode are displayed (X150, 
X1400). In the example, it is the X150 interface.
If the F-CPU is in the same project and is already interconnected with the SIMOTION con‐
troller, the interface will be entered automatically.

F-CPU addresses ⑥ Address of the drive objects in the IO controller of the F-CPU. On the first drive object, the 
starting address is used, that was entered under "Start addresses on the F-CPU."

F-destination address ⑦ Enter the F-destination address here. This is preset to a default value. The F-destination 
address is identical to the PROFIsafe address in the drive.

Input address ⑧ Enter the input address of the I-device here (SIMOTION controller).
Output address ⑨ Enter the output address of the I-device here (SIMOTION controller).
Drive input address ⑩
(not editable)

The logical address of the PROFIsafe telegram of the drive object is displayed here. You can 
change this address in SIMOTION SCOUT TIA.

Configuring a table
When you right-click the table header, a shortcut menu opens.

1. Select "Display/hide" if you wish to configure the displayed columns. Please note that some 
of the columns including, for example, F-CPU address are required for programming the F-
CPU application.

2. "Show all columns" if you require the entire table.

F-CPU in another project
If the F module is located in another project, for example, after migrating a project, select the 
entry "F-CPU in another project" for the F-CPU.

For this setting, at least one PN interface of the SIMOTION controller must be configured as 
an I-device and no F-CPU must be present in the project. When you have made all the 
parameter settings, you must export the I-device with a GSD export and then install it and 
reinsert and interconnect it in the F-CPU.

Filtering the display
With the "Displayed drive objects" filter, you can filter displayed drive objects, for example, for 
the following application scenarios:

● You want to interconnect additional drive objects subsequently.

● You have a project with a large number of drive objects.

● For checking whether all drive objects have been interconnected.

The entries that do not correspond to the filter criterion are hidden.
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Starting address of the F-CPU
The start address is used to define an address range in the F-CPU. All components are then 
clearly listed within the address band.

1. Enter a starting address as the basis for address assignment in the F-CPU here.
If no drive object has yet been interconnected with the F-CPU, this button is not active.

2. First enter the starting address.

3. The make the interconnection.
When you then interconnect the object, the addresses will be assigned from the starting 
value in ascending order.

If you want to change the address range after having made an interconnection, enter a new 
starting address and click "Assign address." 
The addresses are automatically pushed into the address range.

Deleting components
If you delete an F-CPU, for example, all interconnections and transfer areas will be deleted.

6.4 Configuring onboard IO X142

6.4.1 SIMOTION D4x5-2 I/Os (terminal X142)
The I/Os of terminal X142 are permanently assigned to the SIMOTION D4x5-2. The 
configuration is performed in the device view of the TIA Portal. The digital I/Os on the X142 
connector are provided for the connection of sensors and actuators. 

The following types of digital inputs/outputs are used:
● Digital inputs (DI)

● Bidirectional digital I/Os (DI/DO, IN/OUT)

Bidirectional digital inputs/outputs can be configured individually as digital inputs or outputs. 
Assignment of the I/Os to functions can be parameterized as required. Special functions (e.g. 
input of measuring input and output for output cam) can also be assigned to the I/Os.

Note

If you want to interconnect a measuring input or an output cam to the terminals X142 in the 
SIMOTION SCOUT TIA, you can select all of the I/Os (measuring inputs/output cams) 
configured here.
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You can set the following parameters:

Table 6-2 Channels 0-7

Field/button Meaning/instruction
IN/OUT X142 Inputs/outputs (IN/OUT 0-7) of the X142
Inverter Button for the inversion
Function  
 DI Digital input
 DO Digital output
 Output cam Output for output cam
 Measuring input Input for measuring input
IN filter time  
 Filter time The selection list has the values 1 µs and 125 µs 

and is available only for the function "DI" and 
"measuring input."

Logical addr. PI, PQ for output cams and measuring inputs
The displayed logical address of a channel is only 
required when symbolic assignments are not used.

Table 6-3 Digital inputs and outputs

Field/button Meaning/instruction
Input addresses
Start address Enter the start address of the digital inputs here.
End address The end address is determined by the length.
Output addresses
Start address Enter the start address of the digital outputs here.
End address The end address is determined by the length.

Configuration of the D4x5‑2 I/Os (terminal X142)
The following figure shows an example interconnection to DI, DO, measuring input, and output 
cam.
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Figure 6-40 Configuration of the D4x5‑2 I/Os (terminal X142)

In the SIMOTION SCOUT TIA, you can interconnect the technology object to the configured 
I/Os of the X142 in the configuration of the technology objects measuring inputs or output 
cams. In the example, the input X142.6 with the measuring input.
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Figure 6-41 Configuring a measuring input at the input X142

6.5 PROFIBUS DP

6.5.1 Settings on the PROFIBUS

Parameterize PROFIBUS DP
PROFIBUS DP is used for communication between the SIMOTION controller and other 
devices such as drives or other SIMOTION or SIMATIC controllers. Via DRIVE-CLiQ, you can 
connect additional modules (CX32-2) to the PROFIBUS Integrated.

For the settings that are possible for the different devices, refer to the documentation of the 
devices that you use.

Creating a PROFIBUS subnet or master system
To create a new PROFIBUS subnet or a DP master system, proceed as follows:

1. Right-click the interface at which you want to create a system.

2. Select "Create subnet" if you want to create a PROFIBUS subnet at this interface.
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3. Select "Assign subnet" if you want to assign an existing subnet to the interface.

4. Select "Create master system" if your device is to act as a DP master.

PROFIBUS address
In general, the PROFIBUS address of the interface is assigned automatically.

Reserve PROFIBUS address "0" for a service PG and "1" for a service HMI device which are 
connected to the subnet as required.

For service purposes, it is recommended reserving the address "2" for a SIMOTION module. 
This prevents occurrence of duplicate addresses when a SIMOTION D4x5-2 is installed in the 
subnet using default settings (for example, when replacing a SIMOTION D4x5-2). You should 
therefore assign addresses greater than "2" to additional units on the subnet.

The PROFIBUS address set in the TIA Portal must match the address that is set on the device.

You edit The PROFIBUS address either in the device view or in the network view:

● In the device view or network view by selecting the device and then clicking the "PROFIBUS 
address" entry below the "Inspector window > General > <Interface>". There, set the 
PROFIBUS address in the "Address" drop-down menu.

● In the device view or network view by directly selecting the interface and then clicking the 
"PROFIBUS address" entry below the "Inspector window > General". There, set the 
PROFIBUS address in the "Address" drop-down menu.

Operating mode
To create a DP master system, you need a DP master and at least one DP slave. Once you 
connect a DP master with a DP slave, a master-slave coupling occurs.

You can change the operating mode subsequently:

1. To do this, select the device in the network view.

2. Change to the Inspector window and call the respective interface from the "Operating 
mode".

3. Activate the option you want to use for your device.

PROFIBUS Integrated
The PROFIBUS Integrated is operated only equidistantly. You can view the settings by clicking 
the bus in the network view and the "General" tab in the Inspector window under "Properties".

In order to parameterize the isochronous cycle for the PROFIBUS Integrated, proceed as 
follows:

1. Select the PROFIBUS Integrated in the network view.

2. Select the "General" tab in the Inspector window and click "Equidistance" to display the 
parameters for the equidistant PROFIBUS.
The "Activate equidistant bus cycle" setting is permanently selected and cannot be edited.

The other parameters are set to default settings and can be edited.
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See also
Drives on PROFIBUS DP (Page 180)

6.5.2 Setting the equidistant PROFIBUS

Configuring the equidistance
The PROFIBUS properties of "isochronicity" and "equidistance" form the basis for 
synchronized editing cycles.

Equidistance ensures exactly the same interval for bus cycles. The "Constant bus cycle time" 
function ensures that the DP master always starts the PROFIBUS DP bus cycle within a 
constant time interval. Therefore, the connected slaves also obtain their data from the master 
in exactly constant time intervals. This is also called "clock of the bus cycle."

Equidistance is the requirement for isochronous operation. For instructions on setting 
isochronicity, refer to Drives on PROFIBUS DP (Page 180).

Equidistant PROFIBUS
In order to perform the settings for the PROFIBUS, select the bus in the network view.

1. In the Inspector window, select the "Properties > General" tab and click "Equidistance".

2. Parameterize the bus settings there.
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Figure 6-42 Configuring the equidistant PROFIBUS

Parameter Description
Activate the equidistant bus cycle Activate this option if you want to operate the bus isochronously.
DP cycle  
 DP cycle time automatically 

minimal
Activate this option if you want to assign the values automatically with the mini‐
mum value.

Equidistant DP cycle The equidistant DP cycle in which the master exchanges data with all slaves is 
set here.

Ti/To values of the PROFIBUS  
 Ti/To values automatic Activate this option if you want to assign the values automatically.
 Time Ti (read in process values) Specifies at what time Ti before the start of the "DP cycle", the actual position 

value (process value) is recorded. 
 Time To (output process val‐

ues)
Specifies at what time To after the start of the "DP cycle" the controller transfers 
the setpoint (e.g. speed setpoint).
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Detailed overview
For an overview of the current settings and nodes on the equidistant PROFIBUS DP, select 
the "Properties > General" tab in the Inspector window and click "Equidistance". The "Details 
view" is located in the lower area of the "Equidistance" tab.

6.5.3 Drives on PROFIBUS DP

Settings on PROFIBUS DP
Drives are normally operated on the PROFIBUS DP as slave on a higher-level controller. There 
is also the possibility of operating the bus equidistantly and isochronously.

For an isochronous mode, you have to click the "Activate equidistant bus cycle" option on the 
bus, see also Settings on the PROFIBUS (Page 176).

More settings on the drive (DP slave) are necessary for an isochronous PROFIBUS.

For detailed information, refer to the information system of the TIA Portal under "Isochronous" 
and "Equidistant" operation.

Drive units that are not networked or are assigned to a DP master are not displayed in 
SIMOTION SCOUT TIA.

Set the isochronization on the drive
1. Click the interface of the drive in the network view.

2. In the "General" inspector window, select "Isochronization."

3. Activate the "Synchronize DP slave to constant DP cycle" option.
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Figure 6-43 Isochronous drives on PROFIBUS DP
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 The following settings can be made:

Parameter Description
Synchronize the DP slave to equidistant 
DP cycle

Activate this option if you want to synchronize the drive (DP slave) to the equi‐
distant DP cycle.

Ti/To values From the drop-down menu, select whether you want to enter the Ti/To values 
manually or obtain them from the subnet. The values for Ti/To are then set the 
same for all DP slaves.

Time Ti (read in process values) Specifies at what time Ti before the start of the "DP cycle", the process value 
(actual position value) is recorded. If several drives operate as group, the same 
value for all axes should be entered here.

Grid Indicates in which field the value is read.
Time To (output process values) Specifies at what time To after the start of the "DP cycle" the controller transfers 

the process value (e.g. speed setpoint). If several drives operate as group, the 
same value for all axes should be entered here.

Grid Indicates in which field the value is read.
Equidistant DP cycle Displays the calculated cycle time in the equidistant PROFIBUS.
x Factor which is multiplied by the cycle time.
Cycle of the master application Enter the master application cycle here. The cycle describes the reduction ratio 

between the DP cycle and the cycle of a higher-level controller, e.g. the servo 
cycle of a SIMOTION controller.

6.5.4 Direct data exchange via PROFIBUS DP

Configuring direct data exchange between two controllers
Master-slave communication is possible between two SIMOTION controllers via PROFIBUS 
DP using direct data exchange. 

You can find more information in the information system of the TIA Portal under "Direct data 
exchange." 

One module is the DP master, the other module is the I slave. This makes, for example, 
distributed synchronous operation on two modules possible.

Procedure
To configure communication for this topology, proceed as follows:

1. Insert two SIMOTION modules in the TIA Portal.

2. Create a DP master system. Preferably, you should create the system on the module that 
is to be the DP master and drag the PROFIBUS DP onto the second module.

3. In the network view, select a module which is to be the master.

4. In the inspector window on the "General" tab under the interface used under operating 
mode, select the option "DP Master."

5. In the network view, select a module which is to be the I slave.
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6. In the Inspector window on the "General" tab under the interface used, select the item 
"Operating mode".

7. Select the "DP Slave" option.
The direct data exchange is automatically created and displayed under I/O communication.

8. In the "Assigned DP master" dropdown list, select the controller with the interface being 
used.
Additional parameters are listed under "I-Slave communication":

Figure 6-44 Transfer area

9. Under "Transfer areas" click "Add new". A new transfer area is created.

10.Select type "MS" (Master - Slave).
The addresses are entered automatically.

11.In the "Transfer direction" column, click the arrow to reverse the communication direction. 
This activates data transfer from the "sender" (master) to the "receiver" (I-Slave) and vice 
versa.

Type of transfer areas
In the TIA Portal, different types of communication (PROFIBUS, PROFINET) can be 
configured. Depending on this configuration, different short codes are displayed as the transfer 
area type.

● PROFIBUS DP
In master I-slave communication, "MS" is displayed as the type. For synchronous and 
distributed synchronism configurations that are generated automatically by SIMOTION 
SCOUT TIA, "M-MS" is displayed as the type. M-MS means motion control with master I-
slave communication.

See also
F proxy with SIMOTION (Page 162)
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6.5.5 PROFIsafe via PROFIBUS with failsafe direct data exchange

Introduction
This chapter describes a configuration example for failsafe direct data exchange. During 
failsafe direct data exchange, the SIMOTION CPU is the DP master The SIMATIC F-CPU is 
the I slave on PROFIBUS DP and controls failsafe communication, e.g. with a CU320 of the 
SINAMICS S120.

Controllers and drives used
● SIMOTON D410-2 DP (motion control)

● SINAMICS S120 CU320-2 DP

● SIMATIC S7-300 CPU317F-2 PN/DP (F-CPU)

Requirements
● Project created in the TIA Portal

● Controllers and drives inserted in TIA Portal

● PROFIBUS DP system with SIMOTION D410-2 DP, SINAMICS S120 CU320-2 DP, and 
SIMATIC S7-300 CPU317F-2 PN/DP configured in the TIA Portal

Configuring failsafe direct data exchange
1. In network view, create an F-CPU,  a SIMOTION D410 control, and a SINAMICS S120 in 

accordance with the hardware installed. The devices are located in the same PROFIBUS 
DP subnet.

Figure 6-45 Configuration example of failsafe direct data exchange on the PROFIBUS DP

2. You configure the SIMOTION CPU as a DP master and the SINAMICS S120 as a DP slave, 
which is isochronously synchronized to the constant DP cycle time.
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3. You configure the SIMATIC F-CPU as an I slave and enter at least one transfer area per 
transfer direction.

Figure 6-46 I slave communication transfer areas 

4. Configure the SINAMICS drive unit (safety configuration) in SIMOTION SCOUT TIA in 
accordance with your hardware configuration.

5. Then insert a new TO axis in SIMOTION SCOUT TIA and work through the axis wizard. In 
the wizard, interconnect the axis to the corresponding drive object of the S120 and a 
corresponding telegram will automatically be created (symbolic assignment).

6. Save and compile the project in SIMOTION SCOUT TIA.

7. Create a PROFIsafe slot in SIMOTION SCOUT TIA in the configuration of the SINAMICS 
drive unit.
 For this, on tab "IF1: PROFIdrive PZD telegrams," select the drive object that will 
communicate with the SIMATIC F-CPU via PROFIsafe. Click the "Adapt telegram 
configuration" button and select "Add PROFIsafe." In the example, a PROFIsafe telegram 
901 is configured.

Figure 6-47 Adding a PROFIsafe telegram

8. Transfer the new PROFIsafe slot by clicking the "Set up address" button.

9. Switch to the TIA Portal and in the network view click SIMATIC F-CPU.

10.Under the network data, go to the "I/O communication" tab. You can show the network data 
on the right-hand side of the network view.
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11.On the transmitter module (SIMATIC F-CPU), select the interface that you want to use for 
direct data exchange. Below "I/O communication," the modules that are configured in this 
subnet are displayed. Click the SINAMICS drive unit.  It is inserted for direct data exchange.

Figure 6-48 Setting up direct data exchange in the TIA Portal

12.On the "I/O communication" tab, click the inserted drive unit. In the "Inspector window," go 
to the "Properties" tab and then "General" to add a transfer area for failsafe direct data 
exchange. 

13.Click "<Add new>" and then insert a transfer area of type "F-DX-Mode" and adapt the 
addresses accordingly.

Figure 6-49 Adding a transfer area F-DX-Mod in the TIA Portal

14.Save and compile the project in the TIA Portal. Failsafe direct data exchange is configured.
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Configuring an HMI connection 7
7.1 Supported HMI panels

An overview of the HMI panels supported with SIMOTION SCOUT TIA can be found in the 
Internet under: Compatibility list (http://support.automation.siemens.com/WW/view/en/
18857317).

7.2 Adding an HMI

Note

You can only add an HMI device in the TIA Portal.

An HMI device can communicate with a SIMOTION device via the PROFINET, Ethernet and 
PROFIBUS bus systems. The SIMOTION device and the HMI operator panel can exchange 
information about tags for technology objects, system tags and global user tags.

SIMOTION and SIMATIC CPUs can communicate in parallel with an HMI via the same 
connection.

Procedure
To add an HMI, proceed as follows:

1. In the network view, browse to the "Hardware Catalog" task card and open the "HMI" 
component.

2. Open the folder of the panel type. In the example: "SIMATIC Comfort Panel".
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3. In the folder for the display size, select the installed panel.  In the example: "15" Display > 
TP1500 Comfort."

4. Drag the HMI panel into the network view of your project.

Figure 7-1 HMI in the network view

Result
The inserted HMI is visible in the project tree.

Figure 7-2 HMI in the project tree
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7.3 How to synchronize SIMOTION variables and messages
So that they can be displayed on an HMI, the tags and messages of SIMOTION SCOUT TIA 
must be transferred to the TIA Portal.

Procedure
To determine when the tags and messages will be transferred, proceed as follows:

1. Switch to SIMOTION SCOUT TIA.

2. Select "Options > Settings" in the menu.

3. Switch to the "WinCC" tab and select when the data is to be synchronized, e.g. 
"Automatically with Save and compile."

4. Save and compile your project.

Note

In synchronization, alarms, technological objects, and programs are matched to the TIA Portal 
and are displayed there.

If you select "Do not synchronize," only variables and messages are not synchronized with the 
TIA Portal.

Result
The tags have been transferred to the TIA Portal and can be called there in the project 
navigation under the SIMOTION device with the item "SIMOTION tags > Show all tags."

Note
SIMOTION tags

The following SIMOTION tags are visible after synchronization in the TIA Portal:
● System tags (of the technology objects and of the SIMOTION device)
● Configuration data (of technology objects)
● Global device tags
● Global unit variables
● I/O tags

User-defined data types are also available in the TIA Portal.

Configuring an HMI connection
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After synchronization, the messages are available in the TIA Portal in the project navigation 
under the device under "HMI messages" and are known only to the device.

Note
SIMOTION messages

The following messages are also available in the TIA Portal after transfer and/or 
synchronization:
● Alarm_S messages (TIA Portal text lists are supported)
● TO alarms (separate alarm class in the TIA Portal)
● User-defined diagnostic buffer entries
● System-side diagnostic buffer entries

The display language for the entire project including message texts is set in the project 
navigation of the TIA portal under "Languages & Resources."

Additional references
You will find detailed information on creating and compiling message texts in Section "Message 
configuration" in the SIMOTION SCOUT TIA online help.

See also
Using tags (Page 239)

7.4 Creating an HMI connection
To make this connection, the SIMOTION device and the HMI device must have been created 
in HWCN. The HMI device must support SIMOTION CPUs.

There are two ways of establishing the communications connection between the SIMOTION 
CPU and the HMI device:

● The communications connection is configured manually in the network view.

● The communications connection is generated automatically when a SIMOTION tag is used 
in an HMI image.

Configuring an HMI connection
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Configuring an HMI connection manually
1. Switch to the network view.

2. Click  and select "HMI connection" in the drop-down list. 
The connection option is then highlighted in color.

Figure 7-3 Displaying an HMI connection

3. Move a connection from the HMI device to the SIMOTION device with a drag-and-drop 
operation.

Configuring an HMI connection
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Figure 7-4 Configuring an HMI connection

 

Result
The HMI connection has been established.

You can connect parameters in the "Connections" editor.

Configuring an HMI connection
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Figure 7-5 HMI connection created

Generating an HMI connection using tags

Creating an HMI screen
1. In the TIA Portal, browse to the HMI in the project tree.

2. Click "Images" and double-click "Insert new image".

Configuring an HMI connection
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Adding I/O fields
1. In the "Tools" window, select the desired element.

Figure 7-6 Selecting an element

2. Drag the element to the approximate position on the screen at which you want it to appear 
later.

3. Select the element and switch to the property window.

4. In the navigation, select the entry "General".
In this area, you can configure the connection of the process tags and settings to the mode 
and displayed format.

5. Drag the tag from the project tree into the properties window onto the "Tags" item. 

Result
The system automatically creates an HMI tag assignment.

You can see the assignment of the connections in the network view of the device configuration.

Configuring an HMI connection
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7.5 Testing the connection

Testing the connection
To test the created connection with the HMI device in the TIA Portal, proceed as follows:

1. Configure an alarm window on the HMI device with the display setting "message buffer."

2. Compile the project.

3. Load the project into the control and into the HMI device.

4. Switch the control's operating mode to RUN.

Result
Buildup of the connection is displayed in the alarm window.

Configuring an HMI connection
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Motion Control parameterization/programming in 
SIMOTION SCOUT TIA 8
8.1 Start SIMOTION SCOUT TIA

Note

You can only start SIMOTION SCOUT TIA from the TIA Portal.

After you have created the project in the TIA Portal and you have configured the hardware and 
communication, start SIMOTION SCOUT TIA to configure the technology.

Procedure

In the portal view
● Click the "Motion & Technology" function.

● Click the "Open SIMOTION configuration" item in the secondary navigation.

In the project view
● Start SIMOTION SCOUT TIA via the menu "Project > Open SIMOTION configuration".

● Or double-click the "SIMOTION configuration" menu entry under the SIMOTION device in 
the project tree.

Note

You should not go online simultaneously in the TIA Portal and SIMOTION SCOUT TIA.

Always disconnect the online connection in the TIA Portal before going online with SIMOTION 
SCOUT TIA.
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8.2 Going online/offline with SIMOTION SCOUT TIA

8.2.1 Selecting the access point and target devices

8.2.1.1 Online access points
You have two access points for the communication of SIMOTION SCOUT TIA with controllers 
and single drive units.

● The properties of the access point S7ONLINE are defined in the TIA Portal. With this access 
point, you go online via the interface that you have configured in the TIA Portal. The settings 
in SIMOTION SCOUT TIA are not used and are not effective.
The settings for this access point are taken from the TIA Portal.

Figure 8-1 S7ONLINE

● The DEVICE (STARTER) access point provides the option of connecting 
SIMOTION SCOUT TIA either in parallel or alternatively to S7ONLINE, directly to a device, 
e.g. via the Ethernet interface. In this way, you can communicate quickly with the device 
without having to make changes to the project settings, either via the system network or 
via a separate connection in order, for example, to adapt the parameterization or read out 
the diagnostics information.
The DEVICE access point does not exist in the TIA Portal. Thus, the settings for this access 
point can be configured only in SIMOTION SCOUT TIA.
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Figure 8-2 DEVICE

It is therefore possible to configure both access points for a device and to go online via these 
points.

8.2.1.2 Available nodes
The function "Accessible nodes" in SIMOTION SCOUT TIA enables you to identify devices in 
a network, apply them to a project, and go online with them.

Note

The search for accessible nodes assumes that no online connection with an opened project 
exists. 

Displaying accessible nodes
Proceed as follows to identify accessible nodes:

● Select "Project > Accessible nodes" in the menu. 

All the devices found in the network are listed in the working area below the folder "Accessible 
Nodes". Type information is also displayed for them
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Assigning interface parameterization to an access point
To create a connection between the access point, the interface parameterization, and the 
interface, proceed as follows:

1. Click the "PG/PC..." button to open the "Set PG/PC interface" dialog box.

2. Under "Access point of the application," select the DEVICE access point to which you assign 
the interface parameterization.

3. Select one of the interface parameterizations to assign it to the access point, modify its 
properties, copy it, or delete it.

4. Click "OK" to apply the settings.

5. In the working area, click "Update" to restart the search for accessible nodes.

Note

The settings in SIMOTION SCOUT TIA are only accepted for the access point DEVICE. The 
access point S7ONLINE must be configured in the TIA Portal.

Searching for accessible nodes via the IP address
With TCP/IP interface parameterization you can search for nodes via the IP address. Enter 
the IP address in the "IP address of the sought node:"  field.

For the automatic detection of accessible nodes via a PG/PC interface with TCP/IP, the nodes 
must be connected to the same physical Ethernet subnet as the PG/PC. Once a device is 
downstream of an IP router and so located in another physical Ethernet subnet, this device 
will no longer be automatically detected in "Accessible nodes".

You can also enter an IP address and check whether it is possible to access a node 
downstream of an IP router with the configuration currently set of the Ethernet adapter located 
in the PG/PC (IP address/subnet mask).

Displaying additional information
To display additional information about identified devices, proceed as follows:

1. Right-click on a device or drive unit and select, for example, one of the following options 
from the shortcut menu:

– "Device Diagnostics"

– "Operating state"

– "Licenses"
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Going online with accessible nodes
With "Accessible nodes," you can go online on devices for which no access has been 
configured in the project. Device type and address are determined automatically. If the device 
is in another subnet, you must enter the address manually in the interface properties of the 
device for the DEVICE access point.

Note

DEVICE must be set as access point for this function. 

Assigning devices
To go online on a device that has not yet been assigned to the project, you must add the device 
to the project. 

To do this, proceed as follows:

1. Select a device in the "Non-assigned devices - My project" or "Non-assigned devices - 
Accessible nodes" list.

2. Click the "Assign" button to move the device to the "Assigned projects" list.

3. Click "Connect to assigned devices" to go online with the devices.

Cancelling an assignment
To undo the assignment of a device to the project, proceed as follows:

1. In the "Assigned devices" list, select the device in question.

2. Click the "Cancel assignment" button.

Note

The SINAMICS Integrated or an assigned CX32-2 is always also selected for a SIMOTION 
D.

See also
Setting the access point on the PG/PC (Page 201)

Select target devices (Page 202)

8.2.1.3 Setting the access point on the PG/PC

Note

The data for the PG/PC interface can only be changed when the interface is not online. If 
several instances of SIMOTION SCOUT TIA have been started, an online connection can only 
be established from one of the instances. An attempt to go online simultaneously from several 
SIMOTION SCOUT TIA instances to different CPUs results in errors.
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Using S7ONLINE
SIMOTION SCOUT TIA takes the settings for the S7ONLINE access point from the TIA Portal. 
Under "Online accesses" choose the following settings:

1. PG/PC interface type

2. PG/PC interface

3. Connection with subnet

4. "1. Gateway"

5. Device address

The settings for S7ONLINE in the "Set PG/PC interface" dialog box are not applied.

Setting the DEVICE access point
Proceed as follows to set the DEVICE access point:

1. Select "Options > Device access point interface" in the menu. 
The "Set PG/PC interface" dialog box opens.

2. Select the DEVICE access point at "Access point of the application":

3. At "Interface parameterization in use", select the interface with which you want to go online 
via the selected access point.

4. Confirm your selection with OK.

8.2.1.4 Select target devices
With the target device selection, you specify whether this device is to be used to go online 
when you perform "Connect to selected target devices."
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Procedure
1. Select "Target System -> Select target devices ..." in the menu 

The "Target Device Selection" dialog box opens.

Figure 8-3 Selecting target devices and access points

2. Activate the checkbox for the respective device.

3. Click "Establish state" to:

● Establish a connection to a device that was deselected when going online and that has 
been subsequently selected.

● Separate a connection to a device that was selected when going online and that has been 
subsequently deselected.
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8.2.2 Save project and compile changes

Overview

Note

You can only "save a project and compile changes" in SIMOTION SCOUT TIA.

"Save project" in SIMOTION SCOUT TIA automatically performs a "Save project" in the TIA 
Portal.

Always cancel the online connection in the TIA Portal before you execute "Save project and 
compile changes" in SIMOTION SCOUT TIA.

To download a project to the target system, it must first be saved and compiled into an 
executable code. Only the compiled code can be downloaded to the target system and 
executed.

save the project
With "Save project," project is saved to the hard disk. The changes are accepted into the 
project. No further processes (such as compilation or consistency checking) are triggered for 
the project.

Procedure
To save a project, proceed as follows:

1. Select "Project > Save" in the menu.

Save project and compile changes
"Save project and compile changes" searches through the entire project for changes. If a 
source is found which has been changed or has no compilation results, this and any linked 
sources are compiled and saved (e.g. during an FB call). Therefore only the changes are 
compiled. 

Procedure
To save and compile a project, proceed as follows:

● Select "Project > Save and compile all" in the menu.

● Click the "Save project and compile changes" button on the toolbar.

The compilation run is logged in the detail view of the workbench. Information, warning and 
compilation errors are shown there in plain text.

Motion Control parameterization/programming in SIMOTION SCOUT TIA 
8.2 Going online/offline with SIMOTION SCOUT TIA

SIMOTION SCOUT TIA
204 Configuration Manual, 01/2015



Saving projects and recompiling all
With "Save and recompile all," all sources of the entire project are recompiled. The command 
is suitable if you are quite sure that all the old data from older versions should be removed and 
replaced with new compilation results. The command incorporates the following steps:

● Project-wide deletion of all compilation results

● Recompilation of all objects

Procedure
To save and recompile data, proceed as follows:

1. Select the "Project > Save and recompile all" menu command.

The compilation run is logged in the detail view of the workbench. Information, warning and 
compilation errors are shown there in plain text.

8.2.3 Connect to selected target devices
Use the "Connect to selected target devices" function to go online with the device connected 
to the PG/PC. You can send and receive data.

Preconditions
● You have created a subnet for the PG/PC interface in the TIA Portal.

● You have assigned the PG/PC interface to the subnet in the TIA Portal (see also Setting 
up the PG/PC communication (Page 100))

● In the TIA Portal, you have loaded the hardware configuration into the SIMOTION device 
(see also Setting up the PG/PC communication (Page 100))

● You have disconnected the online connection in the TIA Portal.

Online connection
To establish an online connection, proceed as follows:

1. Select "Project > Connect to selected target devices" or click the "Connect to selected target 
devices" button on the tool bar.
The "Target Device Selection" dialog box opens.

2. In this dialog box, check the settings of the target device selection and the access points 
and confirm with "OK." 
Devices not selected in this dialog box but still online will not be disconnected from the 
target system.
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Selective online connection
To establish a selective online connection, proceed as follows:

1. Select a CPU or a drive in the project navigator.

2. Execute "Connect target device" in the shortcut menu to establish a connection with this 
drive.

Result
● The connection will be established and the project checked for consistency.

● The footer area indicates that the system is online.

● The detail view shows the drives control panel.

● In the project tree, the status of the online connection is indicated in a color by the connector 
icons.

Consistency display (connector symbols)
Each element in the project navigator has its characteristic icon. In online mode, the icons are 
highlighted in color or additional icons (connector icons) are displayed which are characteristic 
for the PC/PG to target system connection. 

The table below presents an overview of the meaning of the various icons.

Icon Description
The SINAMICS drive unit/element of a drive unit (DO) is in online mode. There is an incon‐
sistency in terms of the data contents (parameter values) of the drive unit/element.
SINAMICS drive unit / element of a drive unit (DO) is in online mode. There is an inconsis‐
tency in terms of the data contents (parameter values) of the drive unit/element.
Possible reasons for the inconsistency:
● At least one parameter value differs between the project data and the actual values in 

the target system.
● Sequential parameterization: After a parameter assignment has been downloaded, 

sequential parameterization may be required once data has been received in the drive. 
In this case, you must perform an upload for alignment purposes.

Note:
● If the inconsistency is displayed by means of the icon in the project navigator, you can 

display the inconsistency in detail using object comparison. Depending on the result, 
you can then decide whether or not an upload or download is necessary. 

● If this icon is displayed, it may be that, depending on the mechanism used, the 
parameters of a DO that are marked with this icon will be marked as "equal" in the object 
comparison. The object comparison is based on a direct comparison of all the values 
for the element and, therefore, provides the correct difference.

The component (drive object) is in online mode. The component is physically present in the 
RAM of the drive unit or project data in the main memory of the PC/PG is identical with the 
project data of the component present in the RAM.
The component (drive object) is not in online mode. The component is not physically present 
in the RAM of the drive unit or the connection to the target device is broken.
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Icon Description
The device was not selected during the change to online mode. There is no connection to 
this device.
Device/element is in online mode. There is an inconsistency between the project data of the 
device/element in the PG/PCs and the actual values of the device/element in the target 
system.
● Possible reasons for the inconsistency – SIMOTION CPUs/TOs/Units:

– Configuration data of a technology object changed / technology objects added
– Change in a program source, in a global device variable, or in the address list
– Change to the default value of a system variable

● Possible reasons for the inconsistency – drive unit / DO, e.g. due to:
– Change in the name of a DO
– Change in the type of drive object (DO) from SERVO -> VECTOR
– Selection/deselection of different function modules
– Addition/removal of DDS/CDS
– Addition of a DCC chart to a drive object (DO)

Structural changes have been made to the DO. If this inconsistency is present, integrated 
online diagnostics cannot be performed on the device/element.
Remedy:
In the event of this inconsistency, you should save the project and reload the new project 
data into the target system.
Note:
If an inconsistency is displayed by means of the icon in the project navigator, you can display 
the inconsistency in detail using object comparison.

No connection could be established to SINAMICS Integrated/drive units
1. Check the messages in the output window. 

2. Download a project to load the project data into the device and establish a connection.
To do that, select "Project > Download to target system" in the menu. 

You will find more information in Section Loading data to the target system (Page 208).

Note

You must make sure you go online via the selected interfaces. If, for example, you have 
configured the incorrect interface for the S7ONLINE access point, you will not go online. 
Therefore, if required, check the settings made there.

Additional references
You will find more information in Section "Set interface" of the SIMOTION SCOUT TIA online 
help.
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8.2.4 Loading data to the target system

8.2.4.1 Overview

Note

Loading data to the target system can only be done in SIMOTION SCOUT TIA.

You have to download the project data that you have created with SIMOTION SCOUT TIA to 
the target system. 

The target system can contain several CPUs (SIMOTION controllers or drives). The project 
data contains the programs (e.g. MCC) that you have created and compiled, the hardware 
configuration and the technology packages that you have created and parameterized.

You must load a project to the target system, if you have:

● Created or changed programs

● Changed definitions of global tags or symbolic I/O tags

● Made changes to the execution system

● Created or changed technology objects

Preconditions
The following conditions must be met before the project can be downloaded to the target 
system:

● All ports (cables) must be plugged in and the interfaces configured

● All source codes are compiled without errors.

● The project is consistent.

● SIMOTION SCOUT TIA is in online mode.

Responses in the event of an error
The download is canceled in response to a fault: Information can be found in the "Target system 
output" tab.
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Download variants
You can either load the entire project to the target system or perform a download for a specific 
device:

● Downloading a project to the target system (all target devices)

● Download CPU / drive unit to target device

● Downloading a program subset and single units (sources) to the target device 

Additional references
You will find detailed information on downloading in the "Basic functions" function manual and 
in the SIMOTION SCOUT TIA online help under "Downloading data into the target device."

See also
Load project to the target system (Page 209)

Load CPU / drive unit to target device (Page 211)

Downloading a program subset and single units (sources) to the target device (Page 213)

8.2.4.2 Load project to the target system

Note

You can only perform a project download in the STOP mode and for all target devices with 
which you are ONLINE.
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Procedure
To load a project into the target system, proceed as follows:

1. Select the "Project -> Load to target system" in the menu or Click the "Load project to the 
target system" button on the toolbar.
The "Load to the target system" dialog box opens.

Figure 8-4 Download to target system

Depending on the device, optionally select:

– Store additional data on the target device

– Copy RAM to ROM after download

2. Click "Additional CPU options" to display the following options:

– "Replace product versions of the technology packages"; this loads the technology 
packages selected in the "Select Technology Packages" dialog box to the target system. 

– "Initialization of the non-RETAIN technology object data"; only non-RETAIN data can 
be initialized for TOs. This does not affect the program data (variable values).

– "Initialization of the non-RETAIN program data and the non-RETAIN global device 
variables"
The "RETAIN program data and the RETAIN global device variables" can also be 
initialized. This does not affect the technology object data. The global device variables 
are initialized together with the settings for the program data (variable values).

– Load without HW configuration
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3. Select additional options if applicable.

4. Click "Yes" to start downloading.

Note

You make the global settings in SIMOTION SCOUT TIA under "Options > Settings > 
Download."

Result
The project data has been loaded into the target device and an online connection established. 

If the connection was successful, the connector icons are highlighted in a color.

8.2.4.3 Load CPU / drive unit to target device
In addition to a project download, you can also selectively load data to each CPU / drive unit. 
The standard procedure is the download in STOP mode. However, under certain 
circumstances you can also perform a download in RUN mode.

Procedure
Proceed as follows to load selective data into a CPU/drive device:

1. First select the device to which you want to load the data in the project tree. The device 
must be online.

2. Click the "Download CPU / drive unit to target system."
Or, right-click the device in the project navigator and execute "Target device > Download 
to target system" in the shortcut menu.

3. The "Download to target device" dialog box is displayed. The contents depend on the device 
for which you want to download data.

Loading the CPU to the target device
A download can be performed for the entire CPU (without drive unit) but also separately for 
individual related download units. 

● Download CPU without drive unit

● Download all technology objects of the CPU

● Download all programs of the CPU
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Figure 8-5 Download to CPU / drive unit

You can select the following options:

● "Store additional data on the target device"; you can use this option to store supplementary 
data (e.g. program sources) on the target device.

● "After loading, copy RAM to ROM"

● "Perform download during RUN"; enables a download to be performed in RUN mode.

Click "Additional CPU options" to display the following options: 

● "Replace product versions of the technology packages"

● "Initialization of the non-RETAIN technology object data"

● "Initialization of the non-RETAIN program data and the non-RETAIN global device 
variables"

● "Load without HW configuration"
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Downloading the drive to the target device
For drives, you can only download the drive data (parameterization, etc.) to the drive unit.

Figure 8-6 Download to drive unit

By default, the download is performed in STOP. After a successful download, the CPU can be 
restored to its previous status.

You can select the following options:

● "Store additional data on the target device"; you can use this option to store supplementary 
data (e.g. program sources) on the target device.

● "After loading, copy RAM to ROM"; copies RAM to ROM to the selected device once the 
download is complete.

Additional references
You will find detailed information on downloading in the "Basic functions" function manual and 
in the SIMOTION SCOUT TIA online help under "Downloading data into the target device."

8.2.4.4 Downloading a program subset and single units (sources) to the target device

Download of selected units
You can load single or multiple units into the SIMOTION device in the RUN and STOP operating 
states and in this way specifically load only a selected subset of programs. 

This enables, for example, two users who are connected online to the target device at the 
same time with SIMOTION SCOUT TIA to download separate program subsets independently.

To do this, proceed as follows:

1. In the project navigator, right-click on the unit and select "Download to target device..." in 
the shortcut menu.
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Additional references
You will find detailed information on downloading in the "Basic functions" function manual and 
in the SIMOTION SCOUT TIA online help under "Downloading data into the target device."

8.2.5 Disconnect from target system
Use "Disconnect from target system" to switch to offline mode. The device is disconnected 
from the PC/PG.

Disconnecting from the target system
To disconnect the connection to the target system, proceed as follows:

1. Select "Project > Disconnect from target system" or click the "Disconnect from target 
system" button on the toolbar.

Result
The connection is interrupted and SIMOTION SCOUT TIA goes into offline mode.

Disconnecting a device
To disconnect a device selectively, proceed as follows:

1. In the project tree, select the drive that you want to disconnect.

2. Right-click it and choose "Disconnect target device" from the shortcut menu.

Result
The drive goes offline.

If this is the last drive that was online, SIMOTION SCOUT TIA goes into offline mode.

8.2.6 Problems when going online

8.2.6.1 Not possible to connect to target system
If you cannot go offline with the project despite proceeding as described above, check the 
following settings:   

● Network connections (TIA Portal)

● PG/PC interface access point S7ONLINE (TIA Portal)

● Access point Device (SIMOTION SCOUT TIA)

● Bus address of the devices or IP address (TIA portal)

● Firmware version of the device (SIMOTION SCOUT TIA)
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Subsequently we describe the procedures that are particularly easy to implement.

You have the choice of communicating with the controller via PROFINET/Ethernet or 
PROFIBUS. These options also provide maximum flexibility in the choice of a teleservice 
connection (teleservice via PROFINET/Ethernet or PROFIBUS). This access method, which 
is specified once, enables you to use routing to reach other controllers and drives connected 
to the SIMOTION controller via PROFINET/Ethernet or PROFIBUS.

You can also reach the SIMOTION controller via existing routing connections to other 
controllers, without there being a direct connection between the PG and the SIMOTION 
controller.

However, these options require that an online access is specified during the initial 
commissioning. This description explains the procedure for the initial commissioning (or when 
changing the access settings). When this configuration has been performed correctly and 
completed, going online then is practically only at the touch of a button.

Only procedures that always and safely result in success are described here. Depending on 
the initial situation, a different procedure is also possible with sufficient knowledge.

PG/PC interface (access point S7ONLINE) configured in the TIA Portal?

Were you online with the TIA Portal and have you configured the PG/PC interface?
Before you can go online with the SIMOTION SCOUT TIA, you must configure the interface 
on which you want to go online. Perform this step in the TIA Portal. 

Possible sources of error include:

● You are still online with the TIA Portal. Disconnect the online connection. 

● You have not assigned the controller to any subnet. Instructions for assigning the controller 
to a subnet are described in the SCOUT TIA Online help in the TIA Portal.

● IP address and subnet screen of the PG/PC and the controller are not on the same subnet. 
Adapt the IP address/subnet of PG/PC in the Windows Control Panel or automatically 
assign a temporary IP address via the TIA Portal. Associated information is contained in 
the SCOUT TIA Online help in the TIA Portal.

● Check in the TIA Portal under "Online&Diagnosis" with which interface you attempt to go 
online.

Before going online with the controller, you must clarify the following questions:

Is the project to be loaded (or consistent project) already on the controller and have no changes 
been made to the interface settings? 
In this case, activate the interface configured in the project and go online in SIMOTION SCOUT 
TIA using the  button "Connect to selected target devices". The devices to which a 
connection is established can be seen under "Target system > Select target devices...".

Have changes been made to the interface settings?
When do changes have to be made to the interface settings?

● An overall reset has been performed on the controller (MRES).

● The controller has been replaced.
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● The project is to be loaded to a new (or unknown) controller.

● Changes have been made to the interface settings in the project (another PROFIBUS baud 
rate selected; access addresses changed).

Requirement: You have a completed HW configuration and a project that can be downloaded.

Do I require an online connection to all devices/components present in the project?
In online operation, SIMOTION SCOUT TIA attempts to conduct online operation with all 
hardware components contained in the project. This means that the time needed for going 
online increases. We recommend that you make settings for SIMOTION SCOUT TIA so that 
online operation is made only with those components currently needed. The setting can be 
found with "Target system > Select target devices..." in the menu. The selection and 
deselection of the devices in the online state can be made from the "Online connection" context 
menu on the device.

This procedure is also advantageous for SIMOTION D when configuration of the SINAMICS 
Integrated is complete. Without completely going offline with all hardware components, the 
connection may simply be deselected on the object SINAMICS_Integrated via the context 
menu.

See also
Setting up the PG/PC communication (Page 100)

8.2.6.2 Troubleshooting
If you still cannot go online with the project despite proceeding as described above, check the 
settings of CX32-2.

To be able to go online on a CX32-2, at least the hardware configuration (HWCN) must be 
loaded to the D4x5-2 and the CX32-2 connected without errors via the configured DRIVE-CLiQ 
ports on the D4x5-2.

Online access to the drives is not possible if HWCN is not loaded at the time you initially connect 
to the target system.
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8.3 Commissioning the drives

8.3.1 Overview

Note

Configuring a SIMOTION drive in SIMOTION SCOUT TIA. A SIMOTION drive in the current 
version of SIMOTION SCOUT TIA is a drive of the SINAMICS S120 type (interconnection via 
PROFINET or PROFIBUS) interconnected with a SIMOTION CPU. You will find the SIMOTION 
drives you can insert explicitly stated in Chapter Supported devices (Page 23). These 
SIMOTION drives can be configured and parameterized only under these conditions 
(interconnection with SIMOTION CPU).

You can configure the drive both in offline and online modes.

After configuring the drive, you can test the drive with the drive control panel.

8.3.2 Configure drives online

Requirements:
● You have created a drive in the project.

● The project has been downloaded to the target system.

● SIMOTION SCOUT TIA is in online mode.

● The drive is not being used by a current project (TO axis linked to this drive) in the RUN 
state.
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Procedure
To configure drive automatically, proceed as follows:

1. In the project tree, browse to the SINAMICS drive and double-click "Automatic 
Configuration".

Figure 8-7 Starting automatic configuration

The "Configuration" dialog box opens.

Figure 8-8 "Automatic Configuration" dialog box

2. Click the "Start" button and reset the device configuration in the subsequent "Restore 
Factory Settings" dialog box. 
The confirmation prompt appears if the drive unit is not in the "First commissioning" state.

3. In the "Automatic Commissioning" dialog box, you can specify whether you are using a 
drive object of the type "servo" or "vector". Confirm your selection with "Create".
Automatic configuration is started.

Note
Firmware update

If the firmware version on the DRIVE-CLiQ components is different to that on the CF card, 
a firmware update is performed automatically at this position.

In this case, proceed as follows:
● Wait for the procedure to finish. This can take several minutes.
● Go offline.
● Switch the power supply to the SIMOTION device off and on again.
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4. As soon as automatic commissioning has finished, SIMOTION SCOUT TIA carries out an 
upload. With this upload, the configuration data of the component is uploaded to the 
SIMOTION SCOUT TIA project.

5. Close automatic configuration and select "Stay ONLINE" to test the drive with the drive 
control panel.

Result
The drive is displayed in the "Drives" folder in the project tree. 

Figure 8-9 Drives inserted

Infeed
● If an infeed with DRIVE‑CLiQ connection has already been created, the ready signal of the 

infeed (r0863.0) is automatically interconnected with "Infeed operation, p0864" of the drive 
when drives are inserted (only applies to drives that are attached to the same drive unit as 
the infeed).

● If you are using an infeed without a DRIVE-CLiQ interface, e.g. a Smart Line Module, you 
must wire the ready signal of the infeed via terminals, see Chapter Configure the infeed 
without a DRIVE-CLiQ interface (Page 223).

8.3.3 Configure a drive offline
The drive is configured in offline mode in two stages:

1. Insert a drive into the project.

2. Configure the drive with the Wizard.
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Procedure
To insert a drive, proceed as follows:

1. In the project tree, browse to the drive device and double-click "Configure drive unit"

Figure 8-10 Configuring a drive unit

The "Configuration - option module" dialog box opens.

Figure 8-11 Configuration Optional Module

2. Select the option module used under "Option module" if applicable. Confirm with "Next>".

Motion Control parameterization/programming in SIMOTION SCOUT TIA 
8.3 Commissioning the drives

SIMOTION SCOUT TIA
220 Configuration Manual, 01/2015



3. Under "Insert infeed", select whether you want to use an infeed with or without DRIVE CLiQ 
interface.

– If you are using an infeed with DRIVE-CLiQ interface, the ready signal of the infeed is 
interconnected automatically.

– If you are using an infeed without a DRIVE-CLiQ interface, e.g. a Smart Line Module, 
you must wire the ready signal of the infeed via terminals, see Chapter Configure the 
infeed without a DRIVE-CLiQ interface (Page 223).

4. Under "Insert drive," confirm with "YES" that you would like to create a drive. Click 
"Continue>".
The "Configuration - drive properties" dialog box opens.

Figure 8-12 Configuration Drive Properties

5. Assign a name for the drive. Optionally, you can enter Author, Version, and Comment.

6. Confirm with "Next>".

7. Under "Control structure," specify the control mode and the function modules depending 
on the operating mode (servo or vector). Confirm with "Next>".

8. Under "Power Unit," select the required power unit. Further narrow down your selection of 
possible power units by using the prescribed filter criteria supply voltage, cooling method, 
type. Confirm with "Next>".
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9. If you are using an infeed without a DRIVE-CLiQ interface, you must manually interconnect 
the ready signal of the infeed in the next step "Power unit BICO". In the example, the 
parameter p0864 is set to 1 (high) to simplify matters. 
From the perspective of the drive, the infeed is thus always ready, regardless of its actual 
state of readiness.

10.Under "Motor," define the motor for the SINAMICS drive. Confirm with "Next>".

11.Under "Motor holding brake," you can configure the motor holding brake of the selected 
motor. Depending on the motor, different parameters are displayed. Confirm with "Next>".

12.Under "Encoder," specify the encoder that you want to use. This step is skipped if you 
selected speed control without encoder as the control type.  Confirm with "Next>".

13.Adopt the preset option under "Process data exchange" and confirm with "Next>". The 
telegram configuration is done automatically.

14.Once you  have worked through all the steps of the configuration, the configured 
configuration is displayed once again for you to confirm.
Close the dialog box with "Finish."

Result
The drive is displayed in the "Drives" folder in the project tree.

Figure 8-13 Drive inserted

Modify configuration
To change the configuration of a drive that has already been configured, proceed as follows:

1. Open in the project navigator the folder of the drive whose configuration you want to change.

2. Double-click "Configuration."

3. Click "Configure DDS" or "Wizard" (depending on the drive) to start the drive wizard.

Download the drive configuration into the target system
Save and compile the changes and load the drive configuration into the target system to be 
able test the drive function with the control panel in the next step.
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Additional references
You will find detailed information in Section "Configure SINAMICS drives" of the SIMOTION 
SCOUT TIA online help.
You will find additional information on interconnecting the ready signal in Chapter Configure 
the infeed without a DRIVE-CLiQ interface (Page 223).

8.3.4 Configure the infeed without a DRIVE-CLiQ interface

Interconnecting the ready signal of the infeed
An infeed without DRIVE‑CLiQ interface provides the ready signal (p0863.0) via an output 
terminal. In the project, you specify on which input (r0722) of SINAMICS Integrated the signal 
is active. The drive supplied by the infeed uses the signal as a ready signal (p0864).

Note

A drive on SINAMICS Integrated of a SIMOTION D can only be moved if the infeed is ready.

Preconditions
● You have configured a drive.

● SIMOTION SCOUT TIA is in online mode.
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Procedure
In the next step, in order to wire the ready signal of the infeed (terminal "DO: Ready" of infeed) 
with the DI 0 of the D4x5-2, proceed as follows in case you have not already established the 
interconnection during processing using the drive wizard:

1. Navigate in the project tree to the "Drives" folder and double-click "Configuration" below 
the drive.

Figure 8-14 Configuring a drive

2. Click the "Configure DDS" button with a yellow background in the working area.

Figure 8-15 Configure DDS

The drive wizard opens. 

3. Click "Next" in the drive wizard until you reach the "Configuration - SINAMICS_Integrated 
- BICO power unit" dialog box.

4. In the input field "p0864," select the digital input (e.g. DI 0) to which the ready signal of the 
infeed is wired. 

Figure 8-16 BICO interconnection
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5. Click on "Next." Loop through all other dialog boxes without change until the final 
"Summary" dialog box.

6. Click "Complete."
Thus, the configuration is finished.

See also
Configure a drive offline (Page 219)

Configure drives online (Page 217)

8.3.5 Test the drive using the drive control panel

Drive control panel
The drive control panel is used to control and monitor individual drives. With the drive control 
panel, you can operate drive and can:

● Test each part of the system individually before the drives are traversed in a coordinated 
manner by means of a program.

● Test in a fault situation whether the individual drives can be operated by the drive control 
panel at all, or whether there are already problems here.

WARNING

This software may be used only when the associated safety notes are observed! The non-
observance can cause injury to persons or damage to material!

The function is released exclusively for commissioning, diagnostic and service purposes. The 
function should generally only be used by authorized technicians. The safety shutdowns from 
the higher-level control have no effect.

The Stop with preconfigured braking ramp function is not guaranteed in all operating modes. 
Therefore, there must be an EMERGENCY STOP circuit in the hardware. The appropriate 
measures must be taken by the user.

Preconditions
● You have created and fully configured a drive in the project. 

● You have stored and compiled the project. The project is consistent.

● SIMOTION SCOUT TIA is in online mode.

● The project with the drive parameterization has been loaded into the target system.
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Opening the drive control panel
1. In the project tree, browse to the drive device and open the "Drives" folder. 

2. Open the "Commissioning" entry and double click "Control panel".
The drive control panel is opened in the detail view.

Figure 8-17 Drive Control Panel

Using the drive control panel

Assume control priority
1. Click the  button to show the control area to test the motor speed specified under  "n=."

2. Click the  button to show the diagnostics area to display and evaluate defined 
parameters.
You can determine the status of the necessary enable commands with the "Diagnostics" 
button.

3. In the selection list, select the drive that you want to control or monitor using the PC/PG. 
In the example "SINAMICS_Integrated_1 - SERVO_03."

4. Specify the parameters that you want to display in the selection lists on the bottom right-
hand side of the diagnostics area. The values are displayed underneath.
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5. Select "Assume control priority" to establish the connection to the PG/ PC. The "Assume 
Control Priority" dialog box opens.

Figure 8-18 Assume control priority

6. Consider the following infeed options for the type of connection you are using. 

– If you are using an infeed with a DRIVE‑CLiQ interface, select the infeed for which the 
control priority is to be assumed under "Infeed" in the "Assume Control Priority" dialog 
box. 
Select "Infeed" checkbox if the control priority of the infeed is to be fetched and activated.

– If you are using an infeed without a DRIVE‑CLiQ interface, you will have to interconnect 
the "Infeed operation" signal (drive parameter p0864) yourself. In this case, the dialog 
box does not contain any fields for selecting infeed.

– If the signal of the "Closed-loop control operation" infeed is already BICO interconnected 
with the drive, infeed is fixed. No selection is possible in the dialog box, the fields are 
grayed out.

7. Read the safety instructions and confirm these with "Accept".

The PG/ PC has the master control; the label of the button has changed to "Give up master 
control".

Note

You can also stop the drive at any time by pressing the SPACEBAR.

Motion Control parameterization/programming in SIMOTION SCOUT TIA 
8.3 Commissioning the drives

SIMOTION SCOUT TIA
Configuration Manual, 01/2015 227



Activate Infeed
Switch on the power supply. Click the  button for more information.

Activate Enables
Activate the "Enables" checkbox to enable the drive.

The ON and OFF buttons  and  are activates and the enable states are indicated by the 
LEDs.
Click the "Diagnostics" button to show any missing enables. 

Testing the drive
1. Enter a speed setpoint in the "n=" field.

2. Use the slider to set the current speed setpoint in relation to the maximum speed 
setpoint (100%) is set with the slider.

3. Click on the green switch  to start the drive, or click on the  switch to operate the drive 
in jog mode. The motion continues as long as you keep the switch pressed.
In the diagnostics area you can monitor the set speed/torque as well as the actual speed/
torque.

Closing the drive control panel
1. Stop the drive. To do that, click the red switch .

2. Clear the "Enables" checkbox.
The LEDs are grayed out.

3. Deactivate the infeed. To do that, click "Infeed on/off."

4. Click the "Give up control priority" button to return the control priority to the control panel.

5. On the menu bar, select "Project > Disconnect from target system" to switch to offline mode.

Result
The drive can be operated. The drive configuration is complete.
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8.4 Creating and testing an axis

8.4.1 TO axis technology object

Note

You create the technology object (TO) axis in SIMOTION SCOUT TIA.

You can create the axis both in offline and online modes.

Technology objects represent the relevant real objects (such as a positioning axis) in the 
controller.

The Axis technology object offers the user a technological view of the drive and the encoder 
(actuator and sensor) and provides technological functions, such as communication with the 
drive, actual value processing, position control and positioning functionality. It executes control 
and motion commands and indicates statuses and actual values.

Preconditions
If you want to insert a real axis, you will need a working drive.

If you want to insert a virtual axis, you do not need a working drive. 

Note
Virtual axis

All axis types can also be virtual axes, i.e. they do not control real drives but are used as 
auxiliary axes, e.g. as a leading axis for several following axes (line shaft).

Axis technologies
You can use the following axis technologies:

● Drive axis
Motion control is performed using a speed specification without position control.

● Positioning axis
Motions are position-controlled.

● Synchronized axis
The synchronous axis creates a grouping of the slave axis and synchronous object.

● Path axis
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Axis wizard
SIMOTION SCOUT TIA provides the Axis wizard for the creation of a new axis. Using the 
wizard, you interconnect the TO axis with a drive.

Note
Axis wizard - restriction

The wizard can only be run through once. 

Subsequent changes to the axis configuration are possible in the corresponding dialogs of the 
TO axis.
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8.4.2 Configuring Axes

Procedure
To insert an axis with the axis wizard and to interconnect with drive and encoder, proceed as 
follows:

1. Navigate to the folder in the project navigator "AXES" and open it by double click.

2. Select "Add axis". The "Insert a Control" dialog box opens.

Figure 8-19 Creating an axis

3. Name the axis and select the axis technology that you want to use.
Note here that the "Positioning" technology always requires the "Speed control" technology. 
Thus, this technology cannot be deactivated.
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4. Click "OK" to close the dialog. The "Axis Configuration - Axis Type" dialog box opens.

Figure 8-20 Axis configuration - defining the axis type
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5. Select the axis type, and specify this. Select the mode for electric axes or hydraulic axes 
and confirm with "Next>."
The "Axis configuration - Drive assignment" dialog box opens.

Figure 8-21 Axis configuration - Drive assignment
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6. Depending on the selected axis type, with an electric axis you assign the drive which you 
have configured beforehand in the step "Drive assignment".

Note

As an alternative to assigning the axis to an already configured drive, the axis wizard offers 
two further selection options:
● Define the axis/drive assignment later:

The axis is to be created and not assigned to a drive until later. Programming and 
simulation of the axis are also possible here.

● Create drive:
The drive wizard can be called up from the axis wizard (offline configuring). The axis 
can thus be created in one step along with the drive, and assigned to the drive.

The alternative approaches are not being considered at this point.

With an hydraulic axis, you configure the output for a Q-valve in the step "Configuration of 
Q-output"; the Q-valve represents the actuator for a volume flow.
Confirm with "Next>".

7. Specify the encoder to be used by the axis or the active axis data set in the "Encoder 
assignment" step. 
Confirm with "Next>".

8. Specify the parameters for the used encoder in the "Encoder configuration". Only the 
encoder type has to be specified when using the symbolic assignment.

9. Once you have worked through all the steps of the configuration of a TO axis, the configured 
configuration is displayed once again for you to confirm.
Close the dialog with "Finish".

Result
The axis is displayed in the "AXES" folder of the project navigator.

Figure 8-22 Axis created

Automatic settings of the engineering system
The engineering system automatically defines the PROFIdrive axis telegrams required for 
communication, as well as the addresses used.

In the same way, telegrams are extended and interconnections automatically created in the 
drive, depending on the selected TO technology (e.g. SINAMICS Safety Integrated).
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Drive and encoder data, as well as reference variables, maximum variables, torque limits, and 
granularity in torque reduction of the SINAMICS S120 are accepted automatically for the 
configuration of the SIMOTION technology objects "TO axis" and "TO external encoder." This 
data no longer has to be entered in SIMOTION.

Loading the axis configuration into the target system
Save and compile the changes and load the axis configuration into the target system to test 
the function of the axis in the next configuration step.

Additional references
For detailed information, refer to the section "Configuring the axis and external encoder" in the 
online help for SIMOTION SCOUT TIA.

See also
Technology packages and technology objects (Page 30)

8.4.3 Test axis using the axis control panel
Using the axis control panel you can control and observe individual axes. 

Using the axis control panel, you can also:

● Test axes before you run this via a program.

● Testing as to whether you can move the axis using the axis control panel if a fault is detected.

● Set/ remove axis enable.

Preconditions
● You have created, configured and connected an axis to the drive.

● SIMOTION SCOUT TIA is in online mode.

● You have loaded the project into the target system.
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Open axis control panel
1. Open the "AXES" folder in the project tree. 

2. Double-click the "Control panel" item under the axis to be tested.

Figure 8-23 Select axis control panel

The axis control panel opens in the detail view.

Figure 8-24 Axis control panel

Use axis control panel

WARNING

Activate sign-of-life monitoring

Use the axis control panel in control mode only with activated sign-of-life monitoring and a 
suitably short monitoring time! Otherwise, if problems occur in the communication link 
between the control PC and the device, the axis may start moving in an uncontrollable manner.
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Assume control priority
1. Show the control area by clicking the  button in order to test, for example, programmed 

traversing movements in this mode.

2. Show the diagnostic area by clicking the  button in order to test traversing movements 
that are caused by the movement commands sent to the axis in this mode.

3. Select the axis that you want to move and observe from the selection list. In the example 
PLC_1 - Axis_1.

4. Specify the parameters you want to display in the lower left side of the Diagnostics area 
using the selection lists. The corresponding values are shown next to them.

5. Select "Assume control priority" to establish the connection to the PG/PC. The "Assume 
Control Priority" dialog box opens.

Figure 8-25 Assume control priority

6. Read the safety instructions and confirm these with "Accept".

The PG/PC has the master control; the label of the button has changed to "Give up master 
control".

Note

By pressing the SPACER bar, you can stop the axis at any time.
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Activate Enables
● Click the "Set/remove enables"  button to enable the axis.

The LEDs indicate the status of the enables.

Specifying motion commands for axis
● Specify motion commands for the axis.

The following functions are available:

Button Meaning/function
 Speed default

This command specifies that the axis is started speed-controlled.
Specify a speed setpoint to which the axis can be ramped up via a velocity profile. 
The command is possible for all axis types; position and following axes are operated speed-controlled.

 Start axis position-controlled
This command specifies that the axis is started position-controlled.
Specify a speed setpoint to which the axis can be ramped up via a velocity profile. 
The command is possible for position and following axes.

 Position axis
With this command, you specify positioning of the axis (positioning or synchronous axis) at a specific position. 
The position value entered can be absolute or relative. Modulo axes can also be positioned via the shortest path. 
The programmed position must be within the software limit switches.

 Home axis
With an absolute measuring system, homing is only required once during commissioning. When commissioning is 
completed, the position value will be known when the machine is switched on. 
In the case of an incremental measuring system, the machine must be homed every time it is switched on.

Start axis motion
● Click the  button to start the motion command parameterized last.

● Or click the  button to start the "Speed setting" or "Start axis position-controlled" 
movement commands in jog mode. The motion continues as long as the right-hand mouse 
button is pressed.

Exit axis control panel
1. Stop the axis. Click the  button for this.

2. Deactivate the "Set/remove releases" button . Confirm the "Remove Axis Enable" dialog 
box with "OK".

Note

If you want to traverse the axis again, acknowledge all alarms in the "Alarms" window.

3. Click the "Give up master control" button to return the master control back to the control 
panel.

4. On the menu bar, select "Project > Disconnect from target system" to switch to offline mode.
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Result
The axis is movable. Axis configuration is complete.

Potential problems

The axis cannot be moved.
If the axis cannot be moved using the axis control panel, test to see if you can move the drive 
using the drive control panel.

● If you cannot move the drive using the drive control panel, there is a problem with the drive. 

● If you can traverse the drive with the drive control panel, there is a communication problem. 
Check the drive.

See also
Test the drive using the drive control panel (Page 225)

8.5 Program SIMOTION application

8.5.1 Using tags

Tag types
Tags are used to structure programs. They are wild cards in a program and can assume values.
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In SIMOTION, different types of tags are distinguished.

● System tags
Each SIMOTION device and technology object has specific system tags. You can access 
system tags within the SIMOTION device from all programs.

● I/O tags
An I/O tag is a symbolic tag name that is assigned to an I/O address of the SIMOTION 
device or to the I/O. Thus, direct access to the peripherals is possible.
I/O tags are valid for all devices. All programs of the SIMOTION device have access to 
them.

● Global device tags, unit tags and local tags are user-defined tags with limited scope:
These global device tags can be accessed from all parts of the user program. They can 
also be accessed from HMI devices.
Unit tags can be accessed by all programs, function blocks and functions defined within 
the same source, e.g. ST source, MCC source, LAD/FBD source.
A source is a logic unit that you can create in your project and that can contain programs, 
functions and function blocks.
Local tags can only be accessed within the program, the function or function block in which 
they are defined.

Creating global device tags

Note

Global device tags can only be created in offline mode.

In order to create global device tags, proceed as follows: 

1. Click the "GLOBAL DEVICE VARIABLES" element in the project tree under the SIMOTION 
device.
The "Global device variables" table is displayed in the symbol browser.

2. In the "Name" column, click the first empty cell and enter the variable name. In the example: 
"g_bo_start."
Press the RETURN or TAB key. The input focus jumps to the "Data type" field. Alternatively, 
you can click on the field to move the input focus to it.

3. Enter the data type in the "Data type" field. In the example: "BOOL."

4. Press <RETURN> to confirm.
The tag is created and available in the project. In the symbol browser, a new line is opened 
for input.
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5. Create other global device tags according to the same procedure. In the example: 
"g_bo_ready."

Figure 8-26 Creating global device tags

6. Select "Project > Save and compile changes" in the menu to accept the expansions in the 
project.

Creating I/O tags

Note

I/O tags can only be created in offline mode.

1. Double-click the "ADDRESS LIST" element below the SIMOTION device in the project 
navigator.
In the detail view, the "Address List" tab opens.

2. Click on the first free cell in the "Name" column. Enter a name for the tag. 

3. Press the <RETURN> or <TAB> key. The cursor moves to the "I/O address" field.

4. Select the "IN" entry for input tag or "OUT" for output tag in the I/O address column.

5. In the "Assignment" column, click on the 3 points to open the assignment dialog box.

6. In the "Assignment" dialog box, select the required tag and select the "Assign" item in the 
"Assignment" column.

7. Confirm the dialog box with "OK."

8. Select "Project > Save and compile changes" in the menu to accept the expansions in the 
project.

Additional references
You will find detailed information on the programming languages and the execution system in 
the online help of SIMOTION SCOUT TIA and the relevant programming and 

operating manuals.
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8.5.2 Use MCC

8.5.2.1 Overview

Program creation steps
Creation of an MCC program encompasses the following steps:

1. Creating the MCC unit.

2. Creating the MCC charts in the MCC unit.

3. Inserting MCC commands in the MCC chart and parameterizing the commands.

8.5.2.2 Creating the MCC unit

Procedure
To insert an MCC unit, proceed as follows:

1. In the project tree, under the SIMOTION device, open the "PROGRAMS" folder.

2. Double-click "Insert MCC unit." The "Insert MCC Unit" window opens.

Figure 8-27 Insert an MCC source file
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3. Assign a name. In the example: "motion."

4. Go to the "Compiler" tab. For diagnostics purposes, activate the "Permit program status" 
and "Permit single step" options. In this way, you can monitor program execution later in 
online mode.

5. Confirm with "OK."

Result
The MCC unit is created.

● The unit appears in the project tree under the "PROGRAMS" branch.

● In the working area of the workbench, the declaration table of the unit opens. The variables 
declared there apply within the MCC unit and can be linked in other units.

Figure 8-28 MCC unit "motion" inserted

8.5.2.3 Creating an MCC chart

Procedure
To insert an MCC chart, proceed as follows:

1. In the project tree, under the SIMOTION device, open the "PROGRAMS" folder.

2. In the "PROGRAMS" folder, open the MCC unit. In the example: "motion."
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3. Double-click  "Insert MCC chart."
The "Insert MCC Chart" window opens.

Figure 8-29 Inserting an MCC chart

4. Assign a name. In the example: "pos_axis."

5. For the creation type, select "Program."

6. Confirm with "OK."
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Result
The MCC chart is created in the project.

● The created MCC chart "pos_axis" appears in the "PROGRAMS" folder beneath the 
"motion" source.

● The MCC editor is opened in the working area of the workbench. The start and end nodes 
are already pre-defined. You can start MCC programming.

Figure 8-30 MCC Chart "pos_axis" inserted

8.5.2.4 Using MCC command blocks
Every newly created MCC chart already contains a start and end node.

Figure 8-31 MCC chart, start/end nodes

You insert the MCC command blocks between these. The commands are processed in the 
direction from the start to the end node.

The MCC commands are available to you via:

● "MCC editor" toolbar

● "MCC Chart > Insert" menu command

● Context menu of the command block
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Using the MCC editor toolbar

Open the toolbar
The "MCC editor" toolbar becomes visible in the workbench as soon as you open an MCC 
chart.

The commands are arranged into command groups. 

① Command groups
② Basic commands
③ Program structures
④ Single axis commands

Note

If you do not see the toolbar, check that the display is switched on: Open the "View > Toolbars" 
menu. Select the checkbox for "MCC editor" in the "Toolbars" window.

Open the command group
Move the cursor across the colored buttons of the toolbar to fade in the command groups.

Figure 8-32 Open the command group

Keeping command groups open or closed continuously
Click the window title of a command group to keep the command group open continuously. 

Select Hide in the context menu of a command group to close the command group.

Placing the command group as required
Drag the toolbar or the command groups of the toolbar with the mouse to any location on the 
workbench.

Docking the toolbar
Drag the toolbar or the command groups of the toolbar with the mouse to the edge areas of 
the workbench to dock them there.
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Showing a tooltip for the command
Hold the mouse pointer briefly over a command button. The designation of the command is 
shown.

Inserting MCC editor commands into MCC chart
To insert an MCC editor command into the created MCC chart, proceed as follows:

1. Click in the active MCC chart on the connecting line between two commands, or click the 
command after which the new command is to be inserted.
The connecting line or the border of the command button is marked blue. The marking 
flashes.

2. On the "MCC editor" toolbar, select the command group. Click the desired command in the 
command group.

Result
The command was inserted into the chart and can now be parameterized.

8.5.2.5 Backing up the MCC program
To back up the MCC programs, proceed as follows:

On the toolbar, click the "Save project" or "Save project and compile changes" button.

As an alternative to the command "Save project and compile changes," you will find the 
command "Accept and compile" on the MCC editor toolbar. 

This command compiles the currently selected program as well as all other programs of the 
same unit. 

However, the command does not save the changes.

You thus have the option of accepting changes to a program into the project without having to 
save or compile the entire project again.

Additional references
For further information, refer to the SIMOTION MCC Motion Control Chart Programming and 
Operating Manual.

The "Getting Started section of the SIMOTION SCOUT TIA" online help contains a detailed 
description of a sample configuration.
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8.5.3 Use LAD/FBD

8.5.3.1 Overview

Program creation steps
Creation of a LAD/FBD program encompasses the following steps:

1. Creating an LAD/FBD unit.

2. Creating an LAD/FBD program in the LAD/FBD unit.

3. Inserting LAD/FBD commands in the LAD/FBD program and parameterizing the commands.

4. Saving and compiling the LAD/FBD program.
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8.5.3.2 Create LAD/FBD unit

Procedure 
In order to set up an LAD/FBD unit, proceed as follows:

1. In the project tree, under the SIMOTION device, open the "PROGRAMS" folder. 

2. Double-click  "Insert LAD/FBD unit." The "Insert LAD/FBD unit" window opens.

Figure 8-33 Insert LAD/FBD unit

3. Assign a name. In the example: "bg_out."

4. Go to the Compiler tab. Activate the "Permit program status" option for diagnostics 
purposes. In this way, you can monitor program execution later in online mode.

5. Confirm with "OK."
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Result
The LAD/FBD unit is created.

● The LAD/FBD unit "bg_out" appears in the "PROGRAMS" folder.

● In the working area of the workbench, the declaration table of the unit opens. The variables 
declared there apply within the LAD/FBD unit and can be linked in other units.

Figure 8-34 LAD/FBD unit "bg_out" inserted

8.5.3.3 Create LAD/FBD program

Procedure
In order to set up an LAD/FBD program, proceed as follows:

1. In the project tree, under the SIMOTION device, open the "PROGRAMS" folder.

2. Open the LAD/FBD unit "bg_out" in the "PROGRAMS" folder. 
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3. Double-click  "Insert LAD/FBD program." The "Insert LAD/FBD program" window opens.

Figure 8-35 Insert LAD/FBD program

4. Assign a name. In the example: "LAD_1." The name must be unique throughout the project.

5. For the creation type, select "Program."

6. Confirm with "OK."
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Result
The LAD/FBD program "LAD_1" is created in the project.

● The LAD/FBD program appears in the "PROGRAMS" folder.

● The LAD/FBD editor is opened in the working area of the workbench. You can start 
programming.

Figure 8-36 LAD/FBD program "LAD_1" inserted

8.5.3.4 Using the LAD/FBD toolbar

Opening the LAD/FBD toolbar
The LAD/FBD toolbar becomes visible in the workbench as soon as you open an LAD/FBD 
program.

Move the cursor across the active buttons of the toolbar to have the functions displayed.

Note

If you do not see the toolbar, check if the display is switched on: Open the "View > Toolbars" 
menu. In the "Toolbars" window, select the checkbox for "LAD/FBD toolbar."

Switching the programming language
SIMOTION SCOUT TIA allows simple switching between ladder logic and function block 
diagram. The LAD/FBD editor contains the command "LAD/FBD program > Switch to FBD" or 
"Switch to LAD." 
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8.5.3.5 Backing up the LAD/FBD program

Procedure
In order to back up an LAD/FBD program, proceed as follows: 

On the toolbar, click the "Save project" or "Save project and compile changes" button.

As an alternative to the command "Save project and compile changes," you will find the 
command "Accept and compile" on the "LAD/FBD Toolbar." 

This command compiles the currently selected program as well as all other programs of the 
same unit. 

However, the command does not save the changes.

You thus have the option of accepting changes to a program into the project without having to 
save or compile the entire project again.

Additional references
For further information, refer to the online help and SIMOTION LAD/FBD Programming and 
Operating Manual.

The "Getting Started section of the SIMOTION SCOUT TIA" online help contains a detailed 
description of a sample configuration.

8.5.4 Other programming languages

Additional references
Further information on the programming languages can be found in the online help of 
SIMOTION SCOUT TIA and in the SIMOTION ST Structured Text Programming and Operating 
Manual.

8.6 Configure execution system
Execution levels define the chronological sequence of tasks in the execution system. A level 
can contain several tasks. The tasks provide the framework for program execution. A task may 
comprise several programs. By assigning the created programs to the tasks, you can, for 
example, define the priority, the time frame or order in which the programs are to be executed.
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Assigning programs to tasks
To assign tasks in the execution system programs, follow these steps:

1. In the project tree, under the SIMOTION device, double-click  "EXECUTION SYSTEM."
The "EXECUTION SYSTEM" window appears on the working area.

2. Assign the required program to the preferred task. In the sample MCC program, 
"motion.pos_axis" and "MotionTask_1" task.

– Select the "ExecutionLevels > OperationLevels > MotionTasks > MotionTask_1" branch 
in the tree of the execution system.

Figure 8-37 Execution system, tree view of the execution levels and tasks

The "MotionTasks" window appears on the right of the working area. On the "Program 
assignment" tab, under "Programs," the programs "pos_axis" and "KOP_1" and the 
programs of the source "fault" are visible.
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– Select the MCC program "motion.pos_axis" and click the ">>" button. The program is 
displayed under "Programs used." Thus, the "MotionTask_1" task is assigned.

Figure 8-38 Execution system, MotionTasks window

The assignment is visible in the tree of the execution system. The "motion.pos_axis" 
program appears below the "MotionTask_1" branch.

Figure 8-39 Execution system, MotionTask_1 with assigned pos_axis program

– On the the "Task configuration" tab, select the "Activation after StartupTask" checkbox. 
This executes the MCC program immediately after the SIMOTION device is started. If 
this checkbox has not been activated, the program must be explicitly called and started 
from another program which is assigned to the StartupTask or another active task.

3. Assign the LAD program "bg_out.kop_1" to the task "BackgroundTask":

– In the tree of the execution system, select the branch "ExecutionLevels > 
OperationLevels > BackgroundTask." Assign the LAD program "bg_out.kop_1" to this 
task.
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4. Assign the fault handling routines:

– In the tree of the execution system, select the branch "ExecutionLevels > 
OperationLevels > SystemInterruptTasks > TechnologicalFaultTask." Assign the MCC 
program "fault.technology_fault" to this task.

– In the tree of the execution system, select the "ExecutionLevels > OperationLevels > 
SystemInterruptTasks > PeripheralFaultTask" branch. Assign the MCC program 
"fault.peripheral_fault" to this task.

5. Click the "Close" button. Confirm with "Yes" if you are prompted to save.

Result
The execution system is configured.

Loading the configured execution system to the target system
Save and compile the changes, go online and load the configured execution system into the 
target system.

8.7 Controlling the target system

8.7.1 RUN and STOP operating states

Operating conditions
In the "Control Operating Mode" dialog box of SIMOTION SCOUT TIA, you can switch a 
SIMOTION CPU to the RUN or STOP mode.

RUN operating state
SIMOTION executes the user program and the associated system services:

● Reading process image of inputs

● Execution of the user programs assigned to the execution system

● Writing process image of outputs

The technology packages are active in this status. They can execute commands from the user 
program.

STOP mode
SIMOTION does not process a user program.

● It is possible to load a complete user program.

● All system services (communication, etc.) are active.
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● The I/O modules are in a safe state. This means, for example, that digital outputs are "LOW" 
and analog outputs are de-energized or at zero current.

● The technology packages are inactive, i.e. all releases are deleted. No axis motions can 
be executed.

Additional references
Detailed information about operational states can be found in the section "SIMOTION device: 
Operating mode" in the online help of SIMOTION SCOUT TIA.

8.7.2 Control operating mode

WARNING

Danger to life through unexpected machine movement

If the operating state is not switched under controlled conditions, this may endanger the safety 
of personnel and the machine.
● Observe the safety regulations before you control a SIMOTION device via the mode 

selector switch in SIMOTION SCOUT TIA.

Switching SIMOTION devices to RUN or STOP mode
To control the operating mode, proceed as follows:

1. Open the "Control Operating State" dialog box:
Select "Target system > Control operating state" in the menu. Or click on the icon "Control 
Operating State" on the toolbar.

The call is possible if at least one CPU of the project is in online mode.

2. In the "Control Operating State" dialog box, select the desired operating state "RUN" or 
"STOP" for the displayed devices. To do so, click the assigned button.

3. The "State" field reports whether it was possible to change the operating state.
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Control Operating State dialog
The dialog shows the operating state of all configured CPUs. The display can be filtered. The 
change of operating mode is possible per device, or for several devices simultaneously.

Figure 8-40 STOP mode

Note

As of Version 4.4, the "Control Operating State" dialog box represents all configured 
SIMOTION devices. The previous dialog had to be opened individually for each CPU. 

Overall reset is possible in the dialog as before. You will find additional information about overall 
reset in the section Overall reset (Page 264).

The SIMOTION P State tool is retained unchanged.

Listed devices
The "Target device" column shows the names of the CPUs available in the project. The order 
corresponds to the order of the CPUs in the project navigator.

Offline/online distinction
If a CPU is in offline mode, the name of the CPU and all other assigned elements are grayed 
out in the table line. 

The checkbox is always open for input.

Filter
The list of the CPUs can be filtered using the following criteria:

● Selection by checkbox

● Name, or part of the name, of the CPU

● CPU in online mode
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Filtering the display using checkboxes
The display can be restricted to CPUs that are activated in the checkbox columns. The field 
in the header of the checkbox column provides a choice of the following filter values.

Table 8-1 Filter values in the checkbox column

Filter value Filter result
All All CPUs are displayed, regardless of whether a checkbox is marked or not.
Set Only CPUs with a set check mark are displayed.
Not Set Only CPUs without a set check mark are displayed.

If the dialog box is called from the shortcut menu of a CPU, this CPU is automatically 
preselected ("Shortcut menu > Target device > Operating state").

All CPUs can be selected or deselected with the checkbox in the header.

Filtering the display by operating state or CPU name
The selection field in the header of the "Target device" column offers the following filter values:

Table 8-2 Filter values in the Target device column

Filter value Filter result
All All CPUs are displayed, regardless of whether they are in online or offline 

mode
Online Only CPUs that are in online mode are displayed.
User-definable The field can be edited, thus enabling filtering according to parts of names. 

Up to 5 user-defined filters remain for selection.
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Operating conditions
State column: shows the state of the CPUs in text form and via static LEDs.

Table 8-3 Operating states of a SIMOTION device

Operating mode Description
Text LED
STOP

(orange)

● Technology objects inactive (enables deleted, no axis 
motion)

● User program is not executed
● Loading a user program is possible
● All system services are active (communication, etc.)
● All analog and digital outputs set to "0"
● The I/O modules (signal modules) are in the safe state 

(SIMOTION D)
STOP U

(orange/white)

● Technology objects active
● Technology objects can execute jobs for test and 

commissioning functions
● Otherwise identical to STOP mode
● STOP U means stop user program
● User program is not executed

RUN

(green)

● Technology objects active
● Execution of the user programs assigned to the execution 

system
● Loading a user program is possible
● The process image of the inputs and outputs is read or 

written
STOP

(orange/white)

● All tasks shut down, operating system stopped, real-time 
clock continues to run

STARTUP

(orange/white)

● The display only appears if the state persists longer than 
1 second, or in the event of a fault

SERVICE 

(orange/white)

● Display, e.g. if master control has been fetched via the axis 
control panel

SHUTDOWN

(orange/white)

● Display appears only if the state persists for longer than 
1 second.

(empty) (empty) ● CPU is in offline mode
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Control operating mode
A CPU can be switched to the designated operating state with the RUN and STOP switches. 
The switching options are dependent on the position of the mode selector switch on the 
SIMOTION device. The setting on the device takes priority.

Table 8-4 Switching options of the software switch dependent on the position of the mode selector 
switch on the SIMOTION device.

Mode selector switch position of the SIMO‐
TION device

Switching option in the SCOUT dialog box "Control Oper‐
ating State"

STOP STOP
STOP U STOP
RUN RUN, STOP
MRES STOP

Note

As of V4.4, manual switching to the "STOP U" operating state is no longer possible in the 
"Control Operating State" dialog box of SCOUT.

If a CPU is in offline mode, both the RUN and STOP buttons are deactivated.

Simultaneous control of several CPUs
CPUs that are in online mode and that are selected in the filter column can be switched 
simultaneously to the RUN or STOP operating state. To do so, click the RUN or STOP switch 
below the list.

Observe that the switches only switch the CPUs that are visible in the dialog. For this reason, 
verify the effect of the name filter in the "Target device" column.

Error messages
A CPU that can no longer assume the required state is indicated in color. The "State" cell 
changes to red or yellow/orange.

● Red: Fault

● Yellow/orange: Note

A single click on the corresponding cell causes an error text or information text to appear in a 
roll-out tip.
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Figure 8-41 Roll-out tip with error description
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Priority of the mode selector switch on the SIMOTION device
The setting of the mode selector switch on the SIMOTION device has priority. SIMOTION 
SCOUT TIA can switch a SIMOTION device to the RUN operating mode only if the mode 
selector on the device is set to "0" or "RUN." 

● SIMOTION D
You can find the mode selector switch of the D410-2 and D4x5-2 in the lower area of the 
front behind the blanking cover.

Figure 8-42  D410-2 and D4x5-2, mode selector switch, switch position 0 (RUN)

● SIMOTION C

Figure 8-43 SIMOTION C240 module front

Additional references

For detailed information refer to the device and commissioning manuals of the SIMOTION 
device, and the online help of SIMOTION SCOUT TIA.
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8.7.3 Overall reset

Precondition
The SIMOTION device for which overall reset is to be performed must be online.

Procedure
To execute an overall reset, proceed as follows:

1. Open the "Control Operating State" dialog box. Select the "Target system > Control 
operating state" menu command. Or click "Control Operating State" on the toolbar.

The call is possible if at least one CPU of the project is in online mode.

2. Switch the SIMOTION device for which overall reset is to be performed to "STOP" in the 
"Control Operating State" dialog box.

3. Select the SIMOTION device under "Overall reset (MRES)." Click the "Execute" button. 
Confirm the command by clicking "Yes." 

Result
The memory reset will now be performed.

See also
Control operating mode (Page 257)

8.8 Know-how protection

Know-how protection

The know-how protection in SIMOTION SCOUT TIA prevents unauthorized viewing and editing 
of your programs or parameters directly in the drive unit. A distinction is made between two 
types of know-how protection:

● Know-how protection for programs

● Know-how protection for drive units (SINAMICS V4.5 and above)
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Note
Write protection for drive units

In addition to the know-how protection, write protection can be set up for drive units.

See also
Know-how protection for programs (Page 265)

Know-how protection for drive units (Page 268)

Write protection for drive unit (Page 270)

8.8.1 Know-how protection for programs
The know-how protection is used to protect the programs and libraries in your project. With 
the Know-how protection activated, unauthorized viewing and editing of your programs is 
prevented. 

Note

If a program is copied using copy and paste, the copied program also remains locked. A 
program retains its know-how protection even when it is imported or exported.

Setting up a password
By specifying a login and password, the know-how protection is activated for the program. The 
programs included in the project are visible to the user in the project navigator, but the programs 
are grayed out and locked. Only by entering the password can you remove the lock and open 
the program for editing.
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Procedure
To set up a password, proceed as follows:

1. Select "Project > Know-how protection > Edit default login..." in the menu.
The "Edit default login" dialog box opens.

Figure 8-44 Setting up know-how protection password

2. Select the login and specify a password.

Note

The set default login remains valid for the whole project until it is deleted or SIMOTION SCOUT 
TIA is closed.

Configuring know-how protection
To configure the password security level, proceed as follows:

1. Select "Project > Know-how protection > Configure" in the menu.
The "Configure Know-how Protection for Programs" dialog box opens.

Figure 8-45 Configuring know-how protection

2. Select the required security level for programs and libraries. 
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Additional references
For detailed information, refer to the "Know-how protection" section in the online help of 
SIMOTION SCOUT TIA.

8.8.2 Activating/ deactivating know-how protection

Activate know-how protection
Proceed as follows to activate know-how protection for programs:

1. Open the project and, in the project navigator, select the "PROGRAMS" folder or a program, 
depending on whether you want to set know-how protection for all programs or for selected 
individual programs.

2. Right-click to open the context menu and choose "Know-how protection > Set".

Figure 8-46 Set know-how protection

Result
The selected programs are protected and then locked. Protected programs are identified in 
the project navigator symbolically by a lock. 

Figure 8-47 Result: Programs are protected
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Only by entering the password can you remove the lock and open the program.

Deactivating know-how protection
Proceed as follows to deactivate know-how protection for programs:

1. Open the project and, in the project tree, select the "PROGRAMS" folder or the program, 
depending on whether you want to deactivate the know-how protection for all or only for 
specific programs.

2. In the context menu, right click "Know-how protection > Delete".

Result
The know-how protection for all programs or for the selected individual programs will be 
deleted.

Search in know-how-protected sources
If you have set know-how protection on sources, these are no longer included in the search. 
A search is only possible if you open the source in the appropriate editor or if you remove know-
how protection again.

Note

In ST source files, MCC charts and LAD/FBD programs, you can protect all programs in one 
action by setting the know-how protection directly in the "PROGRAMS" folder. 

8.8.3 Know-how protection for drive units
The Drive unit know-how protection only applies online and is used to protect intellectual 
property, in particular, the know-how of machine manufacturers, against unauthorized use or 
reproduction of their products.
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Activating know-how protection for a drive unit
Proceed as follows to activate the know-how protection for the drive unit:

1. Open the project, and in the project navigator, select the drive unit that you want to equip 
with know-how protection.

2. In the context menu, right click the "Drive unit know-how protection > Activate ...".
The Activate Know-how Protection for Drive Unit dialog opens.

Figure 8-48 Know-how protection for drive unit

3. Specify whether the know-how protection should be set with or without copy protection.

4. Activate "Copy RAM to ROM" if the know-how protection is to be maintained permanently.

5. To set a password, click the "Set" button.
The "Know-how protection for the drive unit - assign password" dialog opens.

6. Set a password and confirm with "OK" to close the dialog.

7. Confirm with "OK" to activate the know-how protection for the drive unit.
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Deactivating know-how protection for a drive unit
Proceed as follows to deactivate the know-how protection of the drive unit:

1. Open the project, and in the project navigator, select the drive unit whose know-how 
protection you want to deactivate.

2. In the context menu, right click the "Drive unit know-how protection > Deactivate ...".
The Deactivate Know-how Protection for Drive Unit dialog opens.

Figure 8-49 Deactivating know-how protection for a drive unit

3. Specify whether the know-how protection should be temporarily deactivated, i.e. you can 
reactivate the know-how protection from the context menu, or whether the know-how 
protection should be deleted permanently.
For temporary deactivation, you can activate the know-how protection from the context 
menu. Copying from RAM to ROM is not possible here.

4. Enter the password and confirm with "OK".

Additional references
For detailed information, refer to the "Know-how protection" section in the online help of 
SIMOTION SCOUT TIA.

8.9 Write protection for drive unit

8.9.1 Drive unit with activated write protection
SINAMICS V4.5 version and above provides write protection for drive units. You can only 
activate/ deactivate this write protection in online mode.

The write protection applies only online and is used for protection against accidental changes 
by the user. When write protection is set, p parameters can be read, but not written.

Activate/ deactivate the write protection via the context menu "Write protection for drive unit" 
of the drive unit or via parameter p7761 of the expert list. A password is not required to activate/ 
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deactivate the write protection. You can query the status of the write protection via parameter 
r7760.0 in the expert list (value = 0 means that the write protection is not set). 

Note
Permanent write protection

If you want to activate the write protection permanently, execute the "Copy RAM to ROM" 
function.

Features for drive units with activated write protection
Note the following restrictions for activated write protection of drive units:

● The write protection for drive unit always applies to the device, not to individual drive objects.

● Write protection only applies online.

● All r parameters can still be read and are visible as usual.

● All p parameters can be read, but not written. p parameters are displayed hatched.

● Parameters with the WRITE_NO_LOCK attribute can be written despite the write protection. 

The following functions are available even when write protection is activated for the drive units:

● Restoring factory settings

● Upload

● Acknowledging alarms

● Control panel

● Trace

● Function generator

● Measuring functions

● Reading out the diagnostic buffer

Note
Restoring factory settings

You can restore the factory settings via the expert list (parameters p9, p976). 

The following functions are not available when write protection for drive unit is activated:

● Download

● Automatic controller setting

● Stationary/rotating measurement

● Delete fault buffer (p952 must not be defined as an exception parameter)

● Delete drive unit completely or individual components thereof

● Rename drive unit
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8.9.2 Activating/deactivating write protection for drive unit

Activate write protection
Proceed as follows to activate the Drive unit write protection:

1. Connect to the target device online.

2. Select the drive unit that is to be provided with write protection from the project navigator.

3. Right click the drive unit and select "Drive unit write protection > Activate" in the context 
menu.

Result
Write protection has been activated.

Copy RAM to ROM
You can select whether the write protection for drive unit is to be set permanently by activating 
"Copy RAM to ROM."

Deactivating write protection
Proceed as follows to deactivate the Drive unit write protection:

1. Connect to the target device online.

2. In the project tree, select the drive unit, whose write protection you want to remove.

3. Right click the drive unit and select "Drive unit write protection > Deactivate" in the context 
menu.

Result
Write protection has been deactivated.

Note

You can activate and deactivate the Drive unit write protection also directly in the expert list 
via the parameter p7761. No password is required to modify the parameter p7761. Similarly, 
you can activate and deactivate the Drive unit write protection via script.

Additional references
For detailed information, refer to the "Drive unit write protection" section in the online help of 
SIMOTION SCOUT TIA.
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8.10 Exporting OPC data

8.10.1 Overview
The OPC interface (OLE for Process Control) is the specification of a common, manufacturer 
independent software interface based on OLE (Object Linking and Embedding). It has been 
designed as an industry standard by leading automation companies with the support of the 
Microsoft Corporation. 

Up to now, applications that accessed process data depended on manufacturer-specific 
interfaces. With the standardized OPC interface, you can now access process data uniformly 
via the OPC interface when using, for example, operation and monitoring software.

For OPC data export, the following symbols are exported in the symbol file:
● System tags of the device and the technology objects

● Global device user tags

● Symbolic I/O tags

● Interface tags of user programs (ST source file, MCC, LAD/FBD)

Note

In the interface area of a program, a maximum of 64 KB data can be addressed for operator 
control and monitoring. Data beyond this area get lost during the export.

In addition, the following data can be exported for OPC Alarm/Event:
● Configured alarms (Alarm_S/Q)

● Alarms from technology objects (technology object alarms)

● All messages/alarms from the diagnostics buffer

The data is saved as an XML file in the selected target directory (OPC_AE.xml).
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8.10.2 Exporting OPC data

Procedure
Proceed as follows to export the OPC data:

1. In SIMOTION SCOUT TIA, select "Options > Exporting OPC data..." on the menu bar. 
The "Setting the data for export" dialog opens.

Figure 8-50 Exporting OPC data

2. Select the intended use of the data to be exported and confirm with OK. 
The "Exporting OPC data" dialog opens.

3. Select a target directory and confirm with "OK."

4. If several interfaces with different bus addresses are available on the device, you must also 
select the protocol (PROFIBUS or TCP/IP) and the interface for the export. The 
"Parameterize interfaces" dialog appears. If the interfaces possess the same bus 
addresses or only one is being used, this dialog will not be displayed. Select the interface 
and protocol and confirm with "OK." An interface must be selected for all SIMOTION devices 
in the project. Repeat this step as often as necessary.
The export is started. A successful export is indicated in the "Exporting OPC data status 
display" tab in the detail view.

5. If the SIMOTION devices are distributed across multiple subnets and you want to address 
a SIMOTION device with a SIMATIC OPC server via a router, you must configure this router 
again in a window after the file export in SIMOTION SCOUT TIA. If you do not want to use 
a router, confirm the dialog with "No".
The following is displayed in the "OPC routing information for HMI devices" window:

– All configured networks

– All SIMOTION devices contained in the project

6. Select the subnet (location) of the OPC Server.
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7. Select the network station and then the first router for each network station to be addressed 
via the OPC Server in the displayed window.

8. Confirm with "OK."

8.10.3 Setting the data to be exported

Note

OPC data can only be exported if a project is open. The export is possible both in offline and 
online modes.

Note
Default export setting

The latest version is set as default for the OPC export. The OPC server can use the format 
"*.ati" for SIMATIC Net V8.1.1 version and above and SIMOTION SCOUT TIA V4.4 version 
and above. 

The data to be exported is selected in this window.   

The following parameters can be selected:

Field/button Meaning/information
Exports data for SIMATIC 
NET OPC

 

SIMATIC NET versions Select the SIMATIC NET version for which the export data is to be used. Different versions 
are not fully compatible.
The SIMATIC NET >= V8.1.1 (.ati) Export is the fastest export version. The symbol file to be 
exported is first configured in the main memory and then exported. For this operation, you 
require sufficient main memory for the number of symbols. Before the export is started, the 
maximum number of symbols that can be exported is displayed. Check first whether the max‐
imum possible number of symbols is greater than the number of symbols in your export.

 Scope  
  Global export Under "Global export", activate the data (control data, drive data) that you want to export. All 

the required tags of the controller (SIMOTION CPU) are exported with the control data.
Only drive data of drives of the SINAMICS family can be exported. Whereby the drive must 
be inserted below a SIMOTION CPU. The export of data of single drives and drives below a 
SIMATIC CPU is not possible.
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Field/button Meaning/information
  Selective export Activate "Selective export" if you only want to export specific tags. You must first have compiled 

these tags in watch tables in SIMOTION SCOUT TIA. In the selection list, you can then select 
the watch table whose tags are to be exported.
A selective export is only possible when you have inserted watch tables in the project. You 
can create watch tables in the project tree by clicking "Insert watch table" in the "MONITOR‐
ING" folder.
The drive parameters are copied into the watch table using the expert list of the associated 
drive object.

 Options  
  OPC data Activate OPC data if the symbol names and tag names are to be exported from the current 

SIMOTION project. If the checkbox is deactivated, no data is exported.
   Arrays with single el‐

ements
Activate the option if the arrays' single elements are to be exported with them. If the option is 
deactivated, only the first address of the array is exported and the data export can be shortened 
and the data volume reduced.

  OPC alarm/event Activate OPC alarm/event when you want to export the configured alarms and alarm texts. All 
existing languages of the alarms are exported to the file. If the checkbox is deactivated, no 
alarms are exported.

8.10.4 OPC export - OPC data
The target directory is defined in the Project export window. 

You can set the following parameters:

Field/button Meaning/information
Export settings  
Enter a target directory for 
the export

Specifies the target directory for the export files.
To select a target directory:
1. Click Browse to the right of the text box. A window is opened.
2. Specify a target directory.
3. Select "Open" to confirm. The window closes and your selection is displayed in the text 

box.
Project path The path of the currently opened project is displayed here. The symbol name of the current 

project is exported as a file or files.

8.10.5 Exporting OPC data, ati export (main memory)

SIMATIC NET >= V8.1.1 (.ati) export
The SIMATIC NET >= V8.1.1 (.ati) export is faster than the old versions of the OPC export. 
However, it requires more main memory as the symbol file must be configured in the main 
memory. For this operation, you require sufficient main memory for the number of symbols.
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Therefore, at the start of the export, a calculation is made as to how many symbols can be 
exported with the available main memory. Check first whether the maximum possible number 
of symbols is greater than the number of symbols in your export. If the calculated number is 
not sufficient for the export of the project data, then you still have to use the other export 
versions, e.g. SIMATIC NET V7.0/V7.1.   

8.10.6 Assigning the connection parameters
Assign the parameters for the connection in this window.  

The following parameters can be selected:

Field/button Meaning/information
Device The device for which you must select the protocol and the interface is displayed here. You must 

specify the interface settings for each device in the project. You must specify these settings in this 
window depending on the number of devices.

Connection name With V4.3, it is possible to use device names that do not satisfy the ST conventions. If the name of 
the device violates these conventions, a name valid for the OPC export is displayed at "Connection 
name". The following is modified in the name:
● Invalid characters are replaced by a "_".
● If the first character is not a letter, an "A" is set as prefix.
● A number (_<n>) is added at the end, if not already available, so that the connection name is 

unique.
You can rename the name modified in this way. Since the connection name and the device name 
may be different, the device/connection assignment is also exported in a file (OPC_device_connec‐
tion.dat).

Protocol Selects the transmission protocol for the SIMOTION device.
PROFIBUS
Protocol for PROFIBUS
TCP/IP
Protocol for Ethernet

Interface Use "Interface" to select the interface for the symbol names to be exported. The SIMOTION device 
is addressed via this interface from the HMI software. Each symbol name must be uniquely assignable 
to a hardware address (bus address). This assignment is set via the "Interface" selection.
Caution:
If the interface is parameterized for isochronous bus cycle, then it must not be used for an OP.

8.10.7 OPC routing information (routers)
If the SIMOTION devices are distributed across multiple subnets and you want to address a 
SIMOTION device with a SIMATIC OPC server via a router, you must configure this router 
again in a dialog after the file export in SIMOTION SCOUT TIA.

In the "OPC routing information for HMI devices" dialog , the following is displayed:

● All configured networks

● All SIMOTION devices contained in the project
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First select a location of the OPC Server and then the first router for each node to be addressed 
via the OPC Server.   

Several projects interconnected
To communicate with the SIMOTION devices in a network interconnection through several 
projects, the SIMATIC NET OPC Server must be forwarded the following files and items of 
information:

● "OPC Alarm/Event" files, which may originate from several SIMOTION SCOUT TIA projects

● Time zones

● Router

An auxiliary program, "SIMOTION OPC File Manager", enables you to configure this data for 
the SIMATIC NET OPC Server.

8.10.8 Exporting OPC data, status display
The status is displayed in the "Export OPC data status display" tab in the detail view during 
the export. 

The following information can be displayed during export:

Information displayed Meaning/information
Error messages Error messages are displayed in plain text if export fails. 

Some possible errors:
● SIMATIC NET OPC is not installed.
● Export file with symbol names already exists and is being used by another 

application.
Location and name of the exported data Displays the storage location of the exported files after the symbol names have 

been successfully exported.
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8.11 Licensing of the runtime components

8.11.1 Licensing of the runtime components

8.11.1.1 Overview for the licensing

Licensing of the technology functions
Functions can be licensed using the following software options:   

● Motion control technology functions
The licensing is performed axis-specifically for:

– POS; use of the technology functions for positioning axis

– GEAR; use of the technology functions for following axis and path axis

– CAM; use of the technology functions for cam axis

The GEAR technology function contains the POS technology function, while the CAM 
technology function contains the POS and GEAR technology functions.

The MultiAxes package permits a simple licensing of the Motion Control technology functions. 
It contains the license for the unlimited use of the POS/GEAR/CAM technology function on a 
SIMOTION device, e.g. a D4x5-2.

● TControl technology function
The use of the TControl technology package functions is licensed on a channel-specific 
basis in packages of eight temperature channels.

Note

For SIMOTION C and D, licenses for runtime software can also be ordered as pre-installed 
software (by order code/Z option) on memory card.

Additional references
You will find information on further licensed technology functions and detailed information on 
licensing the runtime software and the order data under: 

● SIMOTION, SINAMICS S120 & SIMOTICS, equipment for production machines, PM 21 
catalog

● PM 21 catalog, section titled SIMOTION runtime software

● Configurator for SIMOTION Runtime Licenses in the A&D Mall 
(http://mall.automation.siemens.com)
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8.11.1.2 Licenses and license key 
Depending on the type and number of runtime components used in the project, licenses must 
be acquired as part of the licensing procedure for SIMOTION. The licenses required for a 
SIMOTION device are assigned to a license key. This license key is stored on the storage 
medium of the SIMOTION device during the licensing procedure.   

There are two ways of ordering licenses:

● Preinstalled licenses
The license key is already stored on the card.

● Ordered licenses (Certificate of License)
These licenses must be assigned to the storage medium using the Web License Manager. 
The Web License Manager can be found on the Internet under: 
Web License Manager (https://workplace.automation.siemens.com/pls/swl-pub/
SWL_MAIN_MENU.NAVIGATION_HEAD?a_lang_id=E&a_action=)
The license key is transferred to the hardware with SIMOTION SCOUT TIA.

You require the following information to obtain the license key:

● The serial number of the SIMOTION device memory medium
You can obtain the serial number from the memory medium or have it displayed online in 
the SIMOTION SCOUT TIA (licensing wizard).

● The serial number of the CoL (Certificate of License)
You have this number on paper.

Table 8-5 The serial number on the SIMOTION hardware assigned to the SIMOTION device

SIMOTION device Hardware serial number of the module
SIMOTION C2xx SIMOTION Micro Memory card
SIMOTION D SIMOTION Compact Flash card

License keys can be generated separately from the licensing.

Note

When the SIMOTION memory card is deleted or formatted, the licensing data is also deleted. 
Archive the licensing data in order to be able to transfer it again to the memory medium in such 
a case. If the data is not backed up, you have to perform the licensing again. You can display 
the entered license key in the Web License Manager.

You will find additional information in the section: License key delete protection (Page 283).

8.11.1.3 Determining licensing requirements

License requirement
Determine your license requirement only if you have completed the configuration, and before 
you load it into the target device! Before you begin, the project must have been saved and 
compiled. 

If you have not acquired any licenses yet, under-licensing is displayed.  
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You can determine the licenses in the following ways:

● Offline mode with open project
The required licenses are displayed.

● Online mode with open project
A comparison of the required and actual licenses is displayed.

● Online mode without project
The actual licenses of the selected SIMOTION device are displayed.

Procedure
1. Select the SIMOTION device in the project tree.

2. Select "Licenses" in the shortcut menu.
The required licenses for the project or a comparison of required and actual licenses are 
displayed.

3. You can close the window with "X" or continue with "Perform licensing...".

The license check, i.e. the inspection of the license key, is carried out in the target system. 
Possible responses in the case of under-licensing can be found in Chapter Underlicensing 
(Page 283).

Memory cards can be purchased with integrated runtime licenses, which do not require 
separate licensing.

Note

A license which has already had a License Key allocated can no longer be taken.

It is possible, however, to add licenses to an already generated license key.

8.11.1.4 Display the available licenses of the SIMOTION device

Displaying via accessible nodes
You can use the list of Accessible nodes to determine the specific licenses that have already 
been assigned to the SIMOTION device. You can access the data of the SIMOTION device 
directly. 

Note

This step is not necessary if the required and actual licenses are displayed within a project.

Preconditions
● SIMOTION SCOUT TIA has been started.

● SIMOTION SCOUT TIA is in online mode.
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Procedure
1. Select the menu "Project" > "Accessible nodes". 

The list of accessible nodes is displayed in the working area.

2. Select the relevant SIMOTION device.

3. Select "Licenses" in the context menu.
The Licenses dialog box appears, showing the actual licenses for the selected SIMOTION 
device.

4. You can close the window with "X" or continue with "Perform licensing...".

8.11.1.5 Performing the licensing
If there are no pre-installed licenses, you can acquire the licenses you need and then generate 
the license key required.   

Preconditions
Licensing is subject to the following preconditions:

● The configuration has been completed.

● The project has been saved and compiled.

● The required licenses have been determined.

● The license key has been determined or the serial numbers of the memory medium and 
the CoL are available.

● SIMOTION SCOUT TIA is in online mode.

Procedure
Proceed as follows to perform licensing:

1. Select the relevant SIMOTION device in SIMOTION SCOUT TIA.

2. Open the shortcut menu and click "Licensing".

3. In the Licenses dialog box, click "Perform licensing...". 
If the "Use wizard" checkbox is activated, a wizard guides you through the licensing 
procedure.
If the checkbox is not activated, the window for expert licensing opens. You can enter the 
license key there without running through the wizard.
If you have not yet generated the license key, the wizard gives you the option of switching 
to the Web tool to generate a license key. Then return to the wizard.

4. If you have an online connection, continue with item 5. 
Otherwise, you can establish an online connection with "Online" in the (Step 2 of 3) window.
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5. Enter the license key in the (Step 3 of 3) window.

6. Click "Finish".
The wizard closes. Licensing is complete.

Note

The license key is written to the retentive memory when the project data is transferred to 
the target system.

8.11.2 Changing the license key
Through changes in the project, such as through the inclusion of an additional axis, the license 
key for the project can lose its validity. This is why under-licensing is displayed when the project 
is downloaded and the SF LED flashes at 0.5 Hz.

After you have determined the actual requirement and purchased the necessary licenses, 
generate the license key again. Now replace the license key already entered with the newly 
generated one.

8.11.3 Licensing during hardware replacement
For the replacement of licensed SIMOTION components (MMC, CF, etc.), the associated 
license key must be assigned to the new SIMOTION component. In this case, contact the 
Customer Support for assistance. 

8.11.4 License key delete protection
The license key is stored in the "KEYS" directory on the SIMOTION Memory Card.

When the controller starts up for the first time, the license key will be saved in the boot sector 
of the card and from this time is protected from being lost.

Deleting the license key in the boot sector through user operation is not possible, also not by 
formatting the card or by using the "Write boot sector..." function.

If the license key is no longer present on the card, it will be written again during the startup 
from the boot sector into the "KEYS" directory. This means that the system will repair any 
deletion on the "Key" file.

The license key can be changed at any time, for example, by relicensing. At the next startup, 
the license key will be saved again in the boot sector.

8.11.5 Underlicensing
If SIMOTION SCOUT TIA detects the presence of under-licensing during license verification, 
an entry is made in the diagnostics buffer. The verification is repeated every hour, and an entry 
is made in the diagnostics buffer each time under-licensing is detected.    
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The following information can be read from the diagnostics buffer entry:

● Number of required licenses

● Number of actual licenses

● Operating mode

As an additional warning signal, the SF LED flashes at 0.5 Hz as long as under-licensing is 
present on the system. Underlicensing will only be displayed if no acknowledgeable 
technological event is pending, as the same SF LED is used to indicate this as well.

See also
Determining licensing requirements (Page 280)
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Service and diagnostics 9
9.1 Diagnostic functions in SIMOTION SCOUT TIA

There are extensive diagnostic capabilities in the online mode within the 
SIMOTION SCOUT TIA for the operation of SIMOTION devices. These diagnostic options are 
summarized in the diagnostics overview:

● The diagnostics overview is a tab in the detail view and is available by default in the online 
mode. You can call up detailed displays from here.

● An "Alarms" tab is also available in the detail view. This provides a tabular overview of

– Technological alarms (from technology objects)

– Alarm_S messages (from user programs)
The alarms can be acknowledged either individually or all together.

● The "Address list" tab in the detail area offers extended functions in terms of I/O diagnostics 
and hardware availability. 

● With the device diagnostics, you determine extensive diagnostic information (e.g. 
diagnostics buffer, system utilization, task status, etc.).

● You can record signal charts with the trace tool. The values of system tags can be recorded 
during runtime for diagnostic purposes.

● Program testing and debugging, e.g. modify variable, program status, breakpoints.

● Back up diagnostic data including non-volatile data (retain data) to CompactFlash card (for 
SIMOTION D) or MMC (for SIMOTION C).

● Back up the HTML pages, including the current contents for diagnostic purposes, on the 
CF card or MMC.

● Restore backed up non-volatile data (retain data).
Further information can be found in the FAQ section on the Utilities & Applications DVD 
under: FAQs > Engineering > Backing up diagnostic data and non-volatile data
SIMOTION IT also offers comprehensive diagnostic options that can be easily accessed 
via an Internet browser.

Additional references
Detailed information can be found in:

● SIMOTION ST Structured Text Programming and Operating Manual

● SIMOTION MCC Motion Control Chart Programming and Operating Manual

● SIMOTION LAD/FBD Programming and Operating Manual

● Diagnostics Manual: SIMOTION IT Ethernet-based HMI and Diagnostic Function

● SIMOTION SCOUT TIA Online Help
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9.2 Using the diagnostics overview
The diagnostics overview is available as a tab in the detail view when the project is in online 
mode. 

● In the detail view, select the "Diagnostics overview" tab.

Figure 9-1 Diagnostics overview in the detail view (online mode)

The following are displayed for each accessible SIMOTION device:

● Operating mode

● Memory used (absolute and percentage display)
RAM disk, RAM, memory card, retentive data

● CPU utilization (percentage display)

The drive units are also displayed. To obtain a detailed display of the individual devices, open 
the device diagnostics.

9.3 Device diagnostics
In online mode, the device diagnostics function enables you to obtain a comprehensive display 
of diagnostics results of the individual SIMOTION devices. 

To display the diagnostic results of the individual devices, follow these steps:

1. Select the desired SIMOTION device in the project navigator.

2. Select "Target system > Device diagnostics..." in the menu.

or

1. Double-click the SIMOTION device in the Diagnostics overview tab in the detail view.

Note

You may open the device diagnostics for several SIMOTION devices simultaneously. This 
allows you to compare different devices.

You can also access these device diagnostics via the "Accessible nodes" function.

The "Device Diagnostics" window will open in the working area of the workbench. This window 
provides you with the following information:

● General information 

● Diagnostics buffer 

● Task runtimes 

● Memory utilization 
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● System utilization 

● User log file 

● Syslog file 

● Version overview 

● Alarms

You have the following options:

● Print:
Select the "Project > Print" menu.

● Save it as a text file:
Click "Save."

● Refresh: 
Click "Refresh" or press the <F5> function key.

You can also monitor and change the operating mode:

● Click "Control operating state."

9.3.1 General information on the SIMOTION device
This provides general information on the SIMOTION device: 

● Select the "General" tab in the "Device Diagnostics".

The following information will be displayed:

● Name and system ID of the SIMOTION device

● Operating mode of the SIMOTION device

● MAC addresses

● IP addresses

● Subnet mask
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● Standard gateway

● Article numbers and designations of the deployed components, 
e.g. SIMOTION device, Motion Control technology package.

Figure 9-2 Display of general information in the device diagnostics

9.3.2 Diagnostics buffer
The diagnostics buffer is part of the system status list. It is possible to jump to the error position 
from the diagnostics buffer. It logs important events (e.g. changes in module state) in the order 
in which they occur. These include the following: 

● Faults in a module

● Faults in the process wiring

● System errors in the CPU

● CPU operating mode transitions

● User-defined diagnostic events

● Technology object alarms

● Alarm_S messages

● Errors in the user program
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● User-defined entries with the _writeAndSendMessage() function

● Compatibility errors, e.g. between the drive software and SIMOTION (SIMOTION D)

To work with the diagnostics buffer:
1. In the "Device Diagnostics" window, select the "diagnostics buffer" tab.

The saved events are displayed in tabular form.

2. Select the event for which you want to obtain more information.
Detailed information for the selected event is displayed in the lower pane of the window.

Figure 9-3 Example of the diagnostics buffer display in the device diagnostics

9.3.3 Task Manager
You can display the task runtimes and the status of the tasks set up in the project if you are 
connected online with the unit. The resolution of the displayed task runtimes is performed in 
the servo cycle clock. 

Note

The task runtimes are calculated to the µs and indicate the effective level runtime of the 
respective task (including the interrupt times). Thus, these correspond to the values of the 
"effectiveTaskruntime" device tags.
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Figure 9-4 Example of the display of the task runtimes in the device diagnostics - STOPPED status

The display is refreshed according to the refresh rate selected. The status and the following 
values are then displayed:

● Current runtime (current): 
Value of last polling

● Minimum runtime (min.): 
Minimum value since last transition from STOP to RUN

● Maximum runtime (max.): 
Maximum value since last transition from STOP to RUN

● Mean runtime (mean value): 
Value averaged from the last 10 cycles

The runtimes measured include the interruptions by higher-priority tasks.
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Meaning of the various status displays:
● RUNNING (TASK_STATE_RUNNING)

Task running, e.g.:

– By "_startTask" function,

– As an active cyclic task

● RUNNING_SCHEDULED (TASK_STATE_RUNNING_SCHEDULED)
Task interrupted by system.
If the task status RUNNING_SCHEDULED remains pending for a long time, it identifies a 
long-runner in the user task, e.g., a programmed continuous loop.

● STOP_PENDING (TASK_STATE_STOP_PENDING)
Task has received signal to stop; it is in a state between RUNNING and STOPPED.
Actions may be performed until the task has stopped.

● STOPPED (TASK_STATE_STOPPED)
Task stopped (e.g. via "_resetTask" function), completed or not yet started.

● SUSPENDED (TASK_STATE_SUSPENDED)
Task suspended by function "_suspendTask."
Use "_resumeTask" (name) to cancel this command. The task then resumes from the point 
at which it was interrupted.

● WAITING (TASK_STATE_WAITING)
Task is waiting due to the function "_waitTime" or "WAITFORCONDITION."

● WAITING_FOR_NEXT_CYCLE (TASK_STATE_WAIT_NEXT_CYCLE)
TimerInterruptTask waiting for start trigger.

● WAITING_FOR_NEXT_INTERRUPT (TASK_STATE_WAIT_NEXT_INTERRUPT)
SystemInterruptTask or UserInterruptTask is waiting for the triggering event to occur. When 
an interrupt occurs, the SystemInterruptTasks are started and executed once. Up to 8 
incoming interrupts can be stored in the buffer. If another interrupt occurs, the buffer 
overflows and the CPU goes into STOP mode.

● LOCKED (TASK_STATE_LOCKED)
Task locked by function "_disableScheduler."
This status prevents the activation of all user tasks (except the IPOSynchronousTask and 
IPOSynchronousTask_2) until "_enableScheduler" command is called. It does not, 
however, affect system tasks. The time watchdog for cyclic tasks is not suspended. 

Note

The also prevents the activation of the SystemInterruptTasks and UserInterruptTasks.

Controlling MotionTasks
It is possible to control MotionTasks via SIMOTION SCOUT TIA without a user program that 
has been created by the user. Consequently, you can test programs and influence MotionTask 
sequences in a very specific way.
Selected MotionTasks can be stopped, and locked or restarted for the sequence.

This means that programs in MotionTasks can also be downloaded in RUN mode. If you have 
made changes to sources and want to reload them in RUN mode, an active MotionTask can 
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prevent this. To avoid this problem, you can terminate MotionTasks specifically with 
SIMOTION SCOUT TIA and then carry out the download in RUN mode.

Additional references
Further information on downloading in RUN mode can be found in:

● SIMOTION Basic Functions Function Manual

● SIMOTION SCOUT Task Trace Function Manual

9.3.4 Checking memory utilization
This is how you view the system utilization: 

● Select the "Memory Utilization" tab in the device diagnostics.

Figure 9-5 Example of the memory utilization display in the device diagnostics
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Additional references
Further information on this topic can be found in:

● SIMOTION Basic Functions Function Manual, in the chapter "Overview of Memory in Target 
Device"

● SIMOTION SCOUT TIA Online Help

9.3.5 Checking the system utilization
To display the system utilization: 

● Select the "System Utilization" tab in the device diagnostics.

Figure 9-6 Example of the system utilization display in the device diagnostics

Additional references
Further information on this topic can be found in:

● SIMOTION Basic Functions Function Manual, in the chapter "Overview of Memory in Target 
Device"

● SIMOTION SCOUT TIA Online Help
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9.3.6 User log file
With the Userlog file, you can store your own texts in the RT system. This is necessary, for 
example, when changes, which are to be documented, are made in the SIMOTION system on 
a plant which has already been commissioned. 
Changes can be written in the SIMOTION SCOUT TIA. These are loaded to the ROM of the 
target device. When required, the text strings can be read out again. The text editor for the 
Userlog file is integrated as a tab in the device diagnostics Snap-in. This function is only 
available in online mode. 

Figure 9-7 Example of the Userlog file display in the device diagnostics

How to work in the Userlog file
● In the Device diagnostics, select the "Userlog" tab.

The editor is in edit mode, i.e. you can write or delete immediately.
The system does not add any additional system content, such as date/time. 
Enter the information.

● To save, click "Save as..." The Userlog file is stored as .txt.
All text items can be changed or deleted at any time. 
Access protection is not available.

● The Userlog file can also be read without the project.
The online mode is necessary for this.

● The Userlog file remains after "Delete user data."
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9.3.7 Syslog file
In addition to the user-defined Userlog file, the SIMOTION device also has a Syslog file. The 
ROM actions entered therein facilitate a subsequent diagnosis. This function is only available 
in online mode. The information of the Syslog file can also be read without a project. 

The Syslog file logs the following actions:

● RAM2ROM

● Overall reset

● Formatting the card from SIMOTION SCOUT TIA

Figure 9-8 Example of the Syslog file display in the device diagnostics

9.3.8 Version overview
The "content.txt" tab displays the SIMOTION version and the SIMOTION device data stored 
in the CompactFlash card. 

The following data are displayed:

● SIMOTION version

● BIOS version
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● Components
Versions of the SINAMICS components

● Internal version/stamp
Internal components

This information is relevant for any questions to the hotline.

Figure 9-9 Example of the version overview display in the device diagnostics

9.3.9 Alarms
In the device diagnostics "Alarms" tab, pending alarms and configured messages are displayed 
in the same way as in the "Alarms" tab in the detail view.   

Note
AlarmS_messages

When configuring AlarmS_messages, observe the specifications for the TIA Portal data type 
formattings.

Detailed information is contained in the help system of the TIA Portal under "Configure 
messages > Creating and editing messages".

Detailed information can be found in the SIMOTION SCOUT TIA online help, in the Alarms 
output window.

Service and diagnostics
9.3 Device diagnostics

SIMOTION SCOUT TIA
296 Configuration Manual, 01/2015



Figure 9-10 Example of the display of the alarms in the device diagnostics

9.4 Diagnostic functions in the address list
The Address list provides more features for I/O diagnostics. In online mode, the information is 
displayed in the Availability column. You can access more detailed information via a tool tip if 
you move the cursor over the relevant cell.

To open the address list:
1. Browse to the folder for your device in the project navigator.

2. Double-click the "ADDRESS LIST" item.
The address list opens in the detailed area.

The following diagnostic information is recorded:
● I/O stations which have failed completely

● Modules have been removed (e.g. for ET200SP)

● Deactivated I/O stations

● I/O variables working with substitute values

● I/O stations whose set topology differs from the actual topology
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● I/O stations configured to be isochronous are not isochronous

– Distributed synchronous operation

– Drive units

– Isochronous I/O

● Partner device (e.g. I-device, I-slave) is in STOP state

● For PROFINET devices: Provider state/consumer state is showing an error

– Controller

– I/O device

– Module

– Submodule

See also the description of the "_quality()" system function in Section Detailed status of I/O 
tags (kernel V4.2 and above) in the SIMOTION ST Structured Text Programming and 
Operating Manual.

For further information on diagnostics involving the address list, please refer to the online help.

9.5 Trace and measuring functions

9.5.1 Trace, measuring function, and automatic controller setting

Overview 
SIMOTION SCOUT TIA provides support for the commissioning and optimization of technology 
objects and user programs. The following functions are available:

● Device trace/Function generator

● System trace

● Measuring function

● Automatic controller setting
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Calling trace and measuring functions
To call the trace and measuring functions in SIMOTION SCOUT TIA, proceed as follows:

1. Select the SIMOTION device in the project navigator.

2. Select "Target system" in the menu and select the desired function or click on the desired 
function in the toolbar.

1 2 3 4

① Device trace/Function generator
② System trace
③ Measuring function
④ Automatic controller setting

Device trace/Function generator
You can use the device trace to record and evaluate parameters as well as system and program 
variables.

The device trace for system variables is mainly used to analyze time-synchronous sequences 
in the real-time system.

An automatic multiple trace is available as of SINAMICS V4.6. It can be used to trigger a 
recording automatically according to the trigger conditions. The measurement is stored as a 
YDB file (SIMOTION) or ACX file (SINAMICS) in a ring buffer on the memory card. At least 
five measurements can be stored in the ring buffer.
You can parameterize the multiple trace on the Trace tab under "Save to device (memory 
card)."

Program variables can be traced in order to find logical errors in the execution system or in 
user programs. For this purpose, rather than a time-triggered measuring task, an event-
triggered measuring task in the RT system can be used. The event that causes the 
measurement recording is the execution of a specific code position in the user program by the 
RT processor. To start recording, a trigger event based on the variable can be selected on the 
Device trace tab (on a positive edge, a tolerance range or a bit map, for example).

The function generator can be used for test purposes to dynamically generate setpoints with 
defined shapes (e.g. rectangle, sine) for various system variables. With the aid of the trace, 
for example, the system response can be recorded in order to optimize the controllers.

System trace
You can use the system trace to record and evaluate parameters, system variables, and 
program variables from multiple CPUs at the same time. It is essential that the CPUs 
communicate via PROFINET. An isochronous connection must exist between the CPUs, and 
the PROFINET Sync Master must be a SIMOTION device.

Function generator, mathematical processing and bit tracks are not available for recording with 
the system trace.
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Measuring function
The measuring function is used for controller optimization.

The SIMOTION measuring functions are used to commission the axis controller without 
requiring a user program.

With the SINAMICS measuring function, you can directly inhibit the influence of higher-level 
control loops by means of simple parameterization, and analyze the dynamic response of 
individual drives. The free measuring function measures and averages several measurement 
series with parameterizable noise sources without master control. This measuring function is 
suitable for controller settings and for avoiding whirling resonance with magnetic suspension 
bearing applications with rotor systems.

Automatic controller setting
The automatic controller setting can be used to configure the speed controller in the drive and 
the DSC position controller in the controller (SCOUT TIA only) for SINAMICS drive units.

Additional references
Detailed information can be found in the SIMOTION SCOUT TIA online help under Diagnostics. 

9.5.2 Task Trace

Application area
The SIMOTION Task Trace supports you when troubleshooting in the SIMOTION multitasking 
environment. The SIMOTION Task Trace records the sequence of individual tasks, identifies 
user events that you can generate via a program command, and displays these graphically.   

Structure of the Task Trace
The SIMOTION Task Trace includes two main components:

● The SIMOTION Task Tracer, which writes the task change and events to a buffer on the 
target device, and  

● The SIMOTION Task Profiler, an application for displaying the recorded data.  

Additional references
Further information on this topic can be found in:

● Function Manual: Task Trace

● Diagnostics Manual: SIMOTION IT Diagnostics and Configuration

● SIMOTION SCOUT TIA Online Help
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9.6 Interconnection overview
The interconnection overview allows you to display all motion input and output interconnections 
of technology objects (TO) within the project. This overview is displayed in the 
SIMOTION SCOUT TIA working area in the form of an interconnection tree. 

The tree display enables the synchronous operation interconnections to be displayed in 
cascades. In the interconnection table below, you can see all the TOs interconnected on the 
input and output sides for the technology object selected in the interconnection tree.

Call the interconnection overview with "Edit > Interconnection overview" in the menu.

Figure 9-11 Example of an interconnection overview

Additional references
Further information on this topic can be found in:

● SIMOTION Basic Functions Function Manual

● SIMOTION SCOUT TIA Online Help

9.7 Service Overview
In online mode, the service overview shows a tabular complete overview of all configured axes 
in the project. The current state (including values from system variables) is displayed along 
with fault conditions.

The service overview is called with "Target system > Service overview" in the menu.
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Figure 9-12 Service Overview

9.8 Program testing and debugging
Comprehensive program testing and debugging functions are available in SIMOTION SCOUT 
TIA. You can perform the following functions, for example:

● Control variable

● Program status

● Breakpoints

Additional references
Please refer to the following documents on this subject:

● SIMOTION ST Structured Text Programming and Operating Manual

● SIMOTION MCC Motion Control Chart Programming and Operating Manual

● SIMOTION LAD/FBD Programming and Operating Manual

● SIMOTION SCOUT TIA Online Help

9.9 Project comparison
You can use the project comparison function to compare objects within the same project or 
objects from other projects (online or offline). 

Objects are devices, programs, technology objects (TOs) or drive objects (DOs) and libraries.
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Procedure
1. Start the project comparison by clicking the  "Start object comparison" button.

2. The "Select Comparison Partners" dialog box opens. Select the projects to be compared.

Figure 9-13 Select comparison partner dialog
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3. Click on "Start comparison".

Figure 9-14 Synchronizing project data via the project comparison function

4. Move the mouse over the symbols highlighted in color to display information about the 
status.

Note

A detail comparison is only possible if supplementary data (e.g. program sources) have 
also been downloaded to the target device ("Options > Settings > CPU download").

Further references
Detailed information on the topic can be found in the SIMOTION SCOUT TIA online help and 
in the Function Manual SIMOTION project comparison.
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9.10 Creating a Project Overview by Script
In the folder Utilities_Applications\src\Scripts\ReportingScripts of the product DVD VOL3 you 
will find sample scripts that allow you to create reports on the following objects of the current 
SIMOTION project:

● TOs

● Programs, function blocks, functions

● Sources

● Tasks and assigned programs

The script lists the relevant specific objects of the SIMOTION project in an HTML document, 
arranged in a tabular format. Once generated, the HTML document opens automatically in the 
Internet Explorer. The information gathered can also be saved from there in HTML or CSV 
format or as an Excel file.

9.11 Services and diagnostics without an engineering system

Activating the Web server
SIMOTION devices have an integrated Web server. The Web server supports the display of 
diagnostics and system data in standard Internet browsers and the carrying out of project/
firmware updates, even in the absence of an engineering system. 
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Procedure
To enable the Web server in the TIA Portal, proceed as follows:

1. Select the SIMOTION device in the network view/device view.

2. In the Inspector window, select the "Properties" tab and then click the "General" tab.

3. Choose "Web server".
The Web server is disabled in the basic setting. To permit the CPU to display websites, you 
must activate the corresponding checkbox.

Figure 9-15 Activating the Web server

The Web server is addressed via HTTP/S. FTP and Telnet are only connected to the user 
administration.

Calling HW Config from SIMOTION SCOUT TIA
With SIMOTION SCOUT TIA, you can switch directly to the appropriate tab of the Inspector 
window in the TIA Portal.
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To do this, proceed as follows:

1. Select the SIMOTION device in the project navigator.

2. Select "Properties" from the context menu
The "Properties" dialog opens.

Figure 9-16 Calling HW Config from SIMOTION SCOUT TIA

3. Switch to the "Settings" tab and click the link "Web Server Settings in HW Config".
Now you can change the Web server settings in the TIA Portal.

Additional references
Detailed information can be found in the SIMOTION SCOUT TIA online help and in the 
Diagnostics Manual SIMOTION IT Diagnostics and Configuration.
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Appendix A A
A.1 Scripting functionality

Scripting
The scripting functionality enables you to automate the configuration of devices, SIMOTION 
technology objects (TOs) and SINAMICS drive objects (DOs) with the easy-to-learn script 
language VBScript. Standard scripts can be adapted to special situations occurring during 
runtime with interactive queries. This facilitates and speeds up commissioning. 

For scripts and related documents, refer to the installation DVD 3 in the directory 
Utilities_Applications\src\Scripts.

The selection of documents and scripts you will find there should help you quickly get to grips 
with scripting in SIMOTION. As well as demonstration-only scripts for studying the code, there 
are also scripts and script libraries you can actually use yourself.

The scripts check the usability with SIMOTION SCOUT TIA and, if applicable, output an error 
message.

Restrictions
In the context of SIMOTION SCOUT TIA (TIA Portal), only scripts that influence/use pure 
SIMOTION SCOUT/SIMOTION SCOUT TIA data/functionalities can be used.

A scripting of the HWCN data/functionalities and project handling of the TIA Portal (framework) 
is not possible.

The following is explicitly not possible via scripting:

● Creating, deleting, and renaming of objects that have a representation in the TIA Portal 
(e.g. all SIMOTION devices).

● Creating, deleting, and renaming of projects.

● File system access to TIA Portal projects.

● Utilization of functionality provided by the TIA Portal (framework), e.g. archiving/retrieval.

● Any handling of TIA Portal data.

The SIMOTION easyProject ProjectGenerator cannot be used for projects with SIMOTION 
SCOUT TIA because the scripting functionality in the TIA Portal is not yet available.

Note also that external scripting of SIMOTION SCOUT TIA is not supported.

Additional references
For detailed information, refer to the section "Scripts for sequence automation" in the online 
help.
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Interface parameters, 277
Project export, 276
Setting data for export, 275
Status display, 278

F
Failsafe direct data exchange, 184
F-Proxy

SIMOTION, 162
Function generator, 299
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Global device tags

Creating, 240

H
Hardware catalog, 42

HMI
Adding I/O fields, 190
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Messages, 189
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I/O tags
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SIMOTION drive, 91
Installation
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Know-how protection, 264
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Drive unit, 264, 268, 269
Password security level, 266
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Setting up a password, 266
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Hardware replacement, 283
Performing, 282
Underlicensing, 283

Load
To the target system, 208, 210

Local tags, 239

M
MCC, 26, 242
MCC editor toolbar, 246
Measuring function, 300
Measuring functions, 298
Memory utilization

Checking, 292
Menu, 47

Context menu, 52
Menu structure, 47

Menu bar, 45
Menu items, 49
Messages

Synchronizing, 189
Migrating

SIMOTION SCOUT project, 69, 71
Migration

SIMOTION SCOUT project, 68
Motion Control Chart, 26
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Online
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Going, 203

Online & diagnostics, 100
Online access, 99, 100
Online and diagnostics, 110, 112
Online connection, 205

Connect to target system, 214
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OPC export

ati export, 277
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OPC server
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Operating mode, 256, 257

Overall reset, 264
Overview

Diagnostic functions, 285
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PG/PC interface

setting, 100
POU (program organization unit), 25
PROFIBUS

Integrated, 176
SIMOTION, 115

PROFINET IO
SIMOTION, 115

PROFIsafe via PROFIBUS DP, 184
Programming language
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MCC, 25, 26
ST, 28
Structured Text (ST), 25

Programs
Execution system, 254
Know-how protection, 265
Sources, 25

Project
Basic principles, 64
Close, 67
Creating, 65
Deleting, 68
Download to target system, 210
Downloading to the target system, 208
Migrating, 69, 71, 75
Open, 66
Save and compile changes, 204
Save and recompile all, 205
Save as, 67

Project management
SIMOTION SCOUT TIA, 64
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Using, 202
Save

Project, 204
Scripting

Examples, 309
Restrictions, 309

Shortcuts, 52
SIMOTION

Equidistance, 178
F-Proxy, 163
I-Device, 145
Interconnecting ports, 135
IO devices, 129
Isochronous IO device, 137
Media redundancy, 157
MRP domain, 160
network, 115
PROFIBUS direct data exchange, 182
PROFIBUS DP, 176
Redundant sync master, 155
Servo on PROFINET IO, 139
Servo_fast on the PROFINET IO, 141
Sync domains, 131
Sync master, 133

SIMOTION CamEdit, 30
SIMOTION CamTool, 30
SIMOTION device
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Properties, 173
Replacing, 84

SIMOTION devices, 20
SIMOTION drive

Inserting, 91
SIMOTION hardware platforms

SIMOTION C, 22
SIMOTION D, 22

SIMOTION in the TIA Portal, 19
SIMOTION SCOUT

Export, 75
Import, 75
Migrating a project, 68, 69, 71
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Devices not supported, 23
Documentation, 3
Export, 75
Import, 75

installing, 33
License, 35
License key, 35, 36
License key upgrade, 36
License upgrade, 36
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Start, 197
Supported devices, 23
Supported functionality, 24
Uninstalling, 35
Using the help, 55

Snap-in, 45
Sources, 25

Implementation section, 25
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Structured Text, 28
Subnet
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Supported devices

SIMOTION devices, 23
SINAMICS devices, 23

Symbol browser, 54
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Syslog file
Device diagnostics, 295
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TIA Portal, 33

System tags, 239
System trace, 299
System utilization
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Tags

Global device, 240
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Target device
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Task card
Hardware catalog, 42

Task Manager
Device diagnostics, 289

Task Profiler, 300
Task Trace, 300
Task Tracer, 300
Technology object axis, 229
Technology objects, 31
Technology package

CAM, 31
CAM_EXT, 31
PATH, 31
TControl, 31

Technology packages, 30
Industry-specific, 31

TIA Portal
Details, 42
Diagnostics, 110
Editor bar, 42
Functions, 112
Information system, 43
Inspector window, 42
Menu bar, 41
Portal view, 39, 42
Project tree, 42
Project view, 39
Reference projects, 42
Status bar, 42
Task card, 42
Title bar, 41
Tool bar, 41
Using the help, 43
Views, 39
Working area, 42

TO Axis
Axis technologies, 229
Axis wizard, 230
Drive axis, 229
Path axis, 229
Positioning axis, 229
Real axis, 229
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Virtual axis, 229

Tool bar, 45
Trace functions, 298
Translate

Project, 204

U
Underlicensing, 283
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Unit tags, 239
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User interface language

Switching, 42
User interfaces

SIMOTION SCOUT TIA, 39
TIA Portal, 39

User log file
Device diagnostics, 294

Using
Detail view, 53
Working area, 45
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Version overview

Device diagnostics, 295
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Elements, 45
Menu bar, 45
Project navigator, 45
Snap-in, 45
Tool bar, 45

Working area
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Using, 45

Write protection
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